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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Digital Industries
Postfach 48 48
90026 NÜRNBERG
GERMANY
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Copyright © Siemens AG 2021.
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Runtime Readme 1
1.1 Security information (Unified)

Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions only form one element of such a concept.
Customer is responsible to prevent unauthorized access to its plants, systems, machines and 
networks. Systems, machines and components should only be connected to the enterprise 
network or the internet if and to the extent necessary and with appropriate security measures 
(e.g. use of firewalls and network segmentation) in place.
Additionally, Siemens’ guidance on appropriate security measures should be taken into account. 
For more information about industrial security, please visit
http://www.siemens.com/industrialsecurity 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends to apply product updates as soon as available and to always use 
the latest product versions. Use of product versions that are no longer supported, and failure to 
apply latest updates may increase customer’s exposure to cyber threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under
http://www.siemens.com/industrialsecurity 

Network settings
The following table shows the network ports that are used by WinCC Unified for internal and 
external communication. These ports must not be used for any other purpose. 
The setup configures the ports for the firewall to ensure smooth operation.

WinCC Unified
Name Port number Transport protocol
ILScs Manager 20008 TCP
UMC 20009 TCP
ILPmon Manager 4999 TCP
ILEvent Manager 1235 TCP
ILDist Manager 4777 TCP
ILDataManager 1234

5001
TCP
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WinCC Unified
Node Processes 3103

443
8888

TCP

Graphics Runtime 1339
1345

TCP

License server 1366 TCP
Screen debugger 9222 TCP
Job debugger 9224 TCP

1.2 GDPR - General Data Protection Regulations
Siemens takes data privacy principles, such as the privacy by design and default principle, into 
account when developing its products and services. For this product WinCC Unified Runtime V16 
this means the following: 

Personal data processed by the Application
This product collects and processes the following personal data:
• User names, i. e. login data, which might directly contain or establish a reference to the 

family name and/or first name
• Timestamps: date / time of login, logoff and access
• Location data (time zone)
• Computer name
• IP addresses
• Optional: With UMC, the following additional personal data can be added in the tool:

– Full name
– Comment
This data is not needed for the product functionality and should not be stored on the same 
medium.

If the user links the above-mentioned data with other data, e. g. shift plans, or stores personal 
data on the same medium, e. g. hard disk, and thus establishes a personal reference, the user 
must ensure compliance with data protection regulations. 

Purposes
The above data is required for the following purposes:
• Access protection and security measures (e. g. Login, IP address)
• Process synchronization and integrity (e. g. time zone information, IP addresses)
• Archiving system for traceability and verification of processes (e. g. access timestamps)
• Alarm system for traceability and availability (for example, e-mail notification)

Runtime Readme
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The storage of data is appropriate and limited to what is necessary, as it is essential to identify 
the authorized operators and process events.

Data configuration
The customer can configure the data collected via the product as follows:
• Display data in process pictures
• Data output in form of reports, e. g. for printing or display as electronic file
• Data collection and evaluation in form of graphics, e. g. for KPI analysis

Deletion policy
The product does not provide an automatic deletion of the above data.
If necessary, these can be deleted manually if desired. To do this, refer to the product 
documentation or contact customer support.

Securing of data
The above data will not be stored anonymously or pseudonymized, because the purpose of 
access and event identification cannot be achieved otherwise.
For WinCC Unified PC-based, the above data is secured by appropriate technical measures:
• Encryption of log data
• Storing the process data in access-protected SQL databases

The user must ensure the access protection as part of their process configuration.
You can find information about securing data on the WinCC Unified Comfort Panel in the 
operating instructions for the Comfort Panel.
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1.3 Installation of WinCC Unified Runtime

1.3.1 Software and hardware requirements

Introduction
Specific requirements for the operating system and software configuration must be met for the 
installation.

Note
Windows computer name
Retain the Windows computer name after the installation.
The following characters are not permitted for the computer name:
• . , ; : ! ? " ' ^ ´ ` ~ _
• - + = / \ ¦ @ * # $ % & § ° 
• ( ) [ ] { } < > 
• Space
Follow these recommendations when assigning the Windows computer name:
• Uppercase only 
• The first character must be a letter.
• The first 12 characters of the computer name must be unique.

Installation in domains and workgroups
WinCC Unified is basically released for operation in a domain or workgroup.
However, note that domain group policies and restrictions of the domain might hinder the 
installation. In this case, remove the computer from the domain before installing WinCC Unified 
and Microsoft SQL Server. Log onto the computer in question locally with administrator rights. 
Then perform the installation. After successful installation, you can enter the WinCC computer 
back into the domain. If the domain group policies and restrictions of the domain do not impede 
the installation, the computer need not be removed from the domain during the installation.
Note that domain group policies and restrictions of the domain may also hinder operation. If you 
cannot remove these restrictions, run the WinCC computer in a workgroup.
Consult with the domain administrator if needed.

Operation on a network server
It is not permitted to operate WinCC Unified Runtime on a network server (e.g. domain 
controller, file server, name service server, router, software firewall, media server, exchange 
server).

Runtime Readme
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Hardware requirements for the installation
The following table shows the minimum hardware requirements that have to be met for the 
installation:   

Hardware Requirement
Processor type Intel Core i3
RAM 4 GB
Free hard disk space 10 GB, 8 GB CF

Virtualization
The following virtualization systems were tested: 
• VMware vSphere Hypervisor (ESXi) 6.7 (or higher)
• VMware Workstation 12.5.5 and VMware Workstation 15.5.0 (or higher)
• VMware Player 12.5.5 and VMware Player 15.5.0 (or higher)
• Microsoft Hyper-V Server 2019

Requirement
The performance data of the virtual computers must meet the minimum requirements of WinCC 
clients.

Software requirements for the installation
Software Configuration Comments
Windows 10 Pro Windows 10 Pro Version 1909 (OS Build 18363)

Windows 10 Pro Version 2004 (OS Build 19041)
Windows 10 Pro Version 2009/20H2 (OS Build 
19042)

64-bit

Windows 10 Enterprise Windows 10 Enterprise Version 1909 (OS Build 
18363)
Windows 10 Enterprise Version 2004 (OS Build 
19041)
Windows 10 Enterprise Version 2009/20H2 (OS 
Build 19042)

Windows 10 IoT Enter‐
prise LTSB

Windows 10 Enterprise 2016 LTSB (OS Build 14393) 
(Test for IPC) 
Windows 10 Enterprise 2019 LTSC (OS Build 17763) 
(Test for IPC)  

Windows Server 2016 
Standard
Windows Server 2019 
Standard

Full installation 64-bit
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Note
Number of supported clients and connections
Desktop operating systems support a maximum of 5 clients. In server operating systems, more 
than 5 clients can connect to the server.
Windows limits the number of incoming connections on desktop operating systems to 20. This 
limits the number of possible accesses to Runtime.

Compatible browsers
Operating system Browser
Microsoft Windows • Google Chrome

• Microsoft Edge
• Mozilla Firefox, Mozilla Firefox ESR

Android • Google Chrome
• Firefox
• Edge

iOS, Mac • Safari
• Google Chrome
• Firefox
• Edge

For more information on the use of browsers, see section Internet browsers for WinCC Unified PC 
(Page 26).

Windows specific software settings for IIS (Internet Information Services)
To be able to install Runtime Unified, the following settings must be enabled in Windows:
For Windows 10 you can make these settings in the following window: Control Panel > Programs 
> Programs and Features > Activate or deactivate Windows features
• HTTP Errors
• HTTP Redirection
• Default document
• Static content
• .NET Extensibility 3.5
• ASP
• ASP.NET 4.5
• ISAPI extensions
• ISAPI filters
• Dynamic Content Compression
• Static Content Compression
• Request Monitor

Runtime Readme
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Topic Version / setting Comment
Web browser The browser must support HTML 5.  
User rights for instal‐
lation

Administrator rights  

SOFTNET-IE S7 Lean 
Single License

 You need this license to be able to op‐
erate Runtime Unified with up to 10 
connections.

Simatic NET V13 SP1 You need this license to be able to op‐
erate Runtime Unified with more than 
10 connections.

Ports
When a Windows firewall is used, the installation routine of WinCC Unified Runtime sets up the 
following ports:
• HTTPS: 443
• TIA administrator: 8888
If your system uses a different firewall solution, make sure the ports are set up accordingly.

Security programs
The following security programs are approved for Runtime Unified:

Virus scanner Symantec Endpoint Protection 14.2
McAfee Endpoint Security (ENS) 10.6
Trend Micro Office Scan 12.0
Kaspersky Endpoint Security 11.3
Windows Defender (as part of the Windows operating system).
Qihoo 360 "Safe Guard 12.1" + "Virus Scanner"

Whitelisting McAfee Application Control 8.2
Hard disk encryption Microsoft Bitlocker (as part of the Windows operating system)

 Principle 
 Care must be taken to ensure that the use of the antivirus software does not impair the process 
operation of a plant.
 Rules for antivirus software (virus scanning clients) 
• Integrated firewall of the virus scanner

In WinCC Unified Runtime, the local Windows firewall used is configured with SIMATIC 
Security Control. Do not install or enable the integrated firewall of the antivirus software. 

• Manual scan
Do not perform a manual scan in Runtime. Perform disk on regular intervals on all plant PCs, 
for example, during the maintenance interval.

• Automatic scan
For automatic scan it is sufficient to scan the incoming data traffic. 

Runtime Readme
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• Time controlled scan
Do not perform at time-controlled scan in Runtime. 

• Pattern update
The pattern update of the virus scanning clients (the plant PCs which are checked for viruses) 
performed by the higher-level virus scanning server (the plant PC which centrally manages 
the virus scanning clients). 

• Dialog
To avoid impairing the process operation, no dialog messages may be displayed on the virus 
scanning clients. 

• Drives
To prevent overlapping scans on network drives, only the local drives are scanned. 

Otherwise apply the default settings. 
What is secured? 
The incoming data traffic is checked for viruses. The impairment of the process mode is 
minimized. 

Note
If you are using an anti-virus scanner, make sure that the computer has sufficient system 
resources.

1.3.2 Starting installation

Requirement
• You have administrator privileges on your computer.
• All running programs are closed. 

Procedure
1. Place the installation medium in the respective drive. 
2. Start the Setup.
3. Select the required installation language. 
4. Select the required product configuration.
5. Read and accept all the license conditions and safety information.
6. Accept the changes in the security settings.
7. Check the selected installation settings. 
8. Start the installation.

Runtime Readme
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9. After selecting the components, make the system settings for operation of Unified Runtime.
These are described in the section Configuring Runtime system settings (Page 16).
You can amend or change the settings at a later time by calling the "WinCC Unified 
Configuration" tool.

10. Reboot the PC to complete the installation. 

Note
Using the Openness SDK
You will find the Openness SDK in the "Support\Openness" folder on the installation medium.  
Unpack the file "Siemens.Unified.Openness_SDK_<version number>.zip" to your local computer. 
A WinCC Unified installation is not necessary to use the Openness SDK. 

1.3.3 Starting removal

Introduction
You have two options for removing: 
• Removing selected components via the Control Panel
• Removing the product using the installation data medium

Note
Some components are not automatically removed by the uninstall routine of the software 
package as these are used for other purposes. ALM, for example, is used for the administration 
of the license keys of several products of Siemens AG. 

Removing selected components via the Control Panel
To remove selected software packages, follow these steps: 
1. Open the program list via "Start > Settings > Control Panel > Programs > Programs and 

Features".
2. Start the uninstall in Windows.
3. Select the Setup language. 
4. Select the software components that you want to uninstall. 
5. Check the selected uninstall settings. 
6. Start the uninstall in the Setup.
7. Reboot the PC to complete the uninstall.

Runtime Readme
1.3 Installation of WinCC Unified Runtime

WinCC Unified Runtime
System Manual, 05/2021 15



Removing a product using the installation medium
To remove all software packages, follow these steps: 
1. Start the Setup.
2. Select the Setup language.
3. Select the full installation.
4. Check the uninstall settings.
5. Start the uninstall.
6. Reboot the PC to complete the uninstall.

1.3.4 Configuring Runtime system settings

1.3.4.1 Configuring the settings during installation

Requirement
• You have completed the component selection in the setup and are now in the step for 

configuration of the Runtime system settings.

Procedure
Follow the setup instructions and configure the following settings:
• The Web UI certificate
• User management
• The log settings for the storage location of log databases and the maximum storage limit of 

the SQL server
• Reporting settings
• Password-protected download
You navigate between the various steps with "Back" and "Next".
To skip a step or maintain the pre-selected inputs, select the option "Keep the existing 
configuration" and click "Next".

Result
The installation automatically creates a desktop shortcut for "WinCC Unified Configuration". You 
can amend or change the settings at a later time by manually starting "WinCC Unified 
Configuration".

Runtime Readme
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1.3.4.2 Changing the settings after the installation
With "WinCC Unified Configuration", you amend or change the Runtime system settings made 
during the installation at a later time. 

Requirement
• The program package is installed. 

Procedure
1. Start "WinCC Unified Configuration" manually using the desktop shortcut that was created 

during the installation.
The same settings are available in "WinCC Unified Configuration" as during the installation. 
– The Web UI certificate
– User management
– The log settings for the storage location of log databases and the maximum storage limit 

of the SQL server
– Reporting settings
– Password-protected download

2. If required, change the interface language of WinCC Unified Configuration. To do so, select 
the desired language from the list.

3. Follow the setup instructions and configure the required settings.
4. You navigate between the various steps with "Back" and "Next".

To skip a step or maintain the inputs select during the installation, select the option "Keep the 
existing configuration" and click "Next".

Result
After you have completed the settings, the system automatically performs the configuration. 
You will receive an overview of the implemented configuration.

1.3.4.3 Certificate management
In this step you select the web server certificate of WinCC Unified Runtime.
Select one of the following options:
• Select one of the web server certificates available on the device.

Requirement: A valid web server certificate is installed on the device (Webserver (IIS)).
• Create a new certificate.

The certificate is self-signed. 
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Secure communication through trusted certificates
To enable web clients to establish a secure connection to WinCC Unified Runtime, it is 
recommended to select a certificate issued by a root certificate in this step. Web clients must 
install this root certificate in the web browser. Create the root certificate and the web server 
certificate with the WinCC Unified Certificate Manager tool.

NOTICE
Security risk due to self-signed web server certificate
Using a self-signed certificate, e.g. for test purposes, is possible but not recommended for the 
operation of the system for security reasons. 
Web clients must install this certificate in the web browser. The installation of self-signed 
certificates is not supported by all web browsers. Depending on the web browser, it is possible 
to define exceptions. 
For more detailed information, refer to the operating instructions of the web browser.

See also
Handling certificates (Page 23)

1.3.4.4 User management

Note
This step is only available in the following situations:
• A UMC server or its agent is installed on the HMI device.
• Or the runtime installation has been started via the TIA Portal engineering DVD.
If this is not the case, Runtime uses the user configuration downloaded from the TIA Portal. User 
data is read from the local or central user management according to the project configuration. 

In the "User management" step, configure the user management configuration that Runtime is 
to use. Possible settings:
• Use the user management configuration downloaded from the TIA Portal.

Runtime uses the local user management. 
• Use the configuration from the Runtime system settings

The user data is always centrally located on a UMC server. The server or its agent must be 
installed on the HMI device.
When a project with local user management is loaded in Runtime, the user management 
connects to the UMC server configured here.
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Using a configuration from the TIA Portal
1. Select the "Use configuration downloaded from the TIA Portal" option.

(Default setting)
2. For projects with a local user management, Runtime uses the full computer name (fully 

qualified domain name) to generate the address of the identity provider and the Unified web 
page. 
To use the IP address instead, proceed as follows: 
– Select the "Use IP address for identity provider and website" option.
– Select an IP address from the list.

Note
Select this option only if you cannot access the computer from the network using the full 
computer name.

When you have entered your settings and the system has terminated the configuration, Runtime 
uses the user management configuration downloaded from the TIA Portal.

Using a configuration from the system settings
1. Select the "Use the following configuration" option.
2. Enter the address of the UMC server.
3. Optional: To enter the identity provider address manually, proceed as follows:

– Clear the "Identity provider address generated by the UMC server" option.
– Enter the identity provider address. Use the following notation:

"https://<computer name>/umc-sso"

Note
Automatic generation of the identity provider address
By default, the identity provider address is automatically generated based on the UMC server 
address.

When you have entered your settings and the system has terminated the configuration, Runtime 
uses the UMC server configured here. 

See also
Activating user management (Page 282)

1.3.4.5 Archive settings
In this step you configure the storage location of the archive database and the SQL server 
settings. 
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You have the following options:
• Select the target directory and name of the archive database.
• Select the memory high limit of the SQL server.

Only available if the Microsoft SQL server is installed.

1.3.4.6 Reporting settings

Introduction
In this step you configure the settings for generating reports.
You have the following options:
• Unified PC: Select the local main storage location for storing reports in the file system.

Note
Permanently configured local main storage location for Unified Comfort Panel
The "Reports" folder on the SD card inserted in the panel is specified as the local main storage 
location for Panels: media/simatic/X51/Reports 
You cannot select or create another folder.

• Select the application that generates the PDFs of the reports.

Specify the local main storage location for reports (Unified PC)
Select a local directory.
To save the generated reports, users can create subdirectories in Runtime in the "Reports" 
control.

Runtime Readme
1.3 Installation of WinCC Unified Runtime

WinCC Unified Runtime
20 System Manual, 05/2021



Select the application for PDF creation
1. Select whether Excel or LibreOffice is to be used for the PDF creation of the reports.

If you select "Do not configure", no PDF files are created for the reports in Runtime.
Note
PDF creation for large reports 
Generating PDFs with Excel is significantly slower than with LibreOffice. To generate large 
PDF reports, it is therefore recommended that you install LibreOffice.

Note
Deviating PDF results possible
A PDF report created by LibreOffice may differ in content or layout from a PDF report created 
with Excel. Such deviations are possible if general Excel functions that LibreOffice does not 
support are used in the report template, for example, special fonts or chart types.

2. When Excel is creating the PDFs: Specify the user name and password of the Windows user 
under whose name the PDF creation is running. 
During the Runtime installation, an appropriate user account is created.
Do not use a user that already exists in Windows user management.
Adhere to Windows policies for user passwords.
Note
Checking the security settings of the user management
Clarify with your administrator whether the security settings of the Windows user 
management prevent the new user created on your device during the Runtime installation 
from being permanently available. 
If required, modify the settings or select LibreOffice as the application for PDF creation.

3. When LibreOffice creates the PDFs: Select the LibreOffice installation directory.

1.3.4.7 Secure download
In this step you configure the settings for secure download of projects to the Runtime. 
To protect the projects with a password during download, follow these steps:
• Activate the option for secure download.
• Enter the password and confirm it.

Note
Requirements for the password
• Length: 8 to 120 characters
• Characters: In each case at least one uppercase letter, one lowercase letter, one number 

and one special character
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1.3.5 Working with license keys

Introduction
To use WinCC Runtime Unified, transfer a license key to the Runtime PC.
When you transfer a license, the associated license key is removed from the storage location. 

Note
A license key cannot be copied. The copy protection employed prevents the license keys from 
being copied.

Data backup
Transfer the license keys from the PC when backing up data on the PC and when creating a 
backup during device replacement. 
You use the Automation License Manager to save license keys for PC-based HMI devices at the 
storage area of the license key. 

NOTICE
Destruction of license keys on PCs
Transfer all license keys to a storage location in the following cases:
• Before you format the hard disk
• Before you compress the hard disk
• Before you restore the hard disk
• Starting an optimization program that moves fixed blocks
• Installing a new operating system
Read the description of Automation License Manager. Observe all warnings and notices.

The location of the license keys is capable of storing multiple licenses when the 
Automation License Manager is used on PC-based HMI devices. This capability means you can 
store multiple licenses of the same type at one location. Save all license keys of the HMI device 
to the same storage location.

Invalid license after time-zone change
The transferred license no longer functions in the following case:
• If you change the time zone on a WinCC PC as follows:

– From a time based on a complete hour to a time not based on a complete hour.
Example: You change the time zone from GMT +3:00 to GMT +3:30.

To work around this, transfer the license key from the HMI device with a time zone setting that 
was set when the license key was transferred to the HMI device. 
Example:
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You transferred the license key to the HMI device with a time zone setting based on a full hour. 
Then, also transfer the license key from the HMI device with a time zone setting based on a full 
hour.
This behavior does not apply to the trial license.

Defective license
A license is defective in the following cases:
• If the license key is no longer accessible at the storage area. 
• If the license key disappears during its transfer to the destination drive.

Note
Resetting of the system status to an earlier time causes all licenses to become defective.

You can use the Automation License Manager to repair the defective licenses. Use the "Restore" 
function or the "Restore Wizard" of the Automation License Manager for this purpose. Contact 
Customer Support in order to restore the license. 

Note
The runtime software can also be operated without errors if the license is missing or defective. 
The system alerts you with an alarm at brief intervals that you are working in non-licensed mode. 

1.3.6 Handling certificates

Introduction
Communication between web clients (browser) and Runtime (web server) is encrypted. The 
communication partners authenticate themselves with a certificate. The web server certificate 
must be known to the web client browser as trusted.  
You determine which certificate you are using when installing Runtime on the web server or at 
a later time in the "WinCC Unified Configuration" tool.
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You have the following options:
• Create your own certification authority and use this certificate. 

Create the root certificate and the web server certificate with the WinCC Unified Certificate 
Manager tool.

• Use a self-signed certificate. 
NOTICE
Security risk due to self-signed web server certificate
Using a self-signed certificate, e.g. for test purposes, is possible but not recommended for 
the operation of the system for security reasons. 
Web clients must install this certificate in the web browser. The installation of self-signed 
certificates is not supported by all web browsers. Depending on the web browser, it is 
possible to define exceptions. 
For more detailed information, refer to the operating instructions of the web browser.

Using a certificate issued by a certification authority
With the WinCC Unified Certificate Manager, you can easily create your own certification 
authority, issue certificates with this certification authority and export them to distribute them 
to the required devices.
You can find additional information on the WinCC Unified Certificate Manager here (Page 251).

Using a self-signed web server certificate
Select the option "Create a new certificate" while installing the Runtime server or later in "WinCC 
Unified Configuration".
Add the self-signed certificate in each client that calls this server to the list of trusted certificates:
1. Open the desired browser.
2. In the address line, enter the host name or the IP of the Runtime server that was used when 

creating the certificate.
You will receive a security warning. 

3. Continue loading the web page. 
4. Install the certificate in the certificate store "Trusted Root Certification Authorities". 
5. If you receive a security warning as to whether you want to trust the certificate, confirm it 

with "Yes".  
6. Load the page again.
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1.4 Release Notes

1.4.1 Notes on the operation of Unified PC

Contents
Information that could no longer be included in the online help and important information 
about product properties.

Accessing Runtime Unified via Android devices or iOS devices
Ensure you have the latest operating system and browser version on your Android device or iOS 
device if you want to access Runtime Unified with this device.

UMCAdmin is not available in V17 
The "UMCAdmin" user is not created automatically when V17 is set up. If you have not 
configured a user in a V16 project, you can no longer log into this project in a V17 Runtime.
This behavior happens in the following situations: 
• When you install V17 on the Runtime machine and open a V16 project.
• When you load a V16 project offline with V17 on a V17 Runtime.
In V17, you must create a user in the engineering system before loading the user management.

Synchronize client values with server time
By default, the following controls display values with client time:
• Alarm control
• Trend companion
• Trend control
• Function trend control
• Process control
To synchronize the time displayed on the client with the server, proceed as follows:
• iOS devices:

To prevent an iOS device from synchronizing with time.apple.com, create a profile file and 
upload it to the device. 
Profile files enable time synchronization within a secure corporate network.

• Android devices:
Use a third-party app for time synchronization.
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1.4.2 Internet browsers for WinCC Unified PC
WinCC Unified displays the runtime elements in HTML5. The browser used also has to support 
this standard. Since the browsers interpret HTML5 differently, it is possible that objects are 
displayed differently depending on the browser and the browser version used.
Compatibility tests were performed for the following browsers. The focus of the compatibility 
tests was on the browsers marked with *:

Operating system Browser
Microsoft Windows • Google Chrome*

• Microsoft Edge
• Mozilla Firefox, Mozilla Firefox ESR

Android • Google Chrome*
• Firefox
• Edge

iOS, Mac • Safari*
• Google Chrome
• Firefox
• Edge

Browser recommendation
In view of the performance and support of the Runtime standard elements, Google Chrome has 
proven to be the preferred browser. Its memory requirements are slightly higher than those of 
the other browsers.

Note
Operating system and browser version
For Runtime operation via Android or iOS, always use the latest operating system.
Use the latest browser version.

Note
Performance differences in different versions of individual browsers
The browser versions can differ from each other, which can result in different behavior regarding 
the memory requirements and speed.

Note
Suitability for continuous operation
MS Edge and Mozilla Firefox have proven to be problematic in continuous operation. 
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Known browser problems
The following restrictions apply to the following browsers:

Internet browser Limitation
MS Edge • High memory capacity utilization in continuous op‐

eration
Mozilla Firefox • High memory capacity utilization in continuous op‐

eration
Mozilla Firefox ESR • Support of touch gestures for touch panels as of Fire‐

fox ESR V59
Google Chrome • High memory capacity utilization in uninterrupted 

duty depending on the version.
• On Android: Grid lines with a line width ≤1 are not 

displayed correctly. This is due to the browser's own 
line thickness representation. As a solution, it is help‐
ful to use a line width ≥1.

• No correct representation of elements that use an 
SVG graphic as background graphic scaled in the En‐
gineering System.

Restrictions to the various functions can also occur, such as the availability of the before and 
after buttons in the controls.

Current information on browser problems
You can find up-to-date information on display problems in browsers at the Siemens Online 
Support under the entry ID 109757952.
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Runtime Operating Manual 2
2.1 Internet browsers for WinCC Unified PC

WinCC Unified displays the runtime elements in HTML5. The browser used also has to support 
this standard. Since the browsers interpret HTML5 differently, it is possible that objects are 
displayed differently depending on the browser and the browser version used.
Compatibility tests were performed for the following browsers. The focus of the compatibility 
tests was on the browsers marked with *:

Operating system Browser
Microsoft Windows • Google Chrome*

• Microsoft Edge
• Mozilla Firefox, Mozilla Firefox ESR

Android • Google Chrome*
• Firefox
• Edge

iOS, Mac • Safari*
• Google Chrome
• Firefox
• Edge

Browser recommendation
In view of the performance and support of the Runtime standard elements, Google Chrome has 
proven to be the preferred browser. Its memory requirements are slightly higher than those of 
the other browsers.

Note
Operating system and browser version
For Runtime operation via Android or iOS, always use the latest operating system.
Use the latest browser version.

Note
Performance differences in different versions of individual browsers
The browser versions can differ from each other, which can result in different behavior regarding 
the memory requirements and speed.

Note
Suitability for continuous operation
MS Edge and Mozilla Firefox have proven to be problematic in continuous operation. 
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Known browser problems
The following restrictions apply to the following browsers:

Internet browser Limitation
MS Edge • High memory capacity utilization in continuous op‐

eration
Mozilla Firefox • High memory capacity utilization in continuous op‐

eration
Mozilla Firefox ESR • Support of touch gestures for touch panels as of Fire‐

fox ESR V59
Google Chrome • High memory capacity utilization in uninterrupted 

duty depending on the version.
• On Android: Grid lines with a line width ≤1 are not 

displayed correctly. This is due to the browser's own 
line thickness representation. As a solution, it is help‐
ful to use a line width ≥1.

• No correct representation of elements that use an 
SVG graphic as background graphic scaled in the En‐
gineering System.

Restrictions to the various functions can also occur, such as the availability of the before and 
after buttons in the controls.

Current information on browser problems
You can find up-to-date information on display problems in browsers at the Siemens Online 
Support under the entry ID 109757952.

2.2 Displaying runtime

Introduction
After you have downloaded a Runtime project to an HMI device and started Runtime, you display 
Runtime in the browser.

Requirement
• The Runtime project is loaded.
• The project is executed in Runtime.
• The user management configuration of the project is active.
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• When using the central user management: 
– At least one user is created in the UMC system.
– The user created in the UMC system has been imported into the TIA Portal project before 

the loading.
– The user has function rights via his/her roles to monitor or monitor and operate the 

Runtime project.
• When using the local user management: 

– Before the loading, at least one user has been created in TIA Portal.
– The user has been assigned at least one role. The user has function rights via his/her roles 

to monitor or monitor and operate the Runtime project.
– At least one user has the "HMI Administrator" role.

Procedure
1. In the browser, enter the IP address or the full computer name (fully qualified domain name) 

of the PC on which Runtime is running, for example, "https://141.73.65.245/".
If Runtime is installed on the same PC as the browser, the "localhost" designation can also be 
used. 

2. If you are accessing the Runtime of the HMI device from this device for the first time and there 
is no corresponding certificate, install the certificate in the browser. Then reload the page.

3. The start page of Runtime is displayed.
Note
If you experience display problems in the web client, completely delete the browser data 
(history, form entries, etc.).

If WebES is installed on the device, the "WinCC Configuration" button also appears.
4. Select "WinCC Unified RT".

The login page is displayed.
After complete download of a project, an error can occur when you open the WinCC Unified 
home page (SwacLogin).
You can find additional information at SwacLogin: Errors after complete download 
(Page 38). 
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5. Enter the user name and password of a user in runtime.
6. Confirm your entry.

The running Runtime project is displayed.
The Runtime project is displayed in the language that is set in the "User login" dialog. If this 
language is not configured in the Runtime settings of the HMI device, the language that has 
the lowest number in the "Order" column under "Runtime settings > Language & font" in the 
TIA Portal is used.

See also
Installing a certificate in the browser when accessing via web client (Unified PC) (Page 32)

2.3 Installing a certificate in the browser when accessing via web 
client (Unified PC)

Using root certificates
To enable web browsers to establish a secure connection to WinCC Unified, the current root 
certificate of the WinCC Runtime must be known in the web browser as a trusted certification 
authority.
By installing the web server certificate on the PC device, the public root certificate is made 
available as a download for installation in web browsers on the WinCC Unified home page.
The procedure for installing the root certificate differs depending on your web browser.

Use of self-signed certificates
As an alternative to the root certificate, you can use a self-signed certificate.

NOTICE
Security risk from self-signed certificate
A self-signed certificate is not issued by a trusted certification authority. 
If you use a self-signed certificate from an untrustworthy source, the data transfer is not 
protected from attacks. 
Before using self-signed certificates, check the source. 
Depending on the firewall and network settings, the use of self-signed certificates may be 
prohibited.

The installation of self-signed certificates is not supported by all web browsers. Depending on 
the web browser, it is possible to define exceptions. 
For more detailed information, refer to the operating instructions of the web browser.
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Installing the root certificate for Chrome and Microsoft Edge
Chrome and Microsoft Edge use the Windows system certificate store.
• On devices with WinCC Unified installation that have been configured with the Certificate 

Manager, these web browsers can immediately establish a secure connection to the WinCC 
Unified web pages because the root certificate has already been installed in the system 
certificate store.

• On devices without WinCC Unified Installation the root certificate must be installed 
manually.

To install manually, follow these steps (for example, Microsoft Edge):
1. Open the WinCC Unified home page via the URL https://<host name>

At first, an error message appears:

2. Open the field with the error details and confirm that you want to open the web page.
3. On the WinCC Unified home page, select the field "Certificate Authority" and confirm "Open 

file" in the download dialog.
The root certificate is downloaded to the pre-selected download directory.
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4. Open the downloaded file.
The root certificate is opened with the Windows standard form.

5. To import the root certificate into Windows, select "Install Certificate".
6. In the certificate import wizard, select "Local Machine" as the storage location, "Trusted Root 

Certification Authority" as the certificate store and start the import process.

Installing the root certificate for Firefox
Firefox uses its own certificate store and must therefore be configured manually on each device 
once:
1. Open the WinCC Unified home page via the URL https://<host name>

At first, an error message appears:
2. Open the field "Advanced" and confirm the field "Accept the Risk and Continue".

An exception is entered for this page in the Firefox certificate management.
3. On the WinCC Unified home page, select the field "Certificate Authority".
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4. Save the root certificate. To do this, click "Save file" in the Firefox dialog that follows.
5. Store the certificate in the Firefox certificate store. Proceed as follows:

– Open the "Settings" page of Firefox.
– Select "Privacy & Security". There you will find the "Certificates" area further down. Open 

"Show certificates...".
– In the "Certificate Management" window, select the "Certification authorities" tab:

– Click "Import" and select the root certificate you saved in step 3.
– In the window that opens, select the option "This certificate can identify websites" and 

confirm your selection.
– Click "Server" and remove the exception that was created by step 2.
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Installing the root certificate on iOS devices
iOS uses its own certificate store and must therefore be configured manually on each device 
once. An error message also appears when the WinCC Unified home page is opened.
1. Open the field "Advanced" and confirm the field "Accept the Risk and Continue".
2. On the WinCC Unified home page, select the field "Certificate Authority".

3. Select "Install".
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4. Select "Install" again.

You see the entry "Trusted".

Runtime Operating Manual
2.3 Installing a certificate in the browser when accessing via web client (Unified PC)

WinCC Unified Runtime
System Manual, 05/2021 37



5. Select "General > Info > Certificate Trust Settings".

6. Activate "WinCC Unified CA" and select "Next".

2.4 SwacLogin: Errors after complete download
After complete download of a project to a Unified PC, an error can occur when you open the 
WinCC Unified home page. The error can occur regardless of whether you open the home page 
locally on the PC or from a different device.
A possible cause of the error is the deletion of the browser cache.

Runtime Operating Manual
2.4 SwacLogin: Errors after complete download

WinCC Unified Runtime
38 System Manual, 05/2021



Error description
In "Chrome" and "MS Edge", the error is displayed with the following alarm: 

In "Firefox", the error is displayed with the following alarm:

After accepting the warning of a potential security risk, the page remains empty in Firefox. Only 
the background screen is visible.
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Remedy the error in "Chrome" and "MS Edge"
To remedy the error in "Chrome" and "MS Edge", follow these steps:
1. Open a new tab. 
2. Enter the URL address of the identity provider of the UMC server in the address line of the 

browser. The URL is the same as the one in the error message without "/swaclogin", for 
example, "https://uadtbf-01.asrd-lab.net/umc-sso".

3. The page with a warning regarding the secure connection is displayed.
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4. Accept the warning by clicking on "Proceed to uadtbf-01.asrd-lab.net (unsafe)".
5. The home page with the "User login" dialog is displayed.

Remedy the error in "Firefox"
To remedy the error in "Firefox", follow these steps:
1. Open a new tab.
2. Enter the URL address of the identity provider of the UMC server (ring server) in the address 

line of the browser, for example, "https://uadtbf-01.asrd-lab.net/umc-sso". 
3. A blank page opens. Close the page.
4. Refresh the home page with the function key <F5>. The home page with the "User login" 

dialog is displayed.

See also
Displaying runtime (Page 30)
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2.5 Logging out user
If you want to end your Runtime session, you have the following options to log out completely:
•  Use the "Logout" system function.
• Log out in the user management.
• Close all instances, i.e. open windows, of the browser in use.

Requirement
• You are logged in to Runtime.
• When you want to log out in the Runtime project, the system function "Logout" is 

configured, for example, to the event "Click left mouse button".

Logging out in the Runtime project with the system function "Logout"
• Select the button at which the system function "Logout" is configured.

Logging out in the user management
• Select "Logout" from the menu. 

Your session is ended.

New data downloaded from the TIA Portal is applied during the next login. 
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2.6 Basics

2.6.1 Process screens

Behavior of process screens
Process screens are static and dynamic representations of the plant, plant units or processes. You 
use the process screens to operate and monitor the plant or areas within it. 
A project on an HMI device consists of multiple process screens. When you start Runtime, the 
process screen that was defined as the start screen is displayed. You navigate between process 
screens according to a sequence, navigation or link that was defined by the configuration 
engineer.
The process screen contains static and dynamic screen objects. Screen objects visualize the 
current process values from the controller memory and record operator inputs that influence the 
process. Dynamization is realized through the connection of tags to the screen object during 
configuration.
Process values and operator inputs are exchanged between the controller and the HMI device by 
means of tags.
A process screen can be opened and operated by several operating stations simultaneously in 
Runtime.
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Note
Displaying a start screen changed by reloading
A start screen was defined for a project, and the project was started in Runtime. If another start 
screen is then defined in engineering and the project is loaded into the device again, the last 
active screen is displayed in Runtime after the connection is established again.
After reloading the project, refresh the screen in Runtime. If your HMI device is a computer, use 
the F5 key or the browser "Refresh" button to do this.

Screen navigation
Process visualization is generally split between multiple process screens, for example on the 
basis of functional or technological aspects. Changing between process screens is referred to as 
screen navigation.

Popup window
With corresponding configuration in the engineering system, clicking on a screen area opens a 
popup window containing additional information on the screen area.
Example: A screen represents a pump with its valves. When you click on a valve, a popup window 
opens with detailed information on the valve as well as input fields. You can check the state of 
the valve in the pop-up window and edit using the input fields.

Predefined styles
The following predefined styles are available for the process screens of the HMI devices:
• Light style
• Dark style
• Expanded style

Note
Compact mode in light and dark style
If the following elements in light or dark style fall below specific dimensions, they are 
automatically displayed in compact mode:
• Bar
• Slider
• Gauge
• Clock
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2.6.2 Tags

Behavior of tags
Tags correspond to defined memory areas to which values are written and/or from which values 
are read.
External tags correspond to the process values from the memory of an automation system. 
Internal tags transport values within the HMI device. The internal tag values are only available 
as long as Runtime is running.
The reading and writing of tag values is triggered by the controller or by the operator on the HMI 
device. The update cycle is defined in the configuration.
Tags are output in Runtime in trends or tables.

Executing the script of a trigger tag 
The script defined for a trigger tag in engineering is executed in Runtime in the following cases:
• During start of Runtime

The start value of the trigger tag is reported to Runtime.
• When the condition defined for the trigger tag occurs

For example if the trigger tag changes its state or exceeds a limit value.

Floating point numbers in the web client
Since the web client is implemented via JavaScript, tag values for floating point numbers can 
only be displayed with a mantissa of up to 54 bits. This leads to rounding of values with a 
mantissa greater than 54 bit in Runtime.

Note
Values with a mantissa of up to 64 bits are correctly displayed by I/O fields.

2.6.3 Alarms

Behavior of alarms in Runtime
Depending on the configuration, PLC alarms and HMI alarms from various areas of the plant are 
displayed in Runtime.
Depending on the configuration, the alarms are labeled according to importance or type and are 
represented and displayed differently. For example, a pending alarm can be displayed as follows:
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2.6.4 Logs

Data log
In Runtime, the data logging functions on the server as a log server. On the clients, the data 
logging functions as a log client. Only the log server accesses the database and compiles and 
logs the process data. The clients receive log data from the log server.
The log data is visualized in tabular or graphic format on all clients running tag logging in 
Runtime. The data to be displayed always comes from the log server. All operations on the client 
are transmitted to the server and the result of the processing is transferred back to the client.

Alarm log
Alarms in the project indicate fault states and operating states of a process. They are generally 
triggered by the controller. Alarms are displayed on the HMI device in screens. All the data 
associated with an alarm and configuration data are saved in an alarm log, for example, alarm 
class, time stamp and alarm text. Each alarm class can be logged separately. Alarms are logged 
either automatically or by operator intervention.

2.6.5 Contexts
Contexts allow you to view plant units according to a certain viewpoint, e.g. according to a 
certain customer, product, job or shift.
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Principle
Contexts always belong to a plant object. They are indicated as follows:
• User-defined contexts:

Using a program created with the ODK-API
• System-generated contexts:

For installed Performance Insight and Calendar option packages: Automatically in Runtime
Example: When a shift starts in Calendar, an archived context value is created with the shift 
ID

A log entry is generated each time a context (e.g. "Product") is executed. The logged context 
saves:
• The context value (e.g. "orange lemonade")
• Start time and end time of the execution time 
• The quality code 

Contexts in the trend control and alarm control
You can filter the content of these controls so that only data that has been generated in a 
specific plant unit and for the context you have selected is displayed. To do this, select a plant 
object, a context and one of its logged context values.

Example
A press house produces juices for various beverage brands. Using contexts, employees can 
display in runtime which alarms have occurred:
• During the production of a specific product (cloudy apple juice, clear apple juice, pear juice 

etc.).
• For orders for a specific customer (Schmitt, Schulze, Meier).
• During a specific shift (early shift, late shift, night shift).

Contexts in the "Reports" control.
You have the option of linking the generation of reports to the execution of contexts.
If the templates are configured appropriately, the reports available in the control can also contain 
information about contexts. When a report was generated as an Excel file and reads both 
contexts and alarms or tag values, you can then use the Excel filter function to filter the alarms 
and tags by context.

See also
Display context-dependent alarms of a plant object (Page 72)
Display context data of the plant objects in a trend control (Page 108)
Adding contexts (Page 191)

Runtime Operating Manual
2.6 Basics

WinCC Unified Runtime
System Manual, 05/2021 47



2.7 Runtime operation

2.7.1 On-screen keyboard

Definition
The on-screen keyboard is a virtual keyboard on the screen of an HMI device. The operator can 
click the displayed keys with a mouse, touch pen or finger.
The on-screen keyboard provides keys for numeric entries or for entering alphanumeric 
characters. The key labeling is based on the country setting is the Windows Control Panel. For 
example, no German or French special characters are available on an English keyboard. The 
arrangement of the letters is also different is some cases. If multiple keyboard layouts are 
installed, you can switch the keyboard layout by clicking on the country ID on the on-screen 
keyboard.

Activates the on-screen keyboard
The on-screen keyboard is displayed either automatically during input or activated by the 
operator when required via an input key. The hide function can be enabled with the "X" button 
in the title bar of the on-screen keyboard or by clicking a position outside of the input field.

Position of the on-screen keyboard on the screen
The default position of the on-screen keyboard is the center of the screen. Like every other 
window, the on-screen keyboard can be positioned on enlarged or reduced on the screen.
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2.7.2 On mobile devices

Definition
Various touch gestures are available for Runtime operation on mobile devices. Some touch 
gestures have different effects in the process pictures than in the controls.

Note
No operation with three or more fingers.
Only use one or two fingers when operating with touch gestures.
If you use more than two fingers with touch gestures, this can cause incorrect operation.
In the case of multi-touch operation with several fingers, you only operate the respectively 
configured objects.

Supported touch gestures in process pictures
Icon Gesture Function

Tap To select an object, tap on the corresponding position in the process picture.

Drag with one 
finger

To scroll horizontally or vertically, drag the object with one finger in the desired di‐
rection.

Scale To zoom in or zoom out, drag simultaneously with two fingers.

Keep pressed To call the shortcut menu, press for longer than a second on the object or the link.
The function corresponds to a right-click.
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Supported touch gestures in controls
Icon Gesture Behavior Supported WinCC 

controls

 

Tap • To select a row, tap the row.
• With corresponding configuration of the control: To se‐

lect a cell.
• To sort a column, click on the column header.
• In trend views:  Zooms into the trend area along the X/Y 

axis.
Requirement: The "Zoom +/-", "Zoom time axis +/-" or 
"Zoom value axis +/-" button is pressed. 

• Alarm control
• Process control
• Trend control
• f(x) trend control
• Ruler window
• System diagnos‐

tics view
• Parameter set con‐

trol
Tap with two 
fingers

Zooms out in the trend control.
Requirement: The "Zoom +/-", "Zoom time axis +/-" or "Zoom 
value axis +/-" button is pressed.

• Trend control
• f(x) trend control

Drag with 
two fingers

To scroll vertically or horizontally in the table of the control, 
drag in the control window with two fingers in the desired 
direction.

• Alarm control
• Process control
• Ruler window
• System diagnos‐

tics view
• Parameter set con‐

trol
Drag with 
one finger

• Moves the ruler.
• Moves the x-axis or y-axis. 

Requirement: The "Move trend area" or "Move axis area" 
button is pressed or the control is zoomed in.

• Trend control
• f(x) trend control

To select multiple rows, tap a row and drag your finger up or 
down.
With corresponding configuration of the control: To select 
multiple cells.

• Alarm control
• Process control
• Ruler window
• System diagnos‐

tics view
• Parameter set con‐

trol

To adapt the column width, tap a column grid line and drag 
your finger to the right or left.
To change the order of the columns, tap a column header 
and drag your finger to another column header.

Double tap To edit a cell value, tap the cell twice.
Requirement:
• Table view: The "Edit" button is pressed.
• Parameter set control: A parameter set is selected.

• Process control
• Parameter set con‐

trol
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Icon Gesture Behavior Supported WinCC 
controls

Scale To zoom in or out in the trend control, drag with two fingers 
in the control window.
Requirement: Trend control is paused and no zoom button is 
active. Or "Move trend area" is active.

Trend control

Swiping (hori‐
zontally and 
vertically)

To quickly scroll left or right or up or down within the table of 
the control, swipe in the corresponding direction.

• Alarm control
• Process control
• Ruler window
• System diagnos‐

tics view
• Parameter set con‐

trol

Multi-touch operation of process pictures
WinCC supports multi-touch operation of process pictures. 
This requires objects to be configured for simultaneous clicking and the screen to support multi-
touch operation.

Simulation of projects with multi-touch functions
WinCC supports the simulation of configured multi-touch functions. Requirement is that your 
monitor supports multi-touch operation. 

Releasing locked operator controls by two-hand operation
Unified supports safe operation of controls that can be used to change critical system settings, 
such as control variables with machine limits. Such operator controls can be configured as 
locked.
Locked operator controls are displayed dimmed in Runtime. To operate them, simultaneously 
press the release button provided for this purpose.  
Releasing the locked operator controls by pressing the release button has a cross-picture effect 
on all open pictures.
In Runtime, locked operator controls can only be accessed with the tab sequence if a release 
button is pressed at the same time.
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2.7.3 Placing the focus on objects
You have the following options:
• Click or tap on the object.

Note
Giving focus to objects with a transparent background
If an object has a transparent background, click on a visible area of the object.

• Press <Tab> until the object has the focus.

2.7.4 Operating objects with transparent fill
The objects displayed on a screen can have transparent ranges. 
Example: Sliders, bars and pointer instruments are enclosed by a transparent rectangle.

Trigger event
Requirement
An event which is triggered by operating actions such as typing or clicking has been configured 
for the object in the engineering.

Procedure
To trigger the event, proceed as follows:
• If the object does not have the focus, click a visible part of the object, e.g. its border.
• If the object already has the focus, the event is also triggered by clicking in the transparent 

area.

2.7.5 Flashing

Flashing in Runtime
You can display the objects flashing in Runtime. Scripts can be used to switch flashing on and off 
and influence the properties of the flashing.
Configure the flashing behavior of an object property in the engineering system for each color 
setting of an object that supports flashing.

Note
The flashing in Runtime does not change the color value of the property.
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2.8 Controls

2.8.1 Overview of controls
Runtime has operable controls in process pictures.
The following controls are available depending on the configured access rights:

Icon Control Brief description
Screen window Displays other screens of the object.

Trend control Displays graphical representations of 
tag values from the current process or 
from a log in the form of trends with 
values over time from the controller or 
a log.

f(x) trend control Represents the values of a tag as a func‐
tion of another tag.

Browser Displays HTML pages.

Media Player Enables video and audio files to be 
played.

Alarm control Shows currently pending alarms or 
alarm events from the alarm buffer or 
alarm log.

Process control Represents current or logged process 
data in a table.

Trend companion Displays evaluated data and statistics in 
a table.

Parameter set control Shows the parameter sets with which 
the PLC is set up for production.

System diagnostics view Shows the diagnostic status of multiple 
PLCs via traffic light SVGs.

2.8.2 Operating alarms

2.8.2.1 Basics of alarms

Alarm system

Introduction
The alarm system allows you to display and record operating states and faults on the HMI device 
that are present or occur in a plant.
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An alarm may have the following content:

No. Time of day Date Alarm text Status Alarm class
5 12:50:24:59

0
24.02.2007 Boiler pressure above 

high limit.
Active
Not active

Warning:
Color Red

The alarm system in WinCC Unified Scada
The alarm system processes various alarm types used by the PLC and the HMI device. The alarm 
types can be broken down into system-defined alarms and user-defined alarms: 
• User-defined alarms are used for monitoring the plant.
• System-defined alarms are used to monitor the HMI device or the PLC.
The detected alarm events are displayed on the HMI device. You can use the alarm system to log 
alarms from the ongoing process. Targeted access to the alarms combined with supplementary 
information about individual alarms ensures that faults are localized and cleared quickly. This 
reduces stoppages or even prevents them altogether.
The types of system-defined PLC alarms depend on the PLC used.
The following figure shows the alarm system structure for communication with the SIMATIC 
S7-300/400 controllers:
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The following figure shows the alarm system structure for communication with the SIMATIC 
S7-1500 controllers:

Alarms

Overview
The following table shows the basic components of alarms:

Alarm
class

Alarm
number

Time of 
day

Date Alarm state Alarm text Priority Trigger
tag

Limit val‐
ue

Alert 1 11:09:14 06.08.200
7

IO Maximum speed 
reached

2 speed_1 27

System 110001 11:25:58 06.08.200
7

I Switch to "Online" 
mode

1 PLC-Varia‐
ble_1

–
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Alarm class
Alarm classes are, for example, "Alerts" or "Errors". The alarm class defines the following for an 
alarm: 
• State machine
• Appearance in Runtime (e.g. color)
• Logging

Note
Device dependency
Logging is not available for all HMI devices.

Alarm number
An alarm is identified by a unique alarm number. The alarm number is assigned by the system. 
You can change the alarm number to a sequential alarm number, if necessary, to identify alarms 
associated with your project.

Time and date
Each alarm has a time stamp that shows the time and date at which the alarm was triggered.

Note
Time zones
All alarms are always synchronized in the utilized time zone.

Alarm state
An alarm has the events "Active", "Inactive", "Acknowledge". For each event, a new alarm is 
output with the current status of the alarm. 

Alarm text
The alarm text describes the cause of the alarm. 
The alarm text can contain output fields for current values. Which values are output depends on 
the runtime used. The value is retained at the time at which the alarm status changes.

Output process values in the alarm text 
Alarm texts output process values if parameters have been defined for the alarm in the 
engineering. A tag is assigned to each parameter. When the alarm is triggered, the alarm text 
shows the values of these tags.
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If a text list is also assigned to a parameter, the alarm text shows the text list entry that 
corresponds to the tag value.

Note
If no default value is assigned to the text list and the tag value is outside the defined value range 
of the text list, the alarm text returns a string with the parameter ID and the text list.

Priority
Displays the priority of individual alarms.

Limit value
Analog alarms display limit violations. Depending on the configuration, WinCC outputs the 
analog alarm as soon as the trigger tag exceeds or undershoots the configured limit value.

Alarm indicator
The alarm indicator is a graphic symbol that is displayed on the screen when an alarm of the 
specified alarm class is active.
The alarm indicator can have one of two states: 
• Flashing: At least one unacknowledged alarm is queued.
• Static: The alarms are acknowledged but at least one of them is not inactive yet. The 

displayed number indicates the number of queued alarms.

Computer
Operator input alarms have the "Computer" column in the alarm summary. The computer name 
is displayed for local alarms and the IP address for alarms from the web client.

Users
When an empty user name is passed to an alarm, it will display its formatting string instead of 
the user name, for example, "@S2%s@".

Alarm types

Introduction
The alarm types are used for various purposes for monitoring the plant. The alarms of the 
individual alarm types are configured and triggered in different ways.
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Alarm types in WinCC Unified Scada
WinCC supports the following alarm types:
• User-defined alarms 
• System-defined alarms

User-defined alarms
• Analog alarms

– Analog alarms are used for limit monitoring and show limit violations in the active 
process.

• Discrete alarms
– Discrete alarms are used for status monitoring and display a status in the active process. 

System-defined alarms
• System-defined PLC alarms

– System-defined PLC alarms are used to monitor the PLC.
– Diagnostic interrupts (SIMATIC S7) and system errors (RSE) also belong to the category of 

system-defined PLC alarms.
Note
Device dependency
System-defined PLC alarms are not available for all HMI devices.

• System alarms 
– System alarms belong to the respective HMI device and are imported into the project.
– System alarms are used for monitoring the HMI device.

Alarm classes

Introduction
Many alarms occur in a plant; these are all of different importance. You can assign the alarms of 
your project to alarm classes to clearly show the user which of the alarms are most important. 

Description
The alarm class specifies the display of an alarm. The alarm class specifies if and how the user has 
to acknowledge alarms of this alarm class.
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A new alarm class with mandatory acknowledgment is generated in WinCC.

Note
The choice of display modes for alarm classes depends on the options of your HMI device.

Examples of how to use alarm classes
• The alarm class of the alarm "Fan 1 speed in upper tolerance range" is "Alerts". The alarm is 

displayed with a white background. The alarm does not require acknowledgment.
• The alarm "Speed of fan 2 has exceeded upper warning range" is assigned to the "Errors" 

alarm class. The alarm is displayed with a red background and flashes at high frequency in 
runtime. The alarm is displayed until the operator acknowledges it.

Use the following alarm classes to define the state machines and appearance of alarms for your 
project:

Alarm classes for system-defined alarms
You cannot delete system-defined alarm classes and edit them only to a limited extent.
• "System"

The alarm class "System" contains alarms that display states of the HMI device and the 
controllers. Alarms of the alarm class "System" belong to the system alarms.

• "Diagnosis Events"
The alarm class "Diagnosis Events" contains alarms that display states and events in 
SIMATIC S7 controllers. Users do not acknowledge alarms from this alarm class.
Note
Device dependency
The alarm class "Diagnosis Events" is not available for all HMI devices.

• "Safety Alerts"
The alarm class "Safety Alerts" contains alarms for fail-safe operation. Users do not 
acknowledge alarms from this alarm class. Alarms of the alarm class "Safety Alerts" belong to 
the system alarms.
Note
Device dependency
The alarm class "Safety Alerts" is not available for all HMI devices.
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Alarm classes for user-defined alarms
The possible number of user-defined alarm classes depends on which runtime is used in your 
project.
• "Alerts"

The alarm class "Alerts" is designed to show irregular states and routines in the process. Users 
do not acknowledge alarms from this alarm class.

• "Errors"
The alarm class "Errors" is intended to show critical or dangerous states or limit violations in 
the process. Users must acknowledge alarms from this alarm class.

Common alarm classes
Common alarm classes originate in the STEP 7 alarm configuration. 

Alarm number 

Alarm number assignment
The system assigns unique alarm numbers for the project.

Note
When adapting alarm numbers, observe the inter-project uniqueness of the alarm number.

The alarm number of a system alarm has a higher priority than the number of a user-defined 
alarm. When you use the alarm number of a system alarm for a user-defined alarm, you change 
the alarm number of the user-defined alarm.

Alarm states

Introduction
An alarm assumes various alarm states in runtime. You analyze and report the process sequence 
using the alarm states.

Note
Device dependency
Reporting and logging are not available for all HMI devices.
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Description
Every alarm has an alarm state. The alarm states are made up of the following events:
• Active

The condition for triggering an alarm is fulfilled. The alarm is displayed, such as "Boiler 
pressure too high".

• Inactive
The condition for triggering an alarm is no longer fulfilled. The alarm is no longer displayed 
as the boiler was vented.

• Acknowledge
The user acknowledges the alarm.

Alarms without acknowledgment
The following table shows the alarm states for alarms without acknowledgment:

Icon Status Description
Active The condition of an alarm is fulfilled.

Inactive The condition of an alarm is no longer fulfilled.

Alarms with acknowledgment
The following table shows the alarm states for alarms with acknowledgment:

Icon Status Description
Active The condition of an alarm is fulfilled.

Inactive,
Not acknowledged

The condition of an alarm is no longer fulfilled. The user 
has not acknowledged the alarm.

Inactive,
Then acknowledged

The condition of an alarm is no longer fulfilled. The user 
has acknowledged the alarm after this time.

Active, 
Acknowledged

The condition of an alarm is fulfilled. The user has ac‐
knowledged the alarm.

Inactive,
Previously acknowledged

The condition of an alarm is no longer fulfilled. The user 
has acknowledged the alarm while the condition was 
still fulfilled.

Each occurrence of these states can be displayed and logged on the HMI device and a protocol 
printed.

Note
The display text for the states of an alarm is language-specific and configuration-specific.
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2.8.2.2 Alarm control

Introduction
The "Alarm control" object displays PLC alarms and HMI alarms that occur during the process in 
a plant. Each alarm is displayed in a separate alarm line. The content of the alarm line depends 
on the alarm blocks to be displayed. 
The following figure shows an alarm control:

Note
An alarm appears in the alarm control with the date and time stamp crossed out in the following 
situations:
• A deactivated alarm is enabled again.
• An alarm is reloaded after a power failure. This applies only to chronological alarming.
• The automation system is restarted. This applies only to chronological alarming.

List in the alarm control
The alarm control displays specific lists to provide a better overview of the active alarms. These 
lists filter and sort alarms by certain properties. To display the alarm summaries in the alarm 
control and switch the alarm control in runtime, click the associated button in the alarm control 
toolbar.

 List Description
Display active alarms Shows the pending alarms.
Display logged alarms Shows the logged alarms. 

The display is not updated immediately when new incoming 
alarms occur.
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 List Description
 Update and display logged 

alarms
Shows the logged alarms. 
The display is updated immediately when new incoming 
alarms occur.

 

Display defined alarms Shows the alarms configured in the engineering.
The configuration of which alarm types belong to the defined 
alarms is performed in the engineering.
 

Alarm statistics Displays statistical calculations of logged alarms.

The setting of whether the following alarms belong to the active alarms and to the defined 
alarms is made in the engineering:
• Not suppressed
• Deactivated
• Suppressed by design
• Shelved alarms 
You can change this setting in Runtime: 
• For the active alarms with the "Display options setup" button
• For the defined alarms with the "Deactivated alarms setup" button

Performance data for SIMATIC Unified PC
Number of controller alarms 160000
Number of OPC UA A&C alarms 20000
Number of alarms per second (continuous load) 20
Number of pending alarm events Unlimited
Number of alarms per 10 seconds (alarm burst) 8000

The maximum number of alarms that can be displayed in Runtime depends on the selected view:

View Maximum number of alarms that can be dis‐
played.

Display active alarms No limit
Display defined alarms
Alarm statistics
Display logged alarms 1000
Update and display logged alarms 100

See also
Alarm control overview (Page 64)
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2.8.2.3 Alarm control overview

Buttons of the alarm control 
The toolbar of the alarm control contains buttons for executing specific functions. Depending on 
the configuration, the following buttons are available for operator input:

Button Name Description
Display active 
alarms

The currently pending alarms are displayed and the alarm summa‐
ry. Alarms do not yet have the status "Inactive" or were not yet 
acknowledged.

Display logged 
alarms

Shows the logged alarms. 
The display is not updated immediately when new incoming alarms 
occur.

Update and dis‐
play logged 
alarms

Updates the logged alarms and shows them. 
The display is updated immediately when new active alarms occur.

Alarm statistics Visualizes statistical information, such as frequency and display du‐
ration of logged alarms. 

Alarm statistics 
setup

Setting options for calculating the alarm statistics.

Display defined 
alarms

Shows the alarms configured in the system.

Alarm signaling 
equipment

Shows all alarms for which the alarm signaling equipment was 
configured. The alarm signaling equipment is a visual or acoustic 
signal, such as a horn or warning light, that is displayed in addition 
to the alarm control in the system. 

First line The first of the currently active alarms is selected. This button is only 
operable if the "Show recent" function is disabled.

Previous line The previous alarm with regard to the selected alarm is selected. 
This button is only operable if the "Show recent" function is disa‐
bled.

Next line The next alarm with regard to the selected alarm is selected. This 
button is only operable if the "Show recent" function is disabled.

Last line The last of the currently active alarms is selected. This button is only 
operable if the "Show recent" function is disabled.

Skip to the next 
alarm that re‐
quires acknowl‐
edgment

Selects the next alarm that requires acknowledgment, starting 
from the currently selected alarm. This button is only operable if the 
"Show recent" function is disabled.

Previous page Navigates to the previous page.

Next page Navigates to the next page.
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Button Name Description
Single acknowl‐
edgment

Acknowledgment of a selected, visible single alarm. If using the 
multiple selection, the selected alarms which require single ac‐
knowledgment are not acknowledged.
A counter shows how many alarms are not acknowledged. The 
counter includes all connected servers, but no filters.

Group acknowl‐
edgment

Acknowledges all active, visible alarms which require acknowledg‐
ment in the alarm window, unless these require single acknowl‐
edgment. If you use the multiple selection, all marked alarms are 
acknowledged, even if the alarms are hidden.

Single confirm For twice-acknowledgeable alarms that have already been acknowl‐
edged once: Resets the alarm. Their status changes from "Active/
Acknowledged" to "Inactive".

Show recent Defines whether it is always the latest alarm that is selected in the 
alarm control. 
Button not pressed: The "Show recent" function is active.
• The current alarms are always displayed first in the alarm con‐

trol. 
• The visible area of the alarm control moves automatically, if 

necessary. 
• You cannot select the alarms individually or sort them by col‐

umn.
Button pressed: The "Show recent" function is paused.  

Info text setup Opens a dialog to display an info text.

Deactivate alarm Hides an alarm in the current alarm summary and in the alarm log 
summaries. 
Only available in the "Display defined alarms" summary.

Release alarm Releases an alarm selected in the "Disabled alarms" display. 
Only available in the "Display defined alarms" summary.

Shelve alarm Shelves an alarm. It appears in the "Shelved alarms" display. You use 
this feature, for example, to prevent that a deviation alarm affects 
the efficiency of your system.

Unshelve alarm Revokes the shelving of an alarm selected in the "Shelved alarms" 
display.

Copy lines Copies the selected alarms.

Time base setup Opens a dialog for setting the time zone for the time information 
shown in alarms.

Selection display Opens a dialog for filtering alarms. Here you define your own filter 
criteria or filter the alarms by criteria defined in the engineering 
system.

Sorting setup Opens a dialog for setting custom sorting criteria for displayed 
alarms. 
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Button Name Description
Display options 
setup

Opens a dialog for configuring the display options of the alarm 
control. Here you define which alarms are displayed, for example, 
only shelved alarms or all alarms.

Configuration of 
the disabled 
alarms

Opens a dialog for configuring the display options of the disabled 
alarms.

Print Starts printing the alarms displayed in the alarm control.

Export Starts exporting the alarms to a CSV file.

Select context For context-based filtering of alarms.
The alarm control only shows alarms that fall within the time period 
of the selected context entry.

Status bar of the alarm control   
The status bar displays the various statuses of the alarm servers. The status bar contains the 
following icons:

Icon Meaning
Shows the status to the alarm servers:
No faulty connections
Shows the status to the alarm servers:
Faulty connections
Shows the status to the alarm servers:
All connections are faulty

With the corresponding configuration in engineering, the status bar shows the number of 
alarms that are not acknowledged in runtime. The counter includes all connected servers, but no 
filters.
When a context is selected, the status bar shows the values of the selected context.

Icons in the alarm summaries     
"Status" alarm block:
Icon Meaning

Alarm is active 

Alarm is active/inactive

Alarm is active/acknowledged 
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Icons in the historical alarm list (short-term) 
"Status" alarm block:
Icon Meaning

Alarm is active

Alarm is inactive

Alarm acknowledged

2.8.2.4 Operating alarms

Note
Displayed alarms
The alarms that you see in the alarm control depend on which alarm summary you have selected 
in the toolbar.

Operation using the mouse
Selecting and operating alarms
• Click the alarm you want to edit.
• In the toolbar, click on the operator control whose function you wish to use.

Changing the order of the columns
This function can be configured and is only available in Runtime if it was enabled in engineering.
1. Hold down the left mouse button to drag a column header to another column header.
The columns swap positions.

Sorting columns
This function can be configured and is only available in Runtime if it was enabled in engineering.
1. Click on a column header.
2. Click the same column header again to reverse the sorting order.
3. You cancel the sorting by clicking again.

Operation using the keyboard
Press <Shift+ENTER> until the focus is on the alarm control. Then select the alarm to be edited 
and operate it using the toolbar. 
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Use the following buttons for this:

Buttons Description
<PgUp> Selects the previous alarm.
<PgDn> Selects the next alarm.
<Ctrl+Up Ar‐
row>
or 
<Home>

If multiple rows were selected, the first row of the selection is selected.

<Ctrl+Down 
Arrow>
or 
<End>

If multiple rows were selected, the last row of the selection is selected.

<Ctrl+Left Ar‐
row>

If multiple columns were selected, the first column of the selection is selected.

<Ctrl+Right Ar‐
row>

If multiple columns were selected, the last column of the selection is selected.

<Tab> Selects the next operator control in the toolbar.
<Shift+Tab> Selects the previous operator control in the toolbar.
<ENTER> Runs the currently selected operator control.
<Shift+PgUp> Scrolls to the left column-by-column.
<Shift+PgDn> Scrolls to the right column-by-column.

Touch operation
Refer to the section On mobile devices (Page 49).

Alternative operation
Depending on the configuration, you can also operate the alarm control via the function keys.

2.8.2.5 Filtering alarms

Introduction
You use criteria to define the alarms you want to display in the alarm control.
The following settings are available in the "Selection" dialog:

Setting Description
"AND/OR" col‐
umn

Adds additional criteria to the existing criteria with the Boolean operations AND or OR.

"Criterion" col‐
umn

Selection list with the available criteria.
Criteria correspond to the alarm blocks in the alarm control.
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Setting Description
"Operator" col‐
umn

Selection list with the available relational operators.

"Setup" column Free text field
"Remove" but‐
ton

Removes the selected filter criterion.

"Up/down" but‐
ton

Moves the selected filter criterion.

"Filter" area Free text area for direct input and editing of filter criteria.

In the example below, only the alarms that contain the alarm text "Motor on" and whose priority 
is less than or equal to 5 are displayed.

Requirement
The "Selection display" button is configured in the alarm control.

Procedure
To filter alarms in the alarm control, follow these steps:
1. Use the "Selection display" to open the "Selection" dialog.
2. In the "Criterion" column, open the selection list and select the entry "Alarm text".
3. In the "Operator" column, open the selection list and select the entry "Equal to".
4. In the free text field of the "Setup" column, enter the value "Motor on".
5. Select an AND logic operation from the selection list in the next row.
6. In the "Criterion" column, open the selection list and select the entry "Priority".
7. In the "Operator" column, open the selection list and select the entry "Less than or equal to".
8. Enter the value "5" in the free text field of the "Setting" column.
9. Confirm your entries with "Apply".
10.Close the "Selection" dialog.
For certain alarm blocks, such as the "date" and "time-of-day" system blocks, you specify the start 
and end times or a search text in the "Selection" dialog. Your input must be in the format required 
in the dialog. 

Note
In multi-user systems, make sure that contents displayed in the "Specify selection" dialog on a 
client have the same names on all servers.
When filtering by time, the start and stop values are not adjusted automatically when the time 
base of the alarm control is changed.
Example: At the PC location with the time zone "UTC + 1h", the alarm control has the "Local time 
zone" time base. You should filter by the time 10:00 to 11:00. Change the time base from "Local 
time zone" to "UTC". If you want to display the same alarms, change the filter to 9:00 to 10:00 hrs.
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Time-based filtering
During time-based filtering of the alarm control, always define two filter conditions linked via 
"And". For these conditions, use the operands "Greater than", "Greater than or equal" and "Less 
than or equal". 
Do not use the operand "Equal to". When filtering, you specify the filter period down to the 
millisecond, but internally the time stamp of alarms is stored precisely down to the nanosecond 
and the missing information for nanoseconds is supplemented by 0. A search with "Equal to" will 
therefore only find alarms whose time stamp has the nanosecond value 0.

Examples
You can use the following filter conditions to filter for alarms that were triggered between 12:00 
and 12:01:
• Filter condition 1: "Tripping time", "Greater than or equal to", 12:00:00.000
• Filter condition 2: "And", "Tripping time", "Less than or equal to", 12:01:00.000
You can use the following filter conditions to filter for alarms that were triggered at 12:00:00.000 
hrs:
• Filter condition 1: "Tripping time", "Greater than or equal to", 12:00:00.000
• Filter condition 2: "And", "Tripping time", "Less than or equal to", 12:00:00.001

See also
Display alarms for plant objects (Page 70)

2.8.2.6 Display alarms for plant objects

Introduction 
In the case of the corresponding configuration, the alarm control shows the alarms of the plant 
objects that are configured in the plant hierarchy:
• Automatic display

When the HMI device is assigned to a plant hierarchy or a plant object, and a plant overview 
and an alarm control are configured for the screen, the alarm control automatically shows the 
alarms of the plant object selected in the plant overview.

• Manual display through filters
If no plant overview is configured in the screen, filter the alarm control to display alarms of 
a plant object.

The alarm control offers the following options for plant object alarms:
• Display the hierarchy path of the alarm source 
• Filter the alarm control by plant objects
• Display alarm log of a plant object 
• Context-dependent display of plant object alarms

Runtime Operating Manual
2.8 Controls

WinCC Unified Runtime
70 System Manual, 05/2021



General requirements
• The plant hierarchy has been created and a device assigned in the engineering system. 
• An alarm control with the column "Area" has been configured in the screen of the assigned 

device.
• Runtime is active.

Filter alarm control by plant objects
Additional requirements
• Alarms are available for a plant object from the plant hierarchy. 

Procedure
1. In Runtime, click the "Selection display" button in the alarm control. 
2. Select "Area" as the criterion in the "Alarm filter" dialog.
3. Click the cell of the "Setting" column 
4. Click "...".

A tree of the plant hierarchy is displayed.
5. Select a plant object and confirm your selection.

6. Under "Operand", select one of the following operators:
– To display the alarms of the selected plant object, select "Same as".
– To output the alarms of the lower-level plant objects, select "Begins with".
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The alarm control shows its setting according to the alarms of the selected plant object or its 
lower-level plant objects. The "Area" column shows the complete path of the plant object.

Note
Display of the filter string for filters configured in engineering
The plant view is based on a type/instance architecture. When a filter has been configured in 
engineering that filters the alarm view by plant objects, you will first see a filter string with 
information from the type level in the "Filter" field of the "Alarm filter" dialog. 
If you select an operand under "Operand" or a plant object under "Setting", the filter string 
changes to the instance level and adopts the device ID.

Display alarm log for a plant object
Additional requirements
• The alarm log contains entries for a plant object from the plant hierarchy.

Procedure
1. In runtime, click on the "Display logged alarms" button. 
The alarm control shows the logged alarms of the plant object.

See also
Filtering alarms (Page 68)
Plant overview (Page 121)

2.8.2.7 Display context-dependent alarms of a plant object
This section describes how to show alarms that occurred on a plant object that you selected for 
a context that you selected.

Requirement
• An HMI device has been configured.
• An alarm control is configured in the device screen.
• The plant hierarchy has been created and assigned to the HMI device. 
• There are alarms for the plant object. 
• Contexts and context entries are available for the plant object.
• The "Select context" button is configured in the alarm control.
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Procedure
1. In the alarm control, click the "Select context" button.

The "Alarm context" dialog opens.
2. Click "..." and select the plant object whose data you want to display in the alarm control.
3. Select one of the contexts assigned to the plant object in the "Context" drop-down list.

A list of the entries logged for the context appears under "Logged context values".
4. Select an entry.
5. Click "OK".
The alarm control shows the alarms of the plant object that fall within the time period of the 
selected entry. The status bar shows the values of the selected context.

Note
"AND" link with other filters
When a filter is defined for the alarm control, the filter condition and the context conditions are 
linked via "AND".
When no alarms appear in the alarm control, check your filter settings by clicking "Selection 
display".

See also
Contexts (Page 46)

2.8.2.8 Sorting alarms

Introduction
In runtime, you can sort the alarms in the alarm control by column header.
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Examples for sorting alarms:
• In descending order by date, time, and alarm number. The latest alarm appears at the top.
• By priority

You must have defined the priority of the alarms in the "HMI alarms" editor and configured the 
"Priority" alarm block in the alarm control. As a result, in a single-line alarm control, only the 
top-priority alarm appears in the alarm window. A lower-priority alarm is not displayed, even 
if it is more recent. The alarms are displayed in chronological order.

• The "Alarm status" alarm block is sorted by the type of state and not by the configured status 
texts. For an ascending sort order, the following order is used:
– Active
– Inactive
– Acknowledged
– Deactivated
– Enabled
– Automatic acknowledgment
– Emergency acknowledgment
– Active/Inactive

When sorting the alarm control by columns, define the sort order over up to four columns. An 
arrow and a number are shown on the right in the column header. The arrow indicates the sort 
order (ascending or descending). The number beside the arrow indicates the sort order of the 
column headers.

Requirement
• "Allow sorting" is enabled for the respective columns in the configuration of the alarm 

control.
• The "Show recent" function is paused in the alarm control.

Procedure
To filter alarms in the alarm control by column, follow these steps:
1. Click the column header by which you want to sort the alarms first.

The number "1" is displayed with an arrow pointing upwards for ascending sort order or an 
arrow pointing downwards for descending sort order.

2. Optional: 
– To reverse the sort order for this column, click the column header again. 
– To cancel the sorting for this column, click the column header a third time.

3. If you want to sort by several columns, click the column header in the required order.
Alternatively, click "Sorting setup" and configure the sorting in the "Sorting" dialog.
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2.8.2.9 Deactivating individual alarms

Introduction
When you deactivate an alarm, this alarm is not logged. You can lock single alarms, alarm classes 
or alarm groups as required.

Note
Deactivated alarm:
Deactivated alarms are no longer deactivated after a restart of the WinCC Runtime. Only alarms 
that are deactivated directly in the automation system via data blocks remain deactivated 
(deactivated at source).
Deactivated alarm classes / alarm groups:
Alarm classes and alarm groups remain deactivated even after a restart of the WinCC Runtime.

Requirement
• The "Visibility" and "Allow operation" settings have been activated for the following buttons 

in the engineering system:
– "Deactivate alarm" 
– "Release alarm"
– "Display defined alarms"

• To activate: 
The alarm summary "Display defined alarms" is configured so that deactivated alarms are 
displayed.
Alternatively: If the "Visibility" and "Allow operator control" settings are enabled for the 
"Deactivated alarms setup" button, you can change the alarm summary configuration in 
runtime with this button.

• The user is authorized to deactivate and activate alarms.
Note
The "Deactivate alarms" and "Enable alarms" authorizations must be configured directly one 
below the other. This is necessary because the authorization level used automatically for the 
"Enable alarms" authorization is directly below the "Deactivate alarms" authorization.

• An alarm is displayed on the HMI device.

Deactivating an alarm
1. In the alarm control, select the alarm summary "Display defined alarms".
2. Select the alarm.
3. Click the "Deactivate alarm" button.

The alarm is removed from the alarm summary.
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Display deactivated alarms
1. In the alarm control, select the alarm summary "Display defined alarms".
2. Click the "Deactivated alarms setup" button.
3. Enable the option for deactivated alarms.

Activating an alarm
1. In the alarm control, select the alarm summary "Display defined alarms".
2. Select the alarm.
3. Click the "Enable alarm" button.

Notes
• Deactivating or activating an alarm of an Alarm_8(P) via S7PMC, always deactivates or 

activates all eight alarms of this block.
• An alarm that has been enabled again appears in the alarm control with the date stamp and 

timestamp crossed out.
• When an alarm is enabled again, it is checked by the system and, if the cause still exists, 

displayed again.

2.8.2.10 Shelving alarms

Introduction
You shelve an alarm for a specific period of time, for example, to prevent that a conformity error 
alarm affects the efficiency of your system. 
Shelving can be canceled at any time. To do so, you use the buttons "Shelve alarm" and "Unshelve 
alarm" in the alarm control in runtime.

Requirement
• The "Visibility" and "Allow operation" settings have been activated for the following buttons 

in the engineering system:
– "Shelve alarm" 
– "Unshelve alarm"
– "Display defined alarms"

• To unshelve: 
The alarm summary "Display defined alarms" is configured so that shelved alarms are 
displayed.
Alternatively: If the "Visibility" and "Allow operator control" settings are enabled for the 
"Deactivated alarms setup" button, you can change the alarm summary configuration in 
runtime with this button.

• An alarm is displayed on the HMI device.
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Procedure
To shelve an alarm, follow these steps:
1. In the alarm control, select the alarm summary "Display defined alarms".
2. Select the alarm.
3. Click the "Shelve alarm" button.
The alarm is shelved. Whether the alarm is visible in the alarm summaries for active alarms and 
defined alarms depends on the settings of this alarm summary.
Shelved alarms are still available and logged in the system.

Display shelved alarms
To display the currently shelved alarms, follow these steps:
1. In the alarm control, select the alarm summary "Display defined alarms".
2. Click the "Deactivated alarms setup" button.
3. Activate the option for shelved alarms.

Unshelve an alarm
To unshelve an alarm, follow these steps:
1. In the alarm control, select the alarm summary "Display defined alarms".
2. Select the alarm.
3. Click the "Unshelve alarm" button.
If the shelving has been canceled, the alarm is again visible in its last state.

2.8.2.11 Acknowledging

Acknowledgment model

Overview
The state machine is defined for an alarm class. Alarms that are assigned to this alarm class are 
acknowledged based on this state machine. The following state machines are used in WinCC:  
• Alarm without acknowledgment   

This alarm becomes active and inactive without having to be acknowledged. There is no 
visible response from the system. 

• Alarm with a single acknowledgment  
This alarm must be acknowledged as soon as the event that triggers the alarm occurs. The 
alarm remains pending until it is acknowledged.
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• Alarm with double-mode acknowledgment  
The alarm requires one acknowledgment as soon as the event that triggers the alarm has 
occurred, and a second acknowledgment when the event that triggers the alarm is no longer 
present. The alarm remains pending until it is acknowledged.

• Alarm without "Inactive" status with acknowledgment 
This alarm is displayed in the alarm control until it is acknowledged. The alarm then 
disappears from the alarm control. The alarm is only logged.

• Alarm without "Inactive" status without acknowledgment 
This alarm is displayed and goes out when the event that was triggered by the alarm is no 
longer present. The alarm is not entered in the alarm control. The alarm is only logged.

• First value alarm with flashing and single acknowledgment  
The first value alarm is a form of alarm processing in which an alarm is highlighted in a list of 
alarms whose status changed first since the last acknowledgment. Only the first alarm of this 
alarm class flashes when it is displayed in the alarm window.

• New value alarm with flashing and single acknowledgment  
New value alarm is a form of alarm processing in which the alarms whose status has changed 
since the last acknowledgment are highlighted.

• New value alarm with flashing and dual-mode acknowledgment 
The alarm flashes when the value being monitored has changed. You acknowledge this 
alarm when it becomes active or inactive. 

Overview of the state machines for multiple alarms
• Group acknowledgment of alarms in the alarm control

The alarm control has a "Group acknowledgment" button. This button triggers the 
acknowledgment of all visible alarms that require acknowledgment and are pending in the 
alarm control. 

• Single acknowledgment of alarms in the alarm control
The alarm control has a "Single acknowledgment" button. This button triggers the 
acknowledgment of individual alarms selected in the alarm control.

• Single confirmation of alarms with dual acknowledgment in the alarm control. The alarm 
control has a "Single confirm" button. The alarm with the state machine "Alarm with dual-
mode acknowledgment" is individually confirmed with this button after it has been 
acknowledged with group acknowledgment or single acknowledgment beforehand.

Note
If the "Show recent" button is pressed, the most recent alarm is always shown first. Group 
acknowledgment is only executed for the visible and selected alarms.

Acknowledging alarms
The number of alarms to be acknowledged is indicated by a counter at the "Single 
acknowledgment" button or, if the alarm control was configured accordingly in engineering, by 
the status bar.
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Introduction
You can acknowledge alarms in runtime according to your project configuration settings. You 
acknowledge alarms as follows:
• In the alarm control with the buttons "Single acknowledgment" and "Group 

acknowledgment", and for alarms with dual-mode acknowledgment also with the button 
"Single confirm".

• With customized buttons
When an operator authorization is configured for the operator controls, the alarms can only be 
acknowledged by authorized users.

Acknowledgment variants
You acknowledge individual alarms or multiple alarms together in runtime. The following 
options are possible:
• Single acknowledgment

Acknowledgment of an alarm using the "Single acknowledgment" button of the alarm 
control.

• Group acknowledgment
Acknowledgment of all pending, visible alarms that require acknowledgment in the alarm 
control using the "Group acknowledgment" button in the alarm control.

• Dual-mode acknowledgment
When an alarm requires dual-mode acknowledgment, you acknowledge the activation and 
deactivation of the alarm or you acknowledge the alarm and reset it with the "Single 
confirm" button in the alarm control. The alarm status changes from "Active/Acknowledged" 
to "Inactive". 

Requirement for single acknowledgment
An alarm is displayed on the HMI device.

Procedure
To acknowledge an alarm, follow these steps:
• Read the alarm texts of the pending alarm and perform corrective measures, if necessary.
• Select the alarm.
• Click "Single acknowledgment" in the alarm control.

Result
The alarm status is set to "Acknowledged". When the trigger condition for an alarm no longer 
applies, the alarm status is set to "Inactive" and no longer displayed on the HMI device.

Requirement for group acknowledgment
Several alarms require acknowledgment in the alarm control.
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Procedure
For group acknowledgment of alarms, follow these steps:
1. Read the alarm texts of the pending alarms and perform corrective actions, if necessary.
2. Click the "Single confirm" button in the alarm control.

Result
All pending alarms with the following properties have been acknowledged:
• Requires acknowledgment
• Does not require single acknowledgment
• Visible

2.8.2.12 Logging alarms

Logging basics

Introduction
An alarm log is used to document the alarms of the project. Alarm logs are created by the system. 
If an error or limit violation occurs, for example, an alarm is output in runtime. Each alarm event 
of an alarm is logged, such as the status change of the alarm from "Alarm active" to "Alarm 
acknowledged".
You can store the alarm events in a log database and/or log them to hardcopy as an alarm report. 
You can output the alarms stored in the database in runtime, for example, in an alarm control.
The logged alarms are stored in a circular log that consists of multiple single segments.

Content of the alarm log
The alarm logs are used to store all alarm data, including configuration data. You can read all 
properties of an alarm from the logs, for example, alarm class, time stamp and alarm texts. A 
new log segment with the new configuration data is generated whenever you edit 
configuration data of an alarm. This function prevents any change from influencing alarms 
logged previously.
The possible number of logged alarms depends on the server used.

Note
The time stamp of a logged alarm is always specified in standard UTC format (Universal Time 
Coordinated).

Because the alarm configuration is language-specific, the logs contain a configuration data table 
for each language configured.
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Storage media and location
Log data are stored in a database. You can further process the saved data in other programs for 
analysis purposes, for example.

Backup for log segments
Take backups of your log segments to ensure complete documentation of your process.

Displaying logged data
You display the logged data on the HMI device. To do this, show the "Show and update logged 
alarms" and "Show logged alarms" in runtime.

No logging due to overload
When an alarm cannot be written to the log after the configured number of attempts and within 
the defined time interval, the alarm is lost. The memory state is set to 
"StorageSystemWriteDataLost" internally. This documents that the number of alarms in the 
queue exceeds the configured high limit. No more alarms can be written to the log. 
The alarm "SystemOverloadAlarm" of the alarm class "ALCL@%SystemInformation" is triggered. 
It is displayed in the alarm control but not logged. 
Possible reasons for the overload:
• There are more alarms in the queue than can be processed.
• The alarms in the queue cannot be processed due to additional error conditions or memory 

states, for example, because the storage space is used up (memory state 
"StorageSpaceExceeded").

Connecting and disconnecting the alarm log backup

Introduction
When you want to access the data of an archived alarm log, connect the log backup to the 
project. You can configure an automatic connection or connect the alarm log to the project via 
a script. The logged alarms are displayed in the alarm control.
If you no longer want to access the backup of a log segment, disconnect the log backup from the 
project.

Requirement
The relevant backup files in "*. ldf" and "*.mdf" format are stored locally.

Display Time Range
Alarms are only displayed if you have configured the time range in the alarm control accordingly.
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Example
You have configured the time range so that only the alarms of the past 24 hours are displayed. 
When you connect to a log backup containing alarms that are older than 24 hours, these alarms 
are not included in the alarm control.

Automatically connecting to an alarm log
To automatically connect to the alarm log backup, follow these steps:
1. Insert the log backup files in the "RuntimeProjectPath\ProjectName\CommonArchiving" 

folder.
2. In runtime, the alarm log is automatically connected to the project.
If signing is enabled, signed log backup files that are changed will not be connected 
automatically. A WinCC system alarm is generated and an entry is added to the Windows event 
log in the "Application" section.

Connecting to the alarm log using a script
Using the "AlarmLogs" VBS object, you can link the log backup files to the project using a script. 
The log segments are then copied with the "Restore" VBS method to the "Common Archiving" 
folder of the Runtime project.

Automatically disconnecting the alarm log
To automatically disconnect the alarm log backup from the project, follow these steps:
1. Go to the folder "RuntimeProjectPath\ProjectName\CommonArchiving".
2. Remove the log backup files from the folder.

Disconnecting from the alarm log using a script
Using the "AlarmLogs" VBS object, you can disconnect the log backup files from the project using 
a script. The log segments are then removed with the "Remove" VBS method from the "Common 
Archiving" folder of the Runtime project. For additional information, see the description of the 
"AlarmLogs" VBS object and the "Remove" VBS method.

Display logged alarms

Introduction
The alarm control not only displays current alarms but also logged alarms.
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Requirements
• All logged data that is to be displayed must be stored locally on the logging server. The SQL 

server does not allow access to backup files held elsewhere, such as another computer on the 
network.

• The buttons "Show logged alarms" and "Show and update logged alarms" are configured in 
the alarm control.

Procedure
To display logged alarms, follow these steps:
1. In the alarm control, click the "Show logged alarms" button to display logged and current 

alarms. Only logged alarms are displayed. 
2. In the alarm control, click the "Show and update logged alarms" button to display logged and 

current alarms. Any new incoming alarms are updated immediately in the control.

2.8.2.13 Displaying alarm statistics

Introduction
The alarm statistics represent statistical calculations of logged alarms.

You can use a button in the alarm control to export the alarm statistics to an Excel file. 

Note
Filter
A filter set in the alarm control is not effective in the alarm statistics.

Note
Display options
Display options selected via the "Display options setup" button in the alarm control are not 
effective in the alarm statistics.

Runtime Operating Manual
2.8 Controls

WinCC Unified Runtime
System Manual, 05/2021 83



Requirement
• Alarms are logged.
• For the following button of the alarm control, the "Visibility" and "Allow operator control" are 

enabled in the engineering system:

Alarm statistics

Procedure
To display the alarm statistics in Runtime, proceed as follows:
1. Click the "Alarm statistics" button in the alarm control.

Result
The alarms to be displayed in the alarm statistics are specified in the engineering system. 
Depending on the engineering system, the following columns are displayed:

Column Description
Number Configured number of the alarm.
Frequency Frequency of an alarm. The system counts the number of occurrences of 

an alarm with "active" status in the log. If the alarm number is not found, 
this alarm number is not included in the statistics.

Sum active active Total display time of an alarm in seconds. The time period between the 
alarm states "active" and "active" is calculated.

Sum active inactive Total display time of an alarm in seconds. The time period between the 
alarm states "active" and "inactive" is calculated.

Sum active acknowledged Total display time of an alarm in seconds. The time period between the 
alarm states "active" and "acknowledged" is calculated.

Average active active Average display time of an alarm in seconds. The time period between 
the alarm states "active" and "active" is calculated.

Average active inactive Average display time of an alarm in seconds. The time period between 
the alarm states "active" and "inactive" is calculated.

Average active acknowledged Average display time of an alarm in seconds. The time period between 
the alarm states "active" and "acknowledged" is calculated.

The calculation of the time of acknowledgment includes the "acknowledged" alarm state. This 
"acknowledged" alarm state includes the acknowledgment by the controller.

Note
For the calculation, alarms in the "acknowledged" and "inactive" states are only used if a suitable 
alarm with "active" state is found in the result set beforehand. 
If an alarm from the controller is pending and Runtime is disabled and enabled several times, the 
alarm is entered into the log several times with the state "active". The alarm will also be included 
multiple times in the evaluation.
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2.8.2.14 Operating alarm statistics

Introduction
Using the statistics setup, you can change the settings for calculating the alarm statistics. The 
following settings are available:

Setting Description
Time range start • Now

The current time is displayed as the start time of the calculation.
• Fixed

The start time of the calculation can be changed as required.
Start time Start time for the calculation. If the "Now" option is selected under "Start 

time range", the start time cannot be changed.
Time range base Unit of time for the calculation. The following settings are available:

• Undefined
The default time unit "Minute" is used with this setting.

• Millisecond
• Second
• Minute
• Hour
• Day
• Month
• Year

Time range factor The time range factor depends on the "Time range base" setting. For 
example, if the number 4 is set for the time range factor and "Minutes" is 
set for the time range base, all alarms that are logged within this period 
will be evaluated.

Requirement
• Alarms are located in the alarm log.
• For the following button of the alarm control, the "Visibility" and "Allow operator control" are 

enabled in the engineering system:

Statistics setup

• The alarm statistics are selected in the alarm control.
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Procedure
To display the statistics setup in Runtime, follow these steps:
1. Click the "Statistics setup" button in the alarm control.

Setup opens.
2. Change the settings as required.
3. Click "OK".

Result
The calculation of the alarm statistics is displayed according to the changed settings.

2.8.3 Displaying tags in Runtime

2.8.3.1 Outputting the tag values

Overview
With WinCC you can output tag values in the HMI screen with different screen objects and 
change them.
• The I/O field is used for the input and output of process values.
• Bars are used for graphic display of the process values in form of a scale.
• Sliders are used for the input and output of process values within a defined range.
• The gauge is used to display the process values in form of an analog gauge.
In runtime you can also output tag values as table or as trend. You can use either process values 
or logged values as source for the tag values.
• Use a trend for the graphic display of tag values. Trends allows you to display the change in 

motor temperature, for example. 
• Use a table to compare tag values. In the table you can, for example, compare fill levels of 

supply tanks. 

Controls for displaying tag values
To display tag values as a trend, use the trend control. The versions of trend views are available: 
• "Trend control": You display a tag value over time, for example, the change in temperature. 

You can compare the current values and logged values or monitor the change in current 
values on the HMI device.

• "Function trend control": You display a tag value against a second tag value, for example, the 
engine speed against the heat produced.

You can use the "Trend companion" to create statistics, for example, from the displayed values. 
Furthermore, you can use the trend companion as reading assistance for the trend control. 
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To display tag values in a table, use the process control. 

Displayed values
When configuring the trend control, specify which tag values are to be displayed.
• "Online": The trend is continued with current individual values from the PLC.
• "Log": In runtime, the trend control displays the values of a tag from a data log. The trend 

shows the logged values in a particular window in time. The operator can move the time 
window in runtime to view the desired information from the log. 

2.8.3.2 Operating controls

Starting and Stopping Update

Introduction
You can continue the update of the data contained in the control with the "Start/Stop" buttons.
Some buttons stop the update automatically, e.g. "Define statistics area"
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The appearance of the button indicates whether the update is stopped or not:

The update has been stopped. To continue the update, click on the button.
 The update has been started. To stop the update, click on the button

Creating statistics for Runtime data

Introduction
You can generate an analysis of the process data for the Runtime data in the trend or process 
control. You can display the evaluated data in the trend companion.

Overview
Use the following buttons to create statistics of runtime data:

"Start/stop"

"Select time range"

"Statistics area"

Requirement
• A trend control or process control is configured.
• A trend companion is configured and connected to the trend or process control.
• Runtime is activated.

Displaying data in a statistics area window
Requirement:
The "Statistics area window" display mode is activated in the trend companion.
To display data in the statistics area window of the trend companion, proceed as follows:
1. In the trend control or process control, click "Stop".

The updated display is stopped, the process data continues being logged.
2. If you wish to evaluate data outside the displayed time range:

– Click "Select time range".
The "Time - Selection" dialog opens.

– Enter the required time range.
The data for the defined time range is displayed.
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3. If you are using a trend control:
– Click on the "Statistics area".

In the trend control, two vertical lines are displayed on the right and left margin.
– To define the statistics area, move the two lines to the desired position.

4. If you are using a process control:
– Use the mouse to select the rows for the desired time range in the table.

For different time columns with different time frames, you can select different time ranges 
for the calculation of statistics.

– Click on the "Statistics area" in the toolbar.
The evaluated data is displayed in the columns that you have configured in the statistics area 
window.
To continue with the display of Runtime data, click "Start".

Note
For additional statistical analysis of process data and logging of results, you can write the scripts 
yourself.

Displaying logged values

Introduction
Scroll through the displayed data of a log using the buttons in the toolbar of a trend or process 
control. If key combinations are configured, you can also use these for scrolling.
The buttons for browsing in logs are available only if data is supplied through logging tags.
The logged values of a tag are displayed within a time range in the trend or process control.

Overview
Use the following buttons to display logged values:

"First data record"

"Previous data record"

"Next data record"

"Last record"
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Requirement
• Time range is configured.

Buttons for Archived Values
To scroll in archived values, proceed as follows:
1. To display the first data record of the time range, click on .
2. To display the previous data record of the time range, click on .
3. To display the next data record of the time range, click on .
4. To display the last data record of the time range, click on .

Elements of the status bar

Elements of the status bar
The status bar of the trend or process control can contain the following elements:

Icon Name Description
Connection status1 No faulty data connections.

Faulty data connections exist.

All data connections are faulty.

"Line 1"2 Selected line Shows the number of the selected line.
"Column 2"2 Selected column Shows the number of the selected column.
"23.02.2010" Date Shows the system date.
"23:59:59" Time Shows the system time.

Time base Shows the time base used in the display of times.

1: If you double-click on the "Connection status" icon, the "Status of the data connections" window opens. 
The following properties of each data connection are listed in the window:
• Name
• Status
• Tag name
2: Only in the process control

Basics of time range
The time range is the range from which the values at the HMI device are shown. The time range 
is determined by the start time and the end time. The time range is always in the past. If the end 
time is later than the current system time, the current system time is used as a temporary end 
time.
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A distinction is made between the following time ranges:
• Static time range
• Dynamic time range

Static time range
The static time range is determined by fixed start and end times. The values are displayed within 
this time range.

Dynamic time range
The dynamic time range is determined by a period of time beginning with a fixed start time. The 
end time thus corresponds to the conclusion of the time period.
You set the time period as follows:
• Duration, e.g. 30 minutes
• The number of measurement points multiplied by the update cycle also produces a duration.

Configuring time range
Configure the time range for all controls. Configure the time range in the time column or in the 
time axis for the process control and the f(t) trend control. For the function trend control, 
configure the time range directly at the trend.

Exporting values

Requirement
• The "Export" button is configured in the control.

Procedure
1. Optional: For the export of a trend control, check the time format for the time axis 

configured in the control. 
The time axis of the export file takes on the time format configured in the control.

2. Click "Export" in the control.
3. Enter the name of the target file.
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4. For the trend companion and process control: Choose whether all values are exported or just 
the values selected in the control.

5. Optional: Using "Select format", determine which separator and which character set the 
target file uses.
Note
Displaying Asian languages correctly in MS Excel
If Runtime is running in an Asian language, select the character set "UTF-8".

2.8.3.3 Trend companion

Trend companion basics

Function
The trend companion displays values or statistics from a control. The content of the trend 
companion is specified during its configuration.

Overview of the trend companion
The trend companion is connected to one of the following controls:
• Trend control
• Function trend control
In the trend companion, a "display mode" is specified during configuration. The display mode 
determines which data are shown in the trend companion.
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Display mode
Three different display modes are available in the trend companion.
• Ruler window

The ruler window shows the coordinate values of the trends on a ruler or values of a selected 
line in the table.

• Statistics area window
The statistics area window shows the values of the low limit and high limit of the trends 
between two rulers or the selected area in the table. You can only connect the statistics area 
view to the trend control or the process control.

• Statistics window
The statistics window displays the statistical evaluation of the trends. Among other things, 
the statistics include:
– Minimum
– Maximum
– Average
– Standard deviation
– Integral

All windows can also display additional information on the connected trends or columns, such 
as time stamps.

Overview of trend companion

Note
With version V16, the "Trend companion" control is supported only for Unified PC. If you use the 
control under Unified Comfort Panel, an error message of the compiler is returned. Existing 
projects under Unified Comfort Panel in which the control is configured must delete the control 
before compilation to version V16.

With the "Trend companion", you display evaluated data and statistics of a control in a table.
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Buttons of the trend companion
The toolbar contains buttons for executing specific functions. Depending on the configuration, 
the following buttons are available for operator input:

Icon Name Function
Statistical analy‐
sis

Displays the statistical values from a defined "statistics range" of the 
trend or process controls in the statistics window of the trend com‐
panion.
Only available with a configured trend companion.

Statistics area Specifies the period for calculation of statistics.

Ruler window Displays a ruler that shows the coordinates of the intersection point 
with a trend in the trend companion.
Requirement: The trend companion is configured with "Ruler win‐
dow" display mode.

Print Starts the printout of the values shown in the table.

Export Exports all or selected data to a *.CSV file.
Depending on the configuration and authorizations, the following 
options may be available:
• Display export settings and start export
• Select file name and directory
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2.8.3.4 Trend control

Overview of trend control
With the trend control, you show the currently pending process values or logged values as a 
trend over time. You design the trend display according to your wishes.

Buttons of the trend controls
The toolbar contains buttons for executing specific functions. Depending on the configuration, 
the following buttons are available for operator input:

Icon Name Function
First record Shows the trend direction starting with the first logged value.

Requirement: The values come from a process value log.

Previous record Shows the trend direction of the previous time range.

Start/stop Stops and starts the trend update. The values are buffered and up‐
dated as soon as you start the trend update again.

Next record Shows the trend direction of the next time range.

Last record Shows the trend direction up to the last logged value.
Requirement: The values come from a process value log.

Previous trend Displays the previous trend in the foreground.

Next trend Displays the next trend in the foreground.
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Icon Name Function
Ruler Displays a movable ruler that shows the coordinates of the intersec‐

tion point with a trend in the trend companion.
With stopped trend update, the trend values are also displayed in 
tooltips.
Requirement: The trend companion is configured with "Ruler win‐
dow" display mode.

Zoom time axis +/- Zooms into or out of the time axis in the trend control.
Left-click: Zoom in

Zoom value axis 
+/-

Zooms in or out of the value axis in the trend control.

Zoom area Zooms in on the section of the trend control. You define the section 
by dragging with the mouse.
Use the "Original view" button to return to the original view.

Zoom +/- Enlarges or reduces the view in the trend window.

Move trend area Moves the display in the trend area. 

Move axes area Moves the display in the axes area.

Original view Returns to the original view from the zoomed display.

Select time range Opens a dialog in which you configure the time range.

Select trends Opens a dialog in which you set the visibility and sorting of trends. 

Select data con‐
nection

Opens a dialog in which you select the data source:
• Process value log
• Tag
• Recipe (only function trend control)

Statistics area Enables you to define a time range for which statistical values are 
determined. Vertical lines which you use to set the time range are 
displayed in the trend window. 

Statistical analysis Opens a statistics window to display the minimum, maximum, aver‐
age, and standard deviation for the selected time range and the 
selected trend. 

Print Starts printing the trends shown in the trend window. 
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Icon Name Function
Export Opens the dialog for saving the trend data in CSV format.

The time axis in the export file takes on the time format configured 
in the control. If necessary, change the configuration of the time 
format in the control before the export.

Select context Shows the value range of the resulting data for analysis purposes

Overview of function trend control
With the function trend control, you display active or logged process values as a function of 
another tag in a trend. You design the trend display according to your wishes.

Button of the function trend control
The toolbar contains buttons for executing specific functions. Depending on the configuration, 
the following buttons are available for operator input:

Icon Name Function
Zoom +/- Zooms in or out on the trends in the trend window. 

Zoom area Zooms in on the section of the trend control. You define the section 
by dragging with the mouse. 
Use the "Original view" button to return to the original view.

Zoom X axis plus 
minus

Zooms into or out of the time axis in the trend control.
Left-click: Zoom in
<Shift + Left-click>: Zoom out
Use the "Original view" button to return to the original view.
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Icon Name Function
Zoom Y axis plus 
minus

Zooms in or out of the value axis in the trend control.
Left-click: Zoom in
<Shift + Left-click>: Zoom out
Use the "Original view" button to return to the original view.

Original view Returns to the original view from the zoomed display.

Previous trend Displays the previous trend in the foreground.

Next trend Displays the next trend in the foreground.

Ruler Displays a ruler that shows the coordinates of the intersection point 
with a trend in the trend companion. 
Requirement: The trend companion is configured with "Ruler win‐
dow" display mode.

Move trend area You can move the trends in the trend window along the X axis and the 
Y axis using the button.

Move axes area You can move the trends in the trend window along the value axis 
using the button.

Select time range Opens a dialog in which you configure the time range.

Select trends Opens a dialog for setting the visibility of trends.

Select data con‐
nection

Opens a dialog in which you select the data source:
• Process value log
• Tag
• Recipe

Print Click this button to print the trend shown in the trend window. The 
print job used during printing is defined in the configuration dialog in 
the "General" tab.

Export data This button is used for exporting all or the selected runtime data to a 
csv file.

Value aggregation

Introduction
If the number of process values or archive values to be displayed for the selected time range in 
a trend control is larger than the number of pixels available for the trend, they will be aggregated.
Which values are aggregated to a trend value depends on the loading time of the trend control. 
For this reason, screen changes can result in a change of the trend line.
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Avoid aggregation
To avoid that values are aggregated, select a shorter time range or enlarge the width of the trend 
control.

Example
• Pixels available for the trend: 600 
• Measuring interval of the tag set as the data source: 10 times per s 
• Time range: 10 minutes, 
i.e. in the selected time range, 6000 values are measured or logged. When drawing the trend, 
10 values are aggregated to each trend value.
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The trend displays different values depending on the loading time. The following graphics 
illustrate how the last two aggregated trend values change when the loading time is 11:00:0019 
instead of 11:00:0024.
• Loading time 11:00:0019:

• Loading time 11:00:0024:
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Using the trend control

Online configuration of the trend control

Introduction
In Runtime, you configure online and thus change the appearance of the trend control. 
During the configuration of the trend control, it is specified whether online configurations are 
retained or discarded during a screen change or after Runtime is ended.

Overview
Use the following buttons to configure the trend control in Runtime:

"Select data con‐
nection"

Opens a dialog in which you can set the source from which a con‐
figured trend is supplied.
Possible sources are the tags or logging tags of an HMI device or 
plant object and UDTs.

"Select trends" Opens a dialog in which you set the visibility and sorting of trends.

"Select time 
range"

Opens a dialog in which you configure the time range.

See also
Select data connection of a trend (Page 105)

Using the zoom functions in trend windows

Note
Scrolling in a zoomed in trend control
When the trend control is zoomed in, you can scroll using the mouse wheel:
• Move the mouse wheel to scroll up or down.
• Press <Shift> and move the mouse wheel to scroll to the left or right.

Introduction
Key functions can be used for zooming in on, zooming out of and returning to the original view 
for trends, axes and various zoom areas of the trend window.
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Overview
The following zoom functions are available in the trend window:

Zoom time axis +/- Zooming in or out of time axis

Zoom value axis +/- Zooming in or out of value axis

Zoom area Zooming in on a trend control area

Zoom +/- Zooming in or out on trend

Original view Returning to the original view

Requirement
• The trend control is open
• Buttons with zoom functions are configured
• Runtime is activated

Zooming in on a trend control area
Using the toolbar
1. Click on "Zoom area" in the toolbar.

The updated display is stopped.
2. Drag with the mouse to draw a box around the area to be zoomed.

If there are at least two measured values within this area, the area of the trend is zoomed.
3. To return to the original view of the trend, click "Original view".
4. To restart the update, click "Start/Stop".
The default values are used for the axis.

Using the mouse wheel
Requirement: No button for zooming has been clicked in the toolbar.
1. Pause the update of the trend control.
2. Press <Ctrl> and move the mouse wheel.

Zooming in or out on trends
If you zoom in or out on a trend, the 50% value of the trend is always in the middle of the value 
axes.

Runtime Operating Manual
2.8 Controls

WinCC Unified Runtime
102 System Manual, 05/2021



Proceed as follows to zoom in or out on a trend:
1. Click "Zoom +/-".

The updated display is stopped.
2. To zoom in on a trend, click on the trend with the left mouse button.
3. To zoom out on a trend, hold down the <Shift> key and click on the trend with the left mouse 

button.
4. To return to the original view of the trend, click "Original view".
5. To restart the update, click "Start/Stop".
The default values are used for the axis.

Note
If you change the value area of a value axis on the "Value Axis" tab in the configuration dialog 
while zooming, the visible zoom area is set to the new value area.

Zooming in on the time axis or value axis
While zooming with time or value axes, the 50% value of the trend is always in the middle of the 
axes.
Proceed as follows to zoom the time axis or value axis:
1. To zoom in or out on the time axis, click on "Zoom time axis +/-".

The updated display is stopped.
2. To zoom in or out on the value axis, click on "Zoom value axis +/-".

The updated display is stopped.
3. To zoom in on an axis, click on the trend control with the left mouse button.
4. To zoom out on an axis, hold down the <Shift> key and click on the trend control with the left 

mouse button.
5. To return to the original view of the trend, click "Original view".
6. To restart the update, click "Start/Stop".
The default values are used for the axis.

Zooming using touch gestures 
Refer to the section On mobile devices (Page 49).

Sorting trends
If a trend area contains multiple trends, you can select the order of the trends.
You have the following options:
• Specify the top trend
• Specify the order of all trends
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Specify the trend order
Requirement
The "Select trend" button is configured in the toolbar.

Procedure
1. Click "Select trend" in the toolbar.
2. Click on a trend.
3. Move the trend to the selected position using the buttons.
4. Repeat these steps for the other trends.

Specify the top trend
In the drop-down list of the trend area, select the trend that you want to display as top trend.
Alternatively, use the "Select trend" button in the toolbar and move the desired trend to the top 
position.

Hiding and showing trends

Requirement
The "Select trend" button is configured in the toolbar.

Procedure
1. Click "Select trend" in the toolbar.
2. Disable the trend option to hide a trend.
3. Enable the trend option to show a trend.

Determining the coordinates of a point

Introduction
The "Ruler" button is used to determine the coordinates of a point on the trend by means of a 
ruler. You can zoom in on an area of the trend to make coordinate finding easier. If you display 
the ruler in the trend control, you can move the ruler at any time.
If you click on the trend with the mouse, several trend parameters are shown in the tooltip for 
the trend control.

Requirement
• A trend control is configured
• A trend companion is configured and connected with the trend control
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• The "Ruler window" display mode is activated in the trend companion
• Runtime is activated

Procedure
Proceed as follows to determine the coordinates of a point:
1. Click "Ruler" in the trend control.

The ruler is shown.
2. Move the ruler to the desired position with the mouse.
3. If you want to zoom in on an area, click on "Zoom area".

– Move the ruler to the desired position with the mouse.
– To return to the original view, click "Original view".

Result
In the ruler window of the trend companion, besides the X value/time stamp and the Y value, the 
data that you have configured in the trend companion is shown in the columns.
In the trend companion, the indices "i" and "u" can be displayed in addition to the values:
• "i.": The displayed value is an interpolated value.
• "u.": The displayed value has an uncertain status:

– The start value after Runtime activation is unknown
– A substitute value is used

Note
You can also display the "uncertain" status of a value in the displayed trend curve. You 
must activate the "Value with uncertain status" option on the "Trends" tab under "Limits".

Alternative procedure
Alternatively, you can also connect the trend companion to the process control. In the "ruler 
window" display mode, the values of the selected row are displayed in the trend companion.

Select data connection of a trend
You have the option to set in Runtime the source from which a trend is supplied. 
Possible sources:
• Tags and logging tags of an HMI device, plant object or PLC
• UDTs
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Requirement
• An HMI device has been configured.
• A trend control is configured in the screen of the device.
• To display logging tags: A data log has been configured.
• To display the tags of a plant object: The plant hierarchy has been created and assigned to the 

HMI device. 
• Runtime is active.

Procedure 
1. Click on "Select data connection" in the toolbar of the trend control.  

The "Selection of logs/tags" dialog opens.
2. Click "Trend:" and select a trend.
3. Click "Tag".

The "Browser view" dialog opens in which you specify how the selected trend is supplied with 
data. 

4. (Optional) Define in a filter.
5. Use the toolbar to configure the view in the dialog: 

"Small icons"

"List"

"Details"
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6. Use the toolbar to configure the contents of the dialog: 

"Online tags" Shows the device and its tags.

"Logging tags" Shows the device and its logging tags.

"CPM" Shows the plant hierarchy and the plant object tags.

"UDT" Shows the device and its UDTs.

"CPM logging tags " Shows the plant hierarchy and the logging tags of the plant ob‐
jects.

7. In the tree, select the object whose data you want to display in the trend control.
8. Select a tag as the data source.
9. Confirm your entries.
The values of the tags are displayed in the trend control. If the path belongs to a plant object, the 
path of the plant object is also shown in the trend control.
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Changing the time range of a trend

Procedure 
The following table shows the configuration options for the time range:

Field Description
Time axis Select the configured time axis for which you want to define a time range.
Time range Set the time range:

• If you want to define a fixed time interval, select the setting "Start to end time". Enter the date and time 
for each.

• If you want to define a time period, select the setting "Time range". Define the date and time for the start 
time. The length of the time interval to be displayed is determined by multiplying the "Factor" by the 
"Unit of time".

• If you want to display a certain number of values, select the setting "Number of measuring points". 
Define the date and time for the start time. Enter the desired number of measuring points in the input 
field.

To configure the time range, follow these steps:
1. Click on "Select time range" in the toolbar of the trend control.

The "Time selection" dialog opens.
2. Select the "Time axis" for which you want to adapt the time range.

If the trends in a trend control are to be displayed with a common time axis, the specified time 
range applies to all trends.

3. Configure the time range.
The entry format of the date and time depends on the Runtime language used.

Display context data of the plant objects in a trend control

This section describes how to show context-dependent data of a plant object in the trend control.
The evaluation is relevant, for example, in connection with the WinCC Performance Insight in 
order to analyze the effectiveness or the fault rate of the plant.

Requirement
• A trend control is configured in the screen of an HMI device.
• The plant hierarchy has been created and assigned to the HMI device. 
• The data source of one of the trends in the trend control is a plant object.
• To display the logging tags of the plant object: A data log has been configured.
• Contexts are available for the plant object.
• The "Select context" button is configured for the trend control.
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Procedure
1. In the trend control, click "Select context".
2. Select the plant object set as data source.
3. Select one of the contexts assigned to the plant object in the "Context" drop-down list.

A list of the entries logged for the context appears under "Logged context values".
4. Select an entry.
5. Click "OK".
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Result
The time period of the selected entry is applied to the time axis of the trend area. The trend 
represents the data that falls within the time period of the selected entry.

Note
Effect on other trend areas
If the plant object selected as data source has multiple interface tags and trends from other trend 
areas of the trend control display these tags, their time axes are also updated accordingly.

See also
Select data connection of a trend (Page 105)
Contexts (Page 46)

2.8.3.5 Process control

Overview of process control
With the process control, you display active or logged process values in a table. You design the 
display of the table as you wish.
You create statistics from selected data. You also export the data for further use.
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Buttons of the process control
The following table shows the buttons that are available in the process control:

Icon Name Function ID
"First data record" Displays the history of a tag within a specified time range 

starting with the first logged value.
Requirement: Values come from a process value log.

0

"Previous data re‐
cord"

Displays the history of a tag within the previous time 
interval, based on the currently displayed time interval.
Requirement: Values come from a process value log.

1

"Start/stop" Stops and starts the column update. The values are buf‐
fered and updated as soon as you start the column up‐
date again.

2

"Next data record" Displays the history of a tag within the next time interval, 
based on the currently displayed time interval.
Requirement: Values come from a process value log.

3

"Last record" Displays the history of a tag within a specified time range 
ending with the last logged value.
Requirement: Values come from a process value log.

4

"Edit" Activates editing of table entries. To edit a value, double-
click in the desired table cell.
Requirement: Updated display is stopped.

5

"Previous column" Moves the value column in front of the previous value 
column.
The function refers to the value columns that are as‐
signed to a time axis.

6

"Next column" Moves the value column to behind the next value col‐
umn.
The function refers to the value columns that are as‐
signed to a time axis.

7

"Select time range" Opens a dialog in which you configure the time range. 8

"Select data connec‐
tion"

Opens the dialog for selecting the logs and tags of an 
HMI device, plant object or PLC that serve as data source 
for this table view. 

9

"Create archive val‐
ue"

Creates a table entry for a log value.
Enter the log value manually. Its time stamp corresponds 
to the time at which you added the table entry.

10

"Delete archive val‐
ue"

Deletes a logged value. 11
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Icon Name Function ID
"Print" Prints the selected values.

You specify the print job in the "General" tab of the con‐
figuration dialog.

12

"Export" Exports all or selected data to a *.CSV file.
Depending on the configuration and authorizations, the 
following options may be available:
• Display export settings and start export
• Select file name and directory

13

Using the process control

Online configuration of the process control

Introduction
In Runtime, you configure online and thus change the layout of the process control. The process 
control configuration specifies whether online configurations are retained or discarded on a 
screen change or after Runtime is ended.

Overview
The following buttons make online configuration possible in process control:

"Select data connection"

"Select time range"

Changing the data connection
The following table shows the configuration options for data connection:

Field Description
Value column Choose the configured value column for which you want to change the data con‐

nection.
Data Source Define whether the selected value column is supplied with a logging tag or online 

tag.
Tag name Select the tag name for the data connection.
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Proceed as follows to change the data connection:
1. Click "Select data connection" in the toolbar.

The "Log/tag selection" dialog is opened.
2. Choose the "Value column" for which you want to change the data connection.
3. Select the "Data supply" and the "Tag name".

Changing a time range
The following table shows the configuration options for the time range:

Field Description
Time column Select the configured time column for which you want to define a time range.
Time range Set the time range:

• If you want to define a fixed time interval, select the setting "Start to end time". Enter 
the date and time for each.

• If you want to define a time period, select the setting "Time range". Define the date 
and time for the start time. The length of the time interval to be displayed is deter‐
mined by multiplying the "Factor" by the "Unit of time".

• If you want to display a certain number of values, select the setting "Number of 
measuring points". Define the date and time for the start time. Enter the desired 
number of measuring points in the input field.

To configure the time range, follow these steps:
1. Click on "Select time range" in the toolbar of the process control.

The "Time - Selection" dialog opens.
2. Choose the "Time column" for which you want to adapt the time range.

If the columns of a process control are to be displayed with a common time axis, the 
specified time range applies to all columns.

3. Configure the time range.
The entry format of the date and time depends on the Runtime language used.

Editing a table field

Introduction
You change the values displayed in the process control manually using the "Edit" button.
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Overview
The following buttons allow you to edit the table fields:

"Start/stop"

"Edit"

Requirement
• The process control is configured
• The "Edit" button is configured
• Runtime is activated

Procedure 
Proceed as follows to edit a table field in Runtime:
1. Click "Stop" in a process control.

The updated display is stopped, the process data continues being logged.
2. Click "Edit".
3. Double click on the desired table field of a value column.
4. Enter the new value.

The changed value is logged.
5. To continue with the display of Runtime data in the process control, click on "Start".

Moving value columns
You can rearrange the value columns assigned to a time axis.

Using the toolbar
1. Click on a column.
2. To move a column to the left, select "Previous column" in the toolbar. 

The column is shifted one position to the left.  
If you have selected the first column, it is moved to the end of the value columns.

3. To move a column to the right, select "Next column" in the toolbar.
The column is shifted one position to the right.  
If you selected the last column, it is moved to the beginning of the value columns.

With the mouse
Drag the column to a different column using the mouse.
The column is inserted in front of the other column.
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2.8.4 Screen window

Application
The "Screen window" object is used to display other screens of the project in the current screen. 
To continuously update the content of a screen window, for example, the object must be 
dynamized. User-defined menus and toolbars can be used to add specific buttons to the screen 
window.
You can also use independent screen windows independently of the screen in question. With 
appropriate hardware equipment and support by the operating system, you can also control 
multiple monitors and map processes in a more comprehensive and differentiated manner.

Layout
The settings for the position, geometry, style and color of the object are made during 
configuration. 
In particular, the following properties are changed:
• Zoom factor: Defines the size of the embedded screen.
• Screen section: Defines the section of the embedded screen that is displayed in the screen 

window. If the embedded screen is larger than the screen window, you configure scroll bars 
for the screen window.

• Independent screen windows: Specified that the screen windows are displayed 
independently from the screen in which they were configured.

Note
Cascading screen windows
Screen windows can also display screens which, in turn, contain screen windows. Up to 14 
cascaded screen windows can be displayed.
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2.8.5 Web control

Introduction
The "Browser" control is designed for the visualization of simple HTML pages. It allows creation 
of centrally stored machine-specific descriptions, which are displayed from different HMI 
devices.
You have access to the data of the local user management in Runtime via a browser.

Note
Switching the functionality of the web control as a file explorer, in the following ways, for 
example, is not enabled in WinCC:
• Entry of a folder or drive, e.g. "\" or "C:", or
• Connection to an FTP server, for example, "ftp://"
One reason this function is not implemented is to prevent inadvertent changes to files, their 
deletion or execution.     
When configuring, ensure that the operator can only enter valid Internet addresses, for example, 
by using symbolic I/O fields. Configure a password-protected input for service purposes.

Note
Page navigation in the web control
Whether you can navigate back and forth between the pages that you have viewed in the web 
control depends on the browser and browser versions in which Runtime is running. If the 
browser or browser versions do not support page navigation, the buttons in the web control are 
disabled.
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Displayed content
Remember the following notes when using the control:
• The "Browser" control only shows contents that are supported by the browser in which 

Runtime is open.
• The control is implemented as IFrame. Pages with X-Frame option settings that prevent the 

display in an IFrame are not displayed in the control. 
• As compared to a standard browser, the "Browser" control has limited functionality:

– Navigation from the "Browser" control is not supported (top-level navigation).
– Calls of queries and dialogs (pop-ups and modal dialogs) are only supported if they were 

activated in the file <Path for the WinCC Unified installation directory>WinCCUnified
\WebRH\public\content\custom\CustomSettings.json:
{"CustomSettings": {"HmiWebControl" : {"AllowPopups" : 
true,"AllowModals" : true}}}
Note
Pop-ups and modal dialogs stop the update.

– Links to embedded files, for example, *.pdf or *.xls, are not supported.
– Queries and dialogs that are conducted during the access of, for example, protected 

pages are not supported. 

2.8.6 Media player

Use   
In Runtime, the media player is used to play multimedia files via an https connection. 
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Layout   
The settings for the position, style and color of the object are made during configuration. 
In particular, the following properties are changed:
• Display operator controls: specifies the operator controls in Runtime.
• Show tracker: establishes, whether a slider is available for the operation.

Supported file formats
The media player supports all formats that support the HTML5 video tag.

Restrictions

Note
Play restrictions
• The web control security settings do not allow local files to be played.
• Playing multimedia files in the Runtime control system depends on factors such as the 

installed operating system, the browser used and video and audio codecs installed on the 
machine.
Examples:
– Internet Explorer does not play any video file with an embedded .wav audio file.
– Most browsers do not support .avi files.

• The browser determines which video formats are supported. 
You can find an overview of the video formats supported by popular browsers here (https://
www.w3schools.com/html/html5_video.asp).
You can find a detailed overview of the browser version used or between browsers here 
(https://html5test.com/compare/browser/index.html). 

• iOS guidelines for the <video autoplay> element are available here (https://webkit.org/blog/
6784/new-video-policies-for-ios/).

Note
Requirements for video files
To play video files in the Windows Server 2008 R2 SP1 and 2012 R2, install the Microsoft feature 
"Desktop Experience". You will find more detailed information on this topic on the Internet in the 
Microsoft documentation.

Note
Data loss when copying the project
If you copy the project to another PC, keep the following in mind: 
Files indicated in the WinCC Media Control are not copied along with the other files if they are 
dynamically linked and no UNC path is specified. You have to load the files into the project again.
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2.8.7 System diagnostics view
The "System diagnostics control" object shows the diagnostic status of several PLCs via traffic 
light SVGs. The diagnostic status contains the overall status of all relevant PLCs. Navigation 
buttons can be used to navigate to the next PLC. The merged state is always the worst state of 
all PLCs. 

Layout
In Runtime, the diagnostic messages of the selected PLC are displayed in the "System diagnostics 
control". The selected PLC can be changed using the buttons ④. Once Runtime has started, the 
events of the PLC with the most serious error are displayed.

3 74 5 6

2

1

① Grid view
② Detail view
③ Update the view of the diagnostics event
④ Switch to the next or previous PLC
⑤ Navigation buttons for the grid view:

jump to the first line 
jump to the previous line 
jump to the next line 
jump to the last line

⑥ Enable/disable detail view
⑦ Status text field
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The diagnostic buffer displays the diagnostics events of a PLC in a grid view ①. The grid view 
shows the last 200 diagnostics events of the PLC.
The first column shows the number of the entry.
The symbols in the second column indicate the event type of the PLC: 

Device in operation

Maintenance required

Maintenance necessary

Error in the device

You can see the symbols of the incoming or outgoing status in the third column:

Incoming event

Outgoing event

Incoming event for which there is no independent outgoing event

User-defined diagnostics event

The fourth column shows the date and time of the event. You can see the event message in the 
last column.
Below the grid view, the detail view ② of the selected row from the grid view is displayed. You 
can enable or disable the detail view with the button ⑥.
When the screen is loaded, the "System diagnostics control" shows the PLC with the most severe 
error. If several PLCs are configured for system diagnostics, you can use the toolbar buttons ④ to 
switch to the next or previous PLC.
To update the "System diagnostics control", select the toolbar button ③. For performance 
reasons, no automatic update is performed.
At the bottom of the window, a status field ⑦ is displayed with the diagnostic status and the 
name of the station/PLC.

Languages in runtime
The alarms are displayed in the RT language selected by the user in the screen logon dialog. The 
Runtime language and the PLC language should be identical.
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The PLC supports only three languages, which can be configured by the user in the engineering. 
If the PLC language and the Runtime language are different, the event text is displayed as follows 
according to the fallback mechanism:
• English US
• English UK
• the standard text "## text is missing ##"

2.8.8 Plant overview

Introduction

Note
With version V17, the "Plant overview" control is supported only for Unified PC. If you use the 
control under Unified Comfort Panel, an error message of the compiler is returned. If the control 
is configured for the Unified Comfort Panels, it must be deleted before the compile.

The "Plant overview" object shows you the configured plant hierarchy in Runtime. In the plant 
overview, you can navigate through the system to the plant objects and see the plant at a glance.
With the corresponding configuration of the lower-level plant objects and the assigned HMI 
device during the engineering, the plant overview also offers you the following options:
• Obtaining an overview of the plant objects for which alarms are available
• Displaying the alarms of a plant object
• Display of configured screens of a plant object.
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Overview of the Plant overview

1 Toolbar
2 Menu bar
3 Filter bar
4 Plant tree
5 Alarm icon

Alarms are available for the plant object or one of its lower-level plant objects. 

The following buttons are available in the toolbar and in the filter bar:

Icon Name Function
Expand all Expands all lower-level plant objects of the plant object selected in 

the control.
Collapse all Recursively collapses all lower-level plant objects of the selected 

plant object.
Expand or collapse the filter 
bar

Opens or closes the filter bar.

 Filters the plant overview:
• No filter: You see all plant objects
• For plant objects for which alarms are available
• According to plant objects for which screen windows are con‐

figured
Search field Filters according to the entered text.
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When configuring in the engineering system, you can hide the toolbar and menu bar.

Requirement
• The plant view has been created and assigned to an HMI device.
• The "Plant overview" object is configured in the screen of the assigned HMI device.
• Optional:

– The "Dynamic" navigation type is configured in the engineering system for the plant 
overview.

– A root node is configured in the engineering system for the plant overview.
• Runtime is active.

Operation
Expand and collapse plant tree
• To show all lower-level plant objects of a plant object, click the "Expand all" button.

To collapse the plant tree, click "Collapse all".
• To expand only the lower-level objects of the next level, click the button with the triangle next 

to the plant object.
To collapse the level again, click again on the button with the triangle.
Alternatively, you can double-click the plant object to expand or collapse lower-level objects.
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Select plant objects
• To select a plant object, click on the plant object in the plant tree.

The path to the selected plant object appears in the menu bar of the "Plant overview" object:

• To see which lower-level objects a plant object displayed in the menu bar has at the next level, 
click the arrow in the menu bar next to the plant object.

• To go from the menu bar to the overview, click on one of the plant objects shown in the menu 
bar.

Dynamic navigation
If dynamic navigation is activated in the engineering system, specify the level from which the 
plant tree is displayed. 
The buttons of the toolbar and the filter bar relate to the displayed area.
• To select a plant object, click on the object in the menu bar or double-click on the object in 

the plant tree.
The levels below the selected plant object are available.

• To navigate up one level, click on the up arrow next to the plant object.

Root node 
You have the option of defining a root node in the engineering system. 
If a root node is configured, the root node and all objects below the root node are available in the 
plant overview.
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See also
Display alarms for plant objects (Page 70)

2.8.9 Plant overview with companion controls

Requirement
• The plant view has been created and assigned to a device.
• The "Plant overview" object is configured in the screen of the assigned device.
• The objects "Alarm control" and "Screen window" are configured in the screen of the assigned 

device and configured as companion controls of the plant overview.
• Screens are configured at the plant objects.
• Runtime is active.

Display alarms
To display the alarms of a plant object, click on the alarm icon. 
The alarm control shows the alarms of the plant object.

Note
The alarm icon only appears when an alarm has occurred at the respective plant object or one 
of its lower-level objects. The alarm icon disappears again when the alarm is no longer present.

Show a screen of a plant object
To show the screen of a plant object, click on the plant object.
The screen window shows the screen of the assigned HMI device.
If you have not configured any screen window, a screen of the plant object with text box 
"$POName$" appears.

Note
"$POName$" is an expression with which the name of the plant object is resolved.
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2.8.10 Parameter set control

2.8.10.1 Overview of parameter set control

Introduction

Note
With version V16, the "Parameter set control" is supported only for Unified PC. If you use the 
control under Unified Comfort Panel, an error message of the compiler is returned. Existing 
projects under Unified Comfort Panel in which the control is configured must delete the control 
before compilation to version V16.

Set up the machine for production in Runtime using parameter sets. The elements in a 
parameter set are defined in engineering by defining its parameter set type.
In Runtime, the parameter sets are displayed in the parameter set control. In the control, you 
manage the parameter sets and load a parameter set into the PLC to set up a machine for 
production.

Example
A bakery generates the following parameter set types in the engineering system:
• Bread
• Bread rolls
• Cake 
The elements of the parameter set types define the ingredients of these products. For example, 
the parameter set type "Bread" has the following elements:
• Flour
• Salt
• Syrup
• Yeast 
• Water
In Runtime, the bakery creates parameter sets for the "bread" parameter set type for the bread 
types to be produced:
• White bread
• Wholewheat bread
• French bread
The quantities required for this type of bread are entered in the elements.
During production, an operator selects the parameter set to be produced next and writes it to the 
PLC.
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User interface

Note
Fixed parameter set type
The parameter set control in the engineering system can be configured so that you are only 
offered the parameter sets of a certain parameter set type and cannot select any other parameter 
set types.
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Parameter set control buttons
The toolbar contains buttons for executing specific functions. Depending on the configuration, 
the following buttons are available for operator input:

 Button Function
Create Creates a new parameter set.

Save Saves a parameter set.

Save as Opens the selection dialog for the storage path of the 
selected parameter set.

Rename Renames the selected parameter set.
The new name must be unique.

Write to PLC Save the parameter set and writes it to the PLC.

Read from PLC Reads a Parameter set type or parameter set from the PLC.

Import Imports parameter sets to a CSV file.

Export Exports parameter sets to a CSV file.

Cancel Cancels the process.

Delete Deletes the selected parameter set.
The table shows the default values at the parameter set 
type.

2.8.10.2 Operate parameter set control

Create parameter sets

Requirements
• Parameter set types were configured in the engineering system.
• The parameter set control is configured in the screen of the device that is active in Runtime. 
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Create a new parameter set
To create a new parameter set, follow these steps:
1. Select a parameter set type in the parameter set control in "Parameter set type".

The parameter table loads the columns and default values predefined at the parameter set 
type.

2. Click the "Create" button.
Note
Cancel creation
Another parameter set parameters set type cannot be selected until you have saved the new 
parameter set or clicked on "Cancel".

3. Optional: Enter the name of the new parameter set in "Parameter set name".
The name must be unique for the parameter set type.

4. Optional: Enter the ID of the parameters set in "Number".
The number must be unique for the parameter set type.

5. The find the values of the parameters set by clicking in a table cell and modifying the value 
predefined by the parameter set type. 

6. Confirm.
The parameter set is created and saved.

Create a version of the existing parameter set
To create a new parameter set based on an existing parameter set, follow these steps:
1. Select a parameter set type in the parameter set control in "Parameter set type".
2. Select a parameter set in "Parameter set".

The parameter set table loads the columns and values defined for the parameter set.
3. Click the "Save as" button.

The "Save parameter set as" dialog opens.
4. Optional: 

– Overwrite the automatically generated name in "Parameter set name".
The name must be unique.

– Overwrite the ID in "Number".
5. Confirm.

The new parameter set is created. 
6. To change the values taken over from the original parameter set, click in a table cell and enter 

a new value.
7. Click the "Save" button.
The parameter set is created and saved.
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Edit parameter sets

Requirements
• Parameter set types were configured in the engineering system.
• The parameter set control is configured in the screen of the device that is active in Runtime. 
• A parameter set was created in Runtime.

Procedure
1. In the parameter set control, select a parameter set type under "Parameter set type".
2. Select a parameter set in "Parameter set".

The parameter set table loads the columns and values defined for the parameter set.
3. The new parameter set is created. 
4. Click in a table cell and enter a new value.
5. Click the "Save" button.

Exchanging data with the PLC

Requirements
• Parameter set types are configured in the engineering system.
• The parameter set control is configured in the screen of the device that is active in Runtime. 
• Write to the PLC: Parameter sets are available in Runtime.

Write parameter sets to the PLC
1. Select a parameter set and a parameter set type in the parameter set control.
2. Click "Write to PLC".

Result
• Unsaved data of the parameter set is saved. 
• The parameter set is written to the PLC of the parameter set type.
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Reading parameter sets or parameter set types from PLC
Reading a parameter set
1. To read a parameter set from a PLC, select the parameters set type of the parameter set and 

the parameter set.
2. Click "Read from PLC".
3. Select one of the following options:

– Overwrite parameter set
– Create new parameter set

Define the name and the number.

Reading a parameter set type
1. To read a parameter set type from a PLC, select the parameter set type.
2. Click "Read from PLC".
3. A parameter set is created for the parameter set type during import. Define the name and the 

number of the parameter set.

Result
• The parameter set or the parameter set type and a parameter set are read in.
• The parameter table is updated.
• The parameter set that is created for the imported parameter set type has the default values 

defined in the type. 

Note
A parameter set cannot be read from the PLC if minimum and/or maximum values are defined 
for a parameter set type element and the value in the parameter set to be transferred is outside 
this range. A message is output.

Importing and exporting parameter sets

Requirements
• Parameter set types are configured in the engineering system.
• The "Parameter set control" control is configured in the screen of the device that is active in 

Runtime. 
• For the export: Parameter sets are available in Runtime.

Import
1. Click "Import" in the parameter set control.
2. In the dialog "Import - Parameter set", select a TSV file with parameter sets. 
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3. To overwrite parameter sets in the parameter set control that have the same IDs as the 
imported parameter sets, activate the "Overwrite" option.
Note
If you deactivate overwriting and if a parameter set with the same ID or the same parameter 
set name exists in the parameter set control, the import of parameter sets is not possible.
Any added parameter sets whose IDs and parameter set names deviate from the existing 
parameter sets are imported regardless of the "Overwrite" option.

4. Select "Check checksum" when importing a parameter data record that was exported with 
the "Generate checksum" option.

5. Click "OK".

Result
• The parameter sets from the file is stored in the database.
• In selecting your parameter set type, you will be prompted to select under "Parameter set".
• If the currently loaded parameter set was part of the import, it will be updated accordingly 

in the parameter set control.

Export
1. Select a parameter set type in the parameter set control. 
2. Click the "Export" button.
3. In the dialog "Export - Parameter set", select a storage location for the file with parameter sets.
4. Set the formatting settings:

– Select the file format.
– Select the list separator.
– Select the decimal character.
– Select "Generate checksum" to export the parameter data record with a checksum.

Parameter data records with a checksum cannot be imported if they have been 
manipulated in the meantime.

5. Click "OK".

Result
All parameters of the parameter set type are exported.
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Updating the UDTs
Parameter set types are linked to UDTs. If the UDT of a parameter set type is replaced or edited 
in the engineering system, the derived parameter sets are updated accordingly in Runtime after 
the next compilation and loading:
• Replacement of the UDT

The parameter sets created in Runtime are retained. You adopt the elements and default 
values of the new UDT.

• Assignment of another UDT version 
The parameter sets created in Runtime are retained. New elements are assigned default 
values, deleted elements are removed.

2.8.11 Reports

2.8.11.1 Basics

Reporting in Runtime

Note
Restriction for Unified Comfort Panel
Audit and contexts are not supported in V17 for Unified Comfort Panel. These options are not 
available in a report template with a Unified Comfort Panel as data source. If you generate a 
report on a Unified Comfort Panel whose report template uses these options, error entries are 
generated in the "ErrorLog" worksheet of the report. 

Introduction
With WinCC Unified Reporting, you can generate tabular production logs (reports) in Runtime for 
the following project data:
• Logging tags and tags
• Log alarms
• Contexts:

– User-defined contexts:
These contexts are created and executed by a program created with the ODK API.

– System-generated contexts
When the Performance Insight and Calendar option packages are installed, these 
contexts are executed by the system during Runtime.

• Audit trail of the Runtime device
• If Plant Intelligence options are installed, you can use the WinCC Unified Local Reporting 

option to generate production logs for additional project data.
You can find more information in the Help for the respective Plant Intelligence option.
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The production reports can be generated as XLSX file or PDF file and sent automatically as an e-
mail to a specified group of recipients. For example, you can generate an XLSX report that 
outputs all alarms occurring in a production line. You then distribute or archive the report for 
analysis purposes.    

Functional scope
In the "Reports" control in Runtime, you configure report jobs that use the report templates 
defined in the Excel add-in. To do so, Reporting offers the following functions in Runtime:
• Maintenance of the global e-mail settings (contact data and SMTP server configuration)
• Maintenance of job parameters, especially import and export of report templates
• Creating new report jobs and managing existing report jobs
• Overview of the generated reports 
• Download or deletion of the reports

Basics of Reporting

Report templates
A report template is an Excel file (.xslx) that was created with the WinCC Unified Excel add-in. The 
report template has access to the data of the data source with which the add-in is connected. 
For each report template, you define which segments are contained in the reports using the 
template and which data source items are evaluated by the segments. 
After you have imported report templates into the "Reports" control in Runtime, you can select 
them for configuring report jobs.
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Data sources
The data source is the source from which you select data source items when you configure the 
report template. 
The following connection modes and data sources are available:
• Connection mode: Online

The data source is the project that is running on the Runtime server to which the add-in is 
connected.

• Connection mode: Offline
Data source is a configuration file. You generate the configuration file by exporting the data 
source items of the project to a file in the "Reports" control in Runtime. You can use this file 
to create additional report templates without connecting to a runtime server.

Options and data source items
Options control the types of data source items to which the report template has access. 
Data source items are the specific objects whose data is read from the Runtime project during 
report generation.
The following options and types of data source items are available in Reporting, depending on 
the installed software:

Software Option Types of data source items
WinCC Unified ba‐
sic installation

Alarm Log alarms
Alarm statistics for log alarms

WinCC Unified ba‐
sic installation

Logging tag Logging tags

WinCC Unified ba‐
sic installation

Tag Tags

WinCC Unified ba‐
sic installation

User-defined col‐
umn

User-defined texts or Excel formulas

WinCC Unified ba‐
sic installation

Context User-defined contexts
Not available for Unified Comfort Panel

WinCC Unified ba‐
sic installation

Audit Audit
Not available for Unified Comfort Panel

Performance In‐
sight option pack‐
age

Performance In‐
sight

Local KPIs and operands of the PI option Performance Insight:
• KPIs
• Logged KPIs
• Operands (counters and numerical operands)
• Machine states
• System-generated contexts

Line Coordination 
option package

Line Coordination Jobs

Calendar option 
package

Context System-generated contexts
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Report jobs and job parameters
A report job is a job for generating reports in Runtime. A new report is generated each time the 
report job is performed.
The job parameters of the report order determine the details of its execution, such as which 
trigger it has, which report template it uses and the format of the report. 
Report jobs are executed automatically when their trigger event occurs or manually by the user.

Reports
A report (production report) is an XLSX file or PDF file that is generated when a report job is 
executed in Runtime. The data source items from the Runtime project defined in the report 
template are read during generation, and their data are imported into a table in the report.

Using general Excel functions
In addition to the specific add-in functions, you also have access to the standard Excel functions 
in a report template. These include:
• Layout functions 
• Functions for graphical preparation or analysis of the data imported from Runtime, such as 

charts, pivot tables and formulas
See also Tips on design and layout (Page 211).

General requirements and restrictions

Installing the Excel add-in
The installation of the Reporting add-in on a computer requires that the operating system and 
the local MS Excel installation are regularly updated.
If there are problems with the installation, check the version of the local MS Excel installation. 
Lengthy maintenance intervals between the operating system and Excel can cause problems 
during installation of the add-in.
Update the operating system and the Excel version if necessary.
To install the add-in with a local Excel installation, MS Excel with build 16.0.6769 or higher is 
required.

Note
Note the Microsoft upgrade restrictions
If you have an Excel installation that cannot be upgraded to Build 16.0.6769 or higher (for 
example, because Excel was installed using a single Office license), purchase a current Office 
version or use Online Office.
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Unified Comfort Panel
Audit and contexts are not supported in V17 for Unified Comfort Panel. These options are not 
available in a report template with a Unified Comfort Panel as data source. When you generate 
a report on a Unified Comfort Panel whose report template uses these options, error entries are 
generated in the "ErrorLog" worksheet of the report. 

See also
Version compatibility (Page 137)

Version compatibility

Introduction
When loading a Runtime project for which the "Reports" control has been configured, the 
general rules for version compatibility of WinCC Unified apply. 
The rules described here also apply for the interaction between add-in, data source, report 
template and runtime version of the project in which reports are generated.

Compatibility between add-in and data source 
The add-in can use the following data sources:

Add-in Online data source Offline data source
V16 Runtime project V16 Configuration file generated with a Runtime 

project V16
V17 Runtime project V16 or V17 Configuration file generated with a Runtime 

project V16 or V17

Compatibility between add-in and report template
The following report templates can be opened and edited in the add-in:

Add-in Report template
V16 Created with a V16 add-in
V17 • Created with a V17 add-in

• Created with a V16 add-in
If the add-in is connected to a V17 data source when you open the report template, you 
will be prompted to migrate the report template to V17. 
If the add-in is connected to a V16 data source when the report template is opened, no 
migration is necessary. 
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Note
Migration of report templates 
The migration of the report template is not reversible. A report template migrated from V16 to 
V17 can no longer be opened in a V16 add-in. 
If migration is not desired, connect the add-in to a V16 data source before opening the report 
template.

Note
Scope of functions of report templates
The functions available in the configuration of the report template in the add-in depend on the 
version of the data source used by the add-in.

Compatibility between report template and runtime project 
In a runtime project, reports can be generated using the following report templates:

Report template Version of the runtime project
V16 V16 and V17
V17 V17

2.8.11.2 Workflow for working with reports in Runtime

Introduction
The following workflow describes which works are required in the "Reports" control so that 
reports (production records) are generated in Runtime.
The reports can be stored as file in the file system and sent as an attachment to an e-mail. 
Alternatively, an e-mail without attachment can also be sent about the generation of the report. 
In this way, employees from management and production can be informed about the 
production situation promptly, regardless of their location.
You can send the e-mail using a secure SMTP server (authentication with user name and 
password or via certificate) or an unsecured SMTP server, for example, an internal company mail 
server.

Requirement
• In engineering, the necessary project data were configured for the HMI device for which 

reports are to be created.
• The "Reports" control was placed on an HMI screen.
• The HMI device has been compiled, uploaded to the Runtime server and its project is being 

executed.
• When using contexts: Contexts have been defined and executed in Runtime for the project.
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• The Runtime server has access to report templates.
• For cross-project and cross-Runtime use of report templates: The data sources used in the 

report template can also be found on the HMI device. Make sure that the names and plant 
hierarchy are consistent.

Procedure
1. To send reports by e-mail, configure the global e-mail settings:

– When one of the servers requires a certificate for sending e-mails, upload the certificate.
– Create contacts for the e-mail receivers and e-mail senders.
– Create the required SMTP server configurations.

2. Configure job parameters for report templates, triggers and targets.
These job parameters will then be available to you for selection when configuring the report 
jobs.

3. Configure report jobs.
Reports are generated in Runtime when the report jobs are executed.

4. (Optional) Perform report orders manually.
5. In the control, get an overview of which reports have been generated.
6. Download the reports, if necessary.
7. (Optional) To reuse the configuration of the "Reports" control, such as on a device in another 

network, transfer the existing configuration from the control from one device to the control 
of the other device.

Configuring job parameters
First, you configure which job parameters are available for selection during the configuration of 
the report jobs. You configure the following job parameters:
• The available report templates 

The report template defines which data the report outputs. Import and/or delete templates, 
if required.

• The available triggers
The trigger defines when a report job is executed. Add triggers, edit triggers or delete them.

• The available targets
Targets define whether reports are made available to users in the file system or via e-mails. 
Add targets, edit triggers, or delete them.

You set further job parameters while configuring a report job in the "Report jobs" tab.

Configuring a report job
You configure the following for each report job:
• Name of the report job
• Used report template
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• Name of the reports generated by this template
Note
Texts through dynamic placeholders 
Placeholders are available to you when defining the report name. The placeholders are 
evaluated and replaced by text during execution of the report.
See also Dynamic placeholder (Page 159).

• Targets of the generated report
To send e-mails, select a target of the type "E-mail". 

• Per target: The target format of the generated report
Possible formats: .XLSX and .PDF

• Trigger
• Comment
• Activate

See also
Setting global email settings (Page 143)
Configuring job parameters (Page 145)
Configuring report jobs (Page 152)
Running a report job manually (Page 155)
Downloading reports (Page 156)
Transferring the control configuration (Page 157)
Configuring report templates in the add-in (Page 161)

2.8.11.3 The user interface of the "Reports" control

Note
Automatic data transfer 
Changes in the "Reports" control are saved automatically. 

Layout
You create and manage report jobs in the "Reports" control. You also have access to the reports 
generated by the report jobs.
The control has the following structure:
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1 Tab for the configuration and management of reports, report jobs, job parameters and global settings
2 Toolbar

The buttons you see depend on the tab.
3 Work area 

On the "Reports", "Report jobs" and "Job parameters" tabs: List of elements available on the tab
On the "Global settings" tab: The settings

4 Options for selecting the elements
You can select elements individually or all at once.

5 Detail area
Shows the properties of the selected element.

6 Status bar
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Tab
"Reports" tab
Here you can see which reports have been generated. You can use the toolbar to download or 
delete reports.
The "Status" column shows Information:
• On the status of the generated report files (XLSX and PDF)
• On the status of the targets (File system and E-mail)
Overview of the status icons:

Status Description
Execution has been successfully completed.

An error occurred during execution.

Execution is in progress.

A click on an icon opens a detailed status message.

"Report jobs" tab
Here you create new report jobs, manage existing report jobs or start a report job manually.

"Job parameters" tab
Here you manage the parameters with which you configure the report jobs in the "Report jobs" 
tab.

"Global settings" tab
Here you make the following settings:
• For sending e-mails 
• For transfer of the control configuration 
• For creating an offline configuration file
• For configuring paging

Toolbar
The following buttons are available in the toolbars of the tabs:

Icon Button  
Delete Deletes the elements whose option is enabled in the work area.

• Add new
• Import

• Creates a new element.
• "Job parameters > Templates" tab: To import a report template into Run‐

time
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Icon Button  
Run In the "Report jobs" tab.

Manually creates a report for the report job whose option is enabled in the 
work area.

Export • In the "Job parameters > Templates" tab:
To export report templates

• In the "Reports" tab: 
To download reports to the client 

Status bar
The button in the status bar displays general information sent by the reporting service, for 
example on whether a report job has been executed.

2.8.11.4 Setting global email settings
If configured accordingly, an e-mail is sent automatically after a report job is executed. The e-
mail can include the report as an attachment.
Maintenance of the basic settings for sending e-mails is carried out in the "Global settings" tab:
• If necessary: The certificates that the e-mail sender uses to authenticate itself at the SMTP 

servers.
• The contact information of the e-mail senders and e-mail receivers.
• The configuration of the SMTP server via which the e-mails are sent.

Upload certificates
Store the certificates of the SMTP servers that require authentication via certificate.

Requirement
• You have access to the storage location of a valid certificate file.

Procedure
1. In the "Reports" control, click on the "Global settings > Certificates" tab.
2. Click "Add new" in the toolbar.

Alternative: In the work area, click "Add new".
3. In the dialog that opens, select the certificate file.
4. Confirm your input.
5. Optional: Select the uploaded certificate in the work area and enter a comment on the 

certificate in the detail area.

Runtime Operating Manual
2.8 Controls

WinCC Unified Runtime
System Manual, 05/2021 143



Result
The certificates uploaded here are available in the "Contacts" tab.

Maintaining contacts
Store the data of the e-mail senders and email recipients. 

Procedure
To create a new contact, follow these steps:
1. In the "Reports" control, click on the "Global settings > Contacts" tab.
2. Click "Add new".
3. Enter the name of the contact.
4. Enter the e-mail address of the contact.
5. To use the contact as a sender for an SMTP server that requires authentication with a 

certificate, select the appropriate certificate under "Certificate".
6. To use the contact as a sender for an SMTP server that requires authentication with a user 

name and password, enter the password.
The e-mail address is used as the user name.

7. (Optional) Enter a comment relating to the contact.

Result
The contacts configured here are available:
• As the e-mail sender in the SMTP server configuration.
• As an e-mail recipient when configuring "target" job parameters with the target type e-mail 

Maintenance of the SMTP server configuration
Store the data of the SMTP servers via which the e-mails are sent. 

Requirement
Contacts that are suitable as senders have been entered in the "Global Settings > Contacts" tab.
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Procedure
To create a new SMTP server configuration, follow these steps:
1. In the "Reports" control, click on the "Global settings > SMTP" tab.
2. Click "Add new". 
3. Specify the following:

Field Description
"Name" Enter the name of the SMTP server configuration.
"Address" Enter the URL of the SMTP server.

Servers without authentication (e.g. company-
internal mail servers) and with authentication are 
permitted.
Example: URL of a company mail 
server: mail.<Company name>.com

"Port" Enter the port number of the SMTP server.
Default setting: 25

"Sender" In the list, select the contact that is used as the 
sender for this SMTP server configuration. 
All contacts maintained under "Contacts" are of‐
fered to you for selection. Select a sender that 
meets the respective requirements of the server.

"Comment" (Optional) Enter a comment relating to the SMTP 
server configuration.

Result
The servers configured here are available when configuring the "Target" job parameters with the 
target type email.

2.8.11.5 Configuring job parameters
Job parameters define the details of a report job. 
You configure the following parameters on the "Job parameters" tab:
• Templates
• Trigger

Define trigger when a report job is executed.
• Targets

Targets define how a report is made available to users. The following target types are 
available:
– "E-mail" 

An e-mail is sent after a report job is executed. The report generated by the report job can 
be included with the e-mail as an attachment.

– "File system"
The reports generated by the report job are stored in the file system.
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The parameters configured here are available to you for selection when configuring the report 
jobs in the "Report jobs" tab.
You define the remaining job parameters while configuring a report job in the "Report jobs" tab. 

See also
Importing and exporting report templates (Page 146)
Deleting templates (Page 147)
Configure trigger (Page 147)
Add target with target type "E-mail" (Page 150)

Importing and exporting report templates

Requirement
• The "Reports" control is placed on a screen of the project.
• The "Job parameters > Templates" tab is visible in the control.
• Import: You have access to the storage location of the report template.
• Export: Report templates have been imported into the control. 

Importing report template
1. Click "Add new" in the toolbar.

Alternative: In the work area, click "Add new".
2. In the dialog that opens, select the file of a report template.
3. Confirm your input.

Note
No validation
The template is not validated during import.

4. Optional: In the work area, select the imported report template in the work area and enter a 
comment describing the template in the detail area.

Exporting report templates
1. In the work area, select the options next to the report templates you want to export.
2. Click "Export" in the toolbar.
The report templates are downloaded to the download folder or a user-defined directory 
according to the device settings. 
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Deleting templates

Requirement
• The "Reports" control is placed on a screen of the project.
• The "Job parameters > Templates" tab is visible in the control.
• Templates have been imported into the control. 

Procedure
1. In the work area, select the options next to the templates you want to delete.
2. Click "Delete" in the toolbar.

Deleting used templates
The "In use" column shows whether the template is used by a report job.
If you delete a template that is used by a report job, the report job is marked as inconsistent and 
no longer executed.

Configure trigger

Introduction 
In the "Job Parameters > Triggers" tab you configure which automatic triggers are available for 
selection when configuring report jobs. 
Report jobs with automatic triggers are executed if the report jobs on the "Report jobs" tab are 
set to active and their trigger event occurs. Users can also start the execution manually.

Requirement
• The "Reports" control is placed on a screen of the project.
• The "Job parameters > Trigger" tab is visible in the control.
• To use the trigger type "Context trigger": Contexts are available in the project.

Add trigger
1. In the work area of the tab, click "Add new".

A new trigger is created and displayed in the detail area.
2. Assign a unique name to the trigger.
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3. Select the trigger mode: 

Trigger type Triggering the trigger
"Tag trigger" Automatically when the configured value condition occurs at the tag 

defined in the trigger.
"Serial trigger" Automatically within the user-defined interval when the time defined by 

the series has been reached.
"Context trigger" Automatically when the selected context is started or stopped.

Optional: By using a condition, you can also limit the triggering of the 
trigger to specific context values.

4. Depending on the selected trigger type, set the settings for the new trigger as described 
below.

5. Optional: Enter a comment for the trigger.

Settings for tag trigger
1. Click "Select tag".
2. Click "Load".
3. Select the required tag and click "OK".
4. Set the condition and the condition value.

Example: 

Set tag <tag name>
Condition >
Condition value 100

The trigger will be initiated when the tag receives a value greater than 100.

Settings for serial triggers
1. Select the serial pattern.

The series pattern defines the occurrence and time at which the trigger is initiated.
Example: Weekly > Every 2 weeks > Fridays

2. Select the series area.
The series range defines the period in which the trigger is initiated.

"Start" Specify the start date
"Time" Specify the time at which the trigger is initiated.
"End on" Specify the end date. The trigger will be executed for the last time on this 

day.
"End after" Determine the number of dates after which the series ends.
"No end date" The series runs indefinitely.
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Settings for context triggers
1. Click "Select context".
2. In the "Context selection" dialog, click "Select plant object".
3. In the "Browser view" dialog, select a plant object and confirm your input.

In the "Context selection" dialog you can see all contexts that have been defined for the 
selected plant object.

4. Select a context and confirm your input.
5. Under "Context status", select when the trigger will be triggered:

"Started" When starting the context.
"Stopped" When stopping the context.

6. Optional: To bind the execution of the report order to certain context values, you define a 
condition:

"Condition" Select an operator.
"Value" Select a context value.

Example:

Plant object "MyPlant.hierarchy::PlantView/Bottling"
Context "Product"
Context state "Started"
Condition =
Value "Orange lemonade"

Report jobs with this trigger are always executed when the context "Product" defined on the 
plant object "Bottling" is started with the value "Orange lemonade".

Delete trigger
Select the option of the desired trigger in the work area of the "Job Parameters > Trigger" tab and 
click "Delete" in the toolbar.

Edit trigger
1. Activate the option of the desired trigger in the work area of the tab.
2. In the detail area, edit the settings of the trigger. 

Note
No change of the trigger type
The trigger type can only be set when adding the trigger.
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Add target with target type "E-mail"

Requirement
• The "Reports" control is placed on a screen of the project.
• The receivers of the e-mails are maintained as contacts in the "Global settings > Contacts" tab.
• An SMTP server, with which the e-mail is to be sent, has been configured in the "Global 

settings > SMTP" tab.

Procedure
1. In the "Reports" control, click on the "Job parameters > Targets" tab.
2. In the work area of the tab, click "Add new". 
3. Select "E-mail" as target type.

A new target is created and displayed in the detail area. 
4. Assign a unique name to the target.
5. Select an SMTP server configuration.
6. Add the desired receivers and CC receivers:

– To do so, select a contact from the list "Add receiver" or "Add CC receiver".
– Add the contact by clicking "+".

7. Enter the e-mail subject.
To integrate the report name into the subject line, use the placeholder {ReportName}. 

8. Enter the e-mail text.
To integrate the report name into the email text, use the placeholder {ReportName}.

9. (Optional) Enter a comment.

Result
The target configured here is available for selection when configuring report jobs.
An e-mail is sent after a report job is executed with this target. The e-mail can include the report 
as attachment. 

See also
Dynamic placeholder (Page 159)

Add a target with "File system" target type

Introduction
A reporting job with a target of the target type "File system" saves the reports to a file system.
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You can select the following, pre-configured targets with the target type "File system" when 
configuring a report job, but not edit or delete them in the control.
• Local project storage location: The "Reports" folder in the project directory.
• Local main storage location for reports: 

Unified PC The local main storage location for reports con‐
figured during Runtime installation or in the 
"WinCC Unified Configuration" tool.

Unified Comfort Panel The "Reports" folder on the SD card inserted in the 
Panel:
 media/simatic/X51/Reports 

In addition, you can add additional targets that save the reports to subfolders of the local main 
storage location for reports.

Requirement
• The "Reports" control is placed on a screen of the project.
• Unified Comfort Panel: An SD card is inserted in the panel.

Procedure
1. In the "Reports" control, click on the "Job parameters > Targets" tab.
2. In the work area of the tab, click "Add new". 
3. Select "File system" as target type.

A new target is created and displayed in the detail area. 
Under "Destination path", you can see the path to the local main storage location for reports.

4. Assign a unique name to the target.
5. Under "Subfolder", enter the path to the subfolder in which the report is to be saved.

Use the following notation: <folder name> or <folder name>\<folder name>\...
Note
Relative path information
The path information is relative to the local main storage location for reports. 

6. (Optional) Enter a comment.

Result
The target is available for selection when configuring report jobs.
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When a report job with this target is executed, the report generated by the report job is saved to 
the file system. If the folder entered under "Target path" does not exist, it is created by the system.

Note
Change of the local main storage location for reports (Unified PC)
When you change the originally configured local main storage location for reports, the targets 
are automatically adapted. New reports are stored relative to the new local main storage 
location. The old folders are not deleted.

2.8.11.6 Configuring report jobs

Creating a report job

Introduction
A report job is a job for generating reports in Runtime. A new report is generated each time the 
report job is performed.
The report jobs configured in the "Report jobs" tab are executed:
• Automatic

Report jobs that have a tag trigger, serial trigger or context trigger and are set to active on the 
"Report jobs" tab are automatically executed when their trigger is triggered.

• Manual
Report jobs with a trigger of the "Manual" type must always be executed manually.
You can also run report jobs manually with triggers of the types "Tag trigger", "Serial trigger" 
or "Context trigger" at any time.

The configuration of a report job controls the details of the generation.

Requirement
• The "Reports" control is configured on a screen of the project.
• The following job parameters were configured in the control:

– At least one template has been imported.
– To automatically execute a report job: Triggers are configured in the "Job parameters > 

Trigger" tab.
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• For sending an e-mail after execution of the report job: 
– E-mail contacts were configured in the global settings.
– An SMTP server was configured in the global settings.
– A target of the target type "E-mail" was configured in the "Job parameters > Targets" tab.

• For a report job with the target format PDF: 
– Microsoft Office Excel or LibreOffice is installed on the runtime server.
– Depending on whether Excel or LibreOffice is installed, the information required for PDF 

creation was provided during the Runtime installation or in the "WinCC Unified 
Configuration" tool.

Procedure
1. Select the "Report jobs" tab in the "Reports" control.
2. Select "Add new" In the work area or click "Add new" in the toolbar.
3. In the detail area, enter a name for the report job.
4. Select a report template.
5. Enter a report name.

The name will be used for all reports generated by the report job. To get unique names, use 
placeholders. They are dynamically evaluated during the execution of the report job. 
Example: 

Entered string Generated name Description
LineA_{yyyymmdd}_{HHMMs
s}

 LineA_20181210_170641 The name consists of a descrip‐
tive part and a dynamically gen‐
erated time stamp.

LineA_{NNN} LineA_014 The name consists of a descrip‐
tive part and a dynamically gen‐
erated counter.
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6. Under "Targets", you determine how the reports are to be made available to users. Follow 
these steps:
– Click "Add target".

You see the targets configured in the tab "Job parameters > Targets".
– Select a target.
– Add the target by clicking "+".

The target is added to the table to define the target formats.

– Determine the formats in which the reports generated by the report job are provided for 
the target. In the table, activate the options of the desired formats for each target.
Note
Sending e-mails without a report
If you deactivate both options for targets with "E-mail" target type, an email without 
attachment is sent after the report job has been executed.

Note
PDF as target type for large reports
Generating PDFs with Excel is significantly slower than with LibreOffice. To generate large 
PDF reports, it is therefore recommended that you install LibreOffice. 

– To remove a target from the report job, click the "Remove" button in the table.
7. Under "Trigger", select which event triggers the execution of the report job:

– If the report job is only to be executed manually, select "Manual".
– If the report job is to be executed automatically, select one of the other triggers 

configured under "Trigger".
Note
You can also execute the report job manually.

8. (Optional) Enter a comment for the report job.
9. Specify whether the automatic execution of the report job is active or paused. To do this, set 

the slider "Enabled" or "Disabled".
Note
You can still execute disabled report jobs manually.
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Result
The report job is saved automatically. When its trigger is triggered, a report is generated.

See also
Configure trigger (Page 147)
Dynamic placeholder (Page 159)
Add target with target type "E-mail" (Page 150)
Tips on design and layout (Page 211)

Managing report jobs

Requirement
• The "Reports" control is configured on a screen of the project.
• Report jobs have been configured in the control. 

Procedure
1. Select the "Report jobs" tab in the "Reports" control.
2. To edit a report job, proceed as follows:

– Select the report job in the work area.
– In the detail area, edit the settings of the report job.

You have the same options as when creating a report job.
3. To delete report jobs, proceed as follows:

– In the work area, enable the options next to the report job.
– Click "Delete" in the toolbar.

2.8.11.7 Running a report job manually
You can execute report jobs manually at any time, regardless of their trigger type. This also 
applies to report jobs that were disabled in the "Report Jobs" tab and whose automatic execution 
is therefore paused. 

Requirement
Report jobs have been configured in the "Reports" control.
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Procedure
1. Select the "Report jobs" tab in the "Reports" control.
2. In the work area, enable the option next to the report job that you want to execute manually.
3. Click "Run" in the toolbar.

Result
The report is generated. You can download it in the "Reports" tab.

2.8.11.8 Downloading reports
You can download the reports stored by the report job in the file system to your device. 
Depending on which file formats have been set in the report job, you can download the report 
as an XLSX file and as a PDF file.

Requirement
• Report jobs with the target type "File system" have been configured and executed in the 

"Reports" control.

Procedure
1. Select the "Reports" tab in the "Reports" control.
2. In the work area, select the option in the left column for each report that you want to 

download.
3. Activate the desired target formats in the "Files" column.

Note
Generation status
You are only offered successfully generated formats.
In the "Status" column you can check whether the generation for a format has failed. For a 
detailed status message click on the icon of a target format.

4. Click "Export" in the toolbar.

Result
The reports are downloaded into the download directory of the browser.
You can edit, distribute, or log the reports.

See also
Installation of the Reporting add-in (Page 162)
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2.8.11.9 Exporting an offline configuration file
An offline configuration file is required to configure reporting templates in the Reporting Excel 
add-in without an online connection to the Runtime server. 

Requirement
• The "Reports" control is placed on a screen of the project.
• The Runtime project has data that can serve as data source elements in the reporting 

template, such as alarms and logging tags.

Procedure
1. In the "Reports" control, click on the "Global settings > Configuration" tab.
2. Enter the name of the offline configuration file under "Offline-configuration".
3. Click "Export offline configuration".

Result
A JSON file with the data source elements of the Runtime project is created. The file is 
downloaded to the download folder or a user-defined directory according to the device settings.
You can select the configuration file in the Reporting Excel add-in as data source for an offline 
connection.

2.8.11.10 Transferring the control configuration
You have the option of reusing the settings in the "Reports" control, for example, on a device in 
another network. To do this, export the existing configuration on the one device from the control 
to a ZIP file. Then import the file into a "Reports" control on the other device.

Scope
The transfer covers the following data:
• Global settings, without passwords and certificates
• Job parameters, including the report templates available in the control
• Report jobs
Reports are not transferred.
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Requirement
• The "Reports" control is placed on a screen in the project running in Runtime.
• Export: Settings have been made, e.g. contacts maintained, report templates imported, and 

report jobs created in the "Reports" control.
• Import: You have access to the ZIP file generated by the export on the device on which 

Runtime is installed.

Export configuration
1. In the "Reports" control, select the "Global settings > Configuration" tab.
2. Enter the name of the export file under "Export/import configuration > Export".
3. Click "Export configuration".
The configuration is exported to a ZIP file and downloaded to the default download directory of 
the device.

Import configuration
1. In the "Reports" control, select the "Global settings > Configuration" tab.
2. Click "Select import file" under "Export/import configuration".
3. Select the ZIP file in File Explorer and confirm your selection.
4. Runtime checks whether the control already contains configurations:

– No: The configuration is imported.
– Yes: 

Select "OK" to import the configuration. The existing configuration is overwritten. 
Select "Cancel" to cancel the import.

2.8.11.11 Configuring enable paging
To set how many entries the lists in the work area of the "Reports" control display per page, follow 
these steps: 
1. In the "Reports" control, click on the "Global settings > Configuration" tab.
2. Under "List Settings", select the number of entries.
If a list has more entries, these are split over several pages. Use the buttons below the list to 
switch pages. 

Note
The setting is lost through a screen change.
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2.8.11.12 Inconsistencies and error diagnostics

Note
Inconsistent report jobs are not executed.
The templates available in the "Reports" control are not validated.

Display of inconsistencies and errors
Errors and inconsistencies are displayed as follows: 

In the control If job parameters are affected.
Examples:
• No template is set for a report job. 
• A tag that triggers a report job is deleted in the engineering system. The project 

is reloaded into the device. 
In the "Error log" 
worksheet of the 
report

Errors or inconsistencies affecting the content of the report.
Example: The report evaluates data from a tag that is no longer available in runtime.

As system alarm For errors and inconsistencies that do not affect job parameters or the contents of the 
report.
Example: The ExecuteReport system function transfers a report job that does not 
exist.

Job parameters
The following values lead to errors and inconsistencies:

Parameter Invalid values Default setting
"Name" Zero, empty or already assigned 

name 
"New report job"

"Template" Zero, empty or "None".
Name of a template that is not 
imported

"None"

"Target name" Zero or empty "NewReportJob[NN]"

2.8.11.13 Dynamic placeholder
Placeholders are dynamically evaluated and replaced by text during the execution of the report 
job. The following job parameters can contain placeholders:
• Report name 
• Targets with the target type "E-mail": Subject and text of the e-mail 
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Placeholder for the report name
The following placeholders are available to generate unique report names:

Place‐
holder

Description Example Area
Configura‐
tion

Result

{N} Automatic numbering
 
 

Rep_{N} Rep_1 0..9
{NN} Rep_{NN} Rep_01 00..99
{NNN} Rep_{NNN} Rep_001 000..999
{yy} Current year

 
Rep_{yy} Rep_18 Valid year with 2 digits

{yyyy} Rep_{yyyy} Rep_2018 Valid year with 4 digits
{m} Current month Rep_{m} Rep_1 Valid month, no prefixed 0 for months in single-digit range
{mm} Rep_{mm} Rep_01 Valid month, prefixed 0 for months in single-digit range
{mmm} Rep_{mm} Rep_Jan Month abbreviation with 3 characters
{mmmm} Rep_{mmm

m}
Rep_Janu‐
ary

Month with full name

{d} Current day of the 
month
 

Rep_{d} Rep_1 Valid day, no prefixed 0 for days in single-digit range
{dd} Rep_{dd} Rep_01 Valid day, prefixed 0 for days in single-digit range
{ddd} Rep_{ddd} Rep_Mon Day abbreviation with 3 characters
{dddd} Rep_{dddd} Rep_Mon‐

day
Day with full name

{h} Current hour
 

Rep_{h} Rep_1 Current hour (12-hour clock), no prefixed 0 for single-digit 
values

{hh} Rep_{hh} Rep_01 Current hour (12-hour clock), prefixed by 0 for single-digit 
values

{H} Rep_{H} Rep_13 Current hour (24-hour clock), no prefixed 0 for single-digit 
values

{HH} Rep_{HH} Rep_13 Current hour (24-hour clock), prefixed by 0 for single-digit 
values

{M} Current minute
 

Rep_{M} Rep_6 Valid minute, no prefixed 0 for single-digit values
{MM} Rep_{MM} Rep_06 Valid minute, prefixed by 0 for single-digit values
{s} Current second

 
Rep_{s} Rep_41 Valid second, no prefixed 0 for single-digit values

{ss} Rep_{ss} Rep_41 Valid second, prefixed by 0 for single-digit values

Examples:

Definition with placeholder Generated report name
LineA_{yyyymmdd}_{HHMMss} LineA_20190101_170001
LineA_{yymmmd}_{hhMMss} LineA_19Jan1_050001
LineA_{NNN} LineA_014

Placeholder for e-mail subject and e-mail text
To integrate the report name into the subject line or the e-mail text, use the following 
placeholder {ReportName}.
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2.8.11.14 Configuring report templates in the add-in

Requirements

General requirements and restrictions

Installing the Excel add-in
The installation of the Reporting add-in on a computer requires that the operating system and 
the local MS Excel installation are regularly updated.
If there are problems with the installation, check the version of the local MS Excel installation. 
Lengthy maintenance intervals between the operating system and Excel can cause problems 
during installation of the add-in.
Update the operating system and the Excel version if necessary.
To install the add-in with a local Excel installation, MS Excel with build 16.0.6769 or higher is 
required.

Note
Note the Microsoft upgrade restrictions
If you have an Excel installation that cannot be upgraded to Build 16.0.6769 or higher (for 
example, because Excel was installed using a single Office license), purchase a current Office 
version or use Online Office.

Unified Comfort Panel
Audit and contexts are not supported in V17 for Unified Comfort Panel. These options are not 
available in a report template with a Unified Comfort Panel as data source. When you generate 
a report on a Unified Comfort Panel whose report template uses these options, error entries are 
generated in the "ErrorLog" worksheet of the report. 

See also
Version compatibility (Page 137)
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Installation of the Reporting add-in

Note
Regular updates of operating system and MS Excel
The installation of the Reporting add-in on a computer requires that the operating system and 
the local MS Excel installation are regularly updated.
If there are problems with the installation, check the version of the local MS Excel installation. 
Lengthy maintenance intervals between the operating system and Excel can cause problems 
during installation of the add-in.
Update the operating system and the Excel version if necessary.
To install the add-in with a local Excel installation, MS Excel with build 16.0.6769 or higher is 
required.

Note
Note the Microsoft upgrade restrictions
If you have an Excel installation that cannot be upgraded to Build 16.0.6769 or higher (for 
example, because Excel was installed using a single Office license), purchase a current Office 
version or use Online Office.

Procedure
1. Install the Excel manifest on the computer.
2. Set up read access to the installation path of the Excel manifest.
3. Add the add-in to Excel.

See also
Installing the Excel manifest (Page 163)
Setting up read access to the Excel manifest (Page 163)
Adding the Reporting add-in in Excel (Page 164)
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Installing the Excel manifest

Procedure
1. In the installation package of WinCC Unified on "DVD_2", double-click the file "Support

\Reporting\SIMATIC_WinCC_Unified_Reporting_<Version number>.exe".
2. Select the target directory to which the underlying ZIP file is extracted and confirm your input.

The ZIP file is extracted and setup starts automatically.
Note
Start setup manually
To start the setup manually after the file was extracted, select the option "Extract the setup 
files without being installed".
Start the setup later by running the "Setup.exe" file as administrator in the target directory.

3. Follow the setup instructions.
4. In the "Configuration" step, select the option for the Excel add-in.
5. Click "Next" and follow the setup instructions.

See also
Installation of the Reporting add-in (Page 162)

Setting up read access to the Excel manifest

Requirement
The Excel manifest is installed.

Procedure
Give the users that create templates with the Excel add-in read access to the installation path of 
the Excel manifest: <target directory>\WinCCUnifiedReporting\Excelmanifest 

Note
This step is also necessary if the user belongs to a group in the user management with general 
read permission.

See also
Installing the Excel manifest (Page 163)
Installation of the Reporting add-in (Page 162)
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Adding the Reporting add-in in Excel

Requirement
• The Excel manifest is installed on the PC.
• Read access to the installation path of the Excel manifest is set up.
• The following software is available on the computer:

– Local Excel
MS Excel (Build 16.0.6769 or higher)
Note
Regular updates of operating system and MS Excel
The installation of the Reporting add-in on a computer requires that the operating system 
and the local MS Excel installation are regularly updated.
If there are problems with the installation, check the version of the local MS Excel 
installation. Lengthy maintenance intervals between the operating system and Excel can 
cause problems during installation of the add-in.
Update the operating system and the Excel version if necessary.

Note
Note the Microsoft upgrade restrictions
If you have an Excel installation that cannot be upgraded to Build 16.0.6769 or higher (for 
example, because Excel was installed using a single Office license), purchase a current 
Office version or use Online Office.

– Or Office online

Procedure
1. Open Microsoft Excel.
2. Open the "Trust Center" under "File" > "Options".
3. Click "Trust Center Settings".
4. Click "Catalogs of trusted add-ins".
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5. Add the catalog using the URL "\\<Computer name>\Excelmanifest".

6. Make sure that the check mark in the "Show in Menu" column is set.
7. End and restart Excel.
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8. In the "Insert" menu, click "My Add-ins".

In the "Office Add-ins" dialog box, the Siemens add-in is displayed under "Shared folders".
9. Select the add-in and click "Add".

See also
Installing the Excel manifest (Page 163)
Setting up read access to the Excel manifest (Page 163)
Installation of the Reporting add-in (Page 162)

Configuring Internet Explorer and Edge
The Reporting Excel add-in uses the certificate that was selected during installation of WinCC 
Unified Runtime or later in "WinCC Unified Configuration".
Some browsers do not recognize self-signed certificates as trusted. If you use a self-signed 
certificate for WinCC Unified Runtime, you must add the certificate to the list of trusted 
certificates in Internet Explorer or Edge on the device on which the Excel add-in is installed.
You can find detailed information on handling certificates here (Page 23).
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Trusting self-signed certificates
The following section describes the procedure for adding a self-signed certificate to the list of 
trusted certificates, using Internet Explorer as an example:
1. Start Internet Explorer.
2. In the address line, enter the host name entered when creating the certificate.

You will receive a security warning.
3. Click "Continue to this website (not recommended)".
4. Click "View Certificates".
5. Click "Install Certificate".
6. Click "Place all certificates in the following store" and "Browse".
7. Click "Trusted Root Certification Authorities" followed by "OK".

Note
Do not use the preset options for automatic selection of the certificate store.

8. Exit the dialog.
9. If you receive a security warning as to whether you want to trust the certificate, confirm it 

with "Yes". 
10.Load the page again.

Login
A login dialog opens in the Excel add-in in the following cases:
• After start of Excel and the add-in
• When using an online connection: When the connection to the Runtime server must be re-

established.
Examples: 
– Runtime has been reloaded.
– The security token has expired due to a timeout.

Requirement
• The add-in is installed.
• When using an online connection:

– A Runtime server is accessible.
– A Runtime project is running on the server.
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Procedure
In order to use an online connection, log onto a Runtime server:
1. Under "Server", enter the name of the server on which the project that is to serve as data 

source for the report template is running.
Use the same spelling as when the Runtime server certificate was created.
Note
If Runtime is installed on the same computer as the add-in, use of the name "localhost" is not 
permitted.

2. Enter the user name and password of a user that is registered on the server in the Runtime 
user management.

3. Click "Login".
In order to use an offline connection, click "Go offline".

Result
Online connection
The add-in is connected to the Runtime server and the options available there are loaded. 
You can now create report templates. 

Offline connection
Before you create report templates, set up the offline connection.

See also
Installation of the Reporting add-in (Page 162)
Setting up an offline connection (Page 171)

Setting up a data source

Using an online connection
When an online connection is present, the add-in establishes a connection to a Runtime server. 
The project running on the server serves as data source for the add-in.
The connection settings allow you to:
• Change the connected Runtime server to another Runtime server 
• When a report template that was created with a different Runtime server than the currently 

connected server is reused: check the options available on the server and delete the options 
that were not loaded
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Setting up an online connection

Requirements
• A Runtime server is accessible.
• A Runtime project is running on the server.

Procedure
1. In the "Data sources" group on the "WinCC Unified" tab, click on "Connections".  
2. Click "Online" under "Connections" in the add-in.
3. Under "Server", enter the server name.

Use the same spelling as when the Runtime server certificate was created.
Note
If Runtime is installed on the same computer as the add-in, use of the name "localhost" is not 
permitted.

4. Click "Load".

Result
• A server node is created.
• The add-in is connected to the Runtime server and its options are loaded. 

Data source items of these options can be added to report templates. Their data can be read 
in from Runtime to Excel.
Note
To check which options were loaded, click on the server node.
Options that are being used in the currently open report template but are not available on the 
connected server have a red icon. You can remove the option:

• If no connection can be established or an incorrect server name has been entered, the add-
in will display a corresponding error message.

See also
Removing options (Page 169)

Removing options

Introduction
If you reuse report templates across servers, e.g. in order to adapt an existing template for 
another project, it may be necessary to remove unavailable options from the connection 
settings.
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The procedure for this is presented using the Performance Insight option as an example. 

Requirement
• The add-in was connected to a server on which the Performance Insight (PI) option is 

installed.
• A report template that uses KPIs was created with the add-in.
• The add-in was then connected to a server without the Performance Insight option installed 

for the purpose of adapting the template to the project running there.

Removing an option
1. In the "Data sources" group on the "WinCC Unified" tab, click on "Connections".
2. Under "Connections", click on "Online".
3. Select the server node.

You see the loaded options under the server node:

 

Available options 
The following applies to data source items of these options:
• They can be added to the report template.
• Their data can be read in from Runtime to Excel in the add-in.
Unavailable options
In the example: Performance Insight 
The following applies to data source items of these options:
• They cannot be added to the report template.
• If the report template already has a data source element of this option, its data 

cannot be read in from Runtime to Excel.

4. Select the "Performance Insight" option under the server node.
5. Click the "Delete" button next to the option.
6. Confirm your input.

Result
The option is removed from the connection settings. 
Next, remove all data source items of this option from the report template.

Reloading an option
When the add-in is connected to a Runtime server, all options available on the server are loaded. 
To reload an option that was deleted in the connection settings but is available on the server, 
select the server node and click "Load". 
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Using an offline connection
With the offline connection, the add-in uses a configuration file as data source. 
The connection settings allow you to: 
• Change the configuration file used
• When reusing a report template with a configuration based on a Runtime server different to 

that of the currently selected configuration file: Check the available options and delete the 
options that were not loaded.

Setting up an offline connection

Requirement
An offline configuration file was created in the "Reports" control in Runtime. The configuration 
file is available on the device.

Procedure
1. In the "Data sources" group on the "WinCC Unified" tab, click on "Connections". 
2. Under "Connections", click on "Offline".
3. Click "Open offline configuration".
4. Select the desired file in the window that opens and confirm your entries.  
5. Click "Load".
6. Select the desired options.
7. Confirm your entries.

Result
• A server node is created. The node bears the name of the server on which the configuration 

file is based.
• The configuration file, together with its options, is loaded into the add-in. The data of the 

configuration file is available for configuring the report template.
Note
To check which options were loaded, click on the server node.
Options that are being used in the currently open report template but are not available in the 
configuration file have a red icon. You can remove the option: 

See also
Removing options (Page 172)
Exporting an offline configuration file (Page 157)
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Removing options

Introduction
If you reuse report templates across servers, e.g. in order to adapt an existing template for 
another project, it may be necessary to remove unavailable options from the connection 
settings.
The procedure for this is presented using the Performance Insight option as an example. 

Requirement
• The add-in was changed over to an offline connection whose configuration file does not 

include Performance Insight.
• A report template was opened in the add-in whose configuration is based on a connection to 

a Runtime server on which Performance Insight is installed.

Removing an option
1. In the "Data sources" group on the "WinCC Unified" tab, click on "Connections".
2. Under "Connections", click on "Offline".
3. Select the server node.

You see the loaded options under the server node:

 

Available options 
The following applies to data source items of these options:
• They can be added to report templates.
• Their data can be read in from the configuration file to Excel.
Unavailable options
In the example: Performance Insight 
The following applies to data source items of these options:
• They cannot be added to the report template.
• If the report template already has a data source element of this option, its data 

cannot be read in from the configuration file to Excel.

4. Select the "Performance Insight" option under the server node.
5. Click the "Delete" button next to the option.
6. Confirm your input.

Result
The option is removed from the connection settings. 
Next, remove all data source items of this option from the report template.
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Reloading an option
When a configuration file is loaded, all options available in the file are loaded. 
To reload an option that was deleted in the connection settings but is available in the 
configuration file, select the server node and click "Load". 

Configuring report templates

Requirement
An online connection or offline connection has been established.

Procedure
To create a new report template, proceed as follows:
1. Open a new Excel file.
2. Add a segment.

You can choose between time series segments and single value segments.
3. Add data source items to the segment.

The exact procedure depends on the type of the data source item.
4. Optional: If you do not want a data source item to use the default configuration, determine its 

configuration.
You have the following options:
– Select an existing configuration. 
– Create a new configuration and select it.
– Define a local configuration.

5. Optional: To define additional segments, repeat steps 2 to 4.
6. Optional: When using an online connection, test the template by reading the runtime data 

of selected segments or all segments.

See also
Setting up a data source (Page 168)

User interface of the add-in

Requirement
• The "WinCC Unified" tab is visible in Excel. 
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Structure
If you click on "Segments" in the "Configuration" group, you see the following interface:

① Toolbar
② Work area

Toolbar buttons:

Button Tooltip Description
"Segment configuration" Loads the interface to add and edit segments 

in the work area.
"Data source item configuration" Loads the interface for adding and editing the 

configuration of a data source item in the 
work area. 

"Basic settings" Loads the interface for setting the language 
settings in the work area.

"Update all" Reads the Runtime data of the connected da‐
ta source into the data tables of the segments.

"Delete Runtime data" Removes all Runtime data from the report 
template.

Logoff Logs out the user currently logged in to the 
add-in.

Help Opens the user help for the add-in.

See also
The segment user interface (Page 177)
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Working with segments

Basic information on segments

Definition
A report template consists of any number of segments. Each segment is a container to which you 
can add any number of data source items. The segment reads the data from its data source items.
There are time series segments and single value segments.

Time series segments
Time series segments consist of a legend table and a data table.

Content of the legend table
The legend table contains general information about the segment and its data source items. 
When creating or editing a segment, you configure the contents of the legend table.

Content of the data table
The data table lists several values for each data source item in the segment. 
Example of logging tags: All values logged for the tags in the evaluation period, including their 
time stamp.

Data source items
The following data source items can be added to time series segments:
• Log alarms
• Logging tags 
• User-defined columns
• Contexts

Note
Data source items of the PI options
If PI options are installed, additional data source elements may be added. For more information 
on this, refer to the PI Options help.
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Single value segments
Single value segments consist of a data table that lists exactly one value for each data source 
item in the segment. 

Note
Output additional information
For the data source items of the single value segment, you can set in the configurations of the 
data source items whether the data table outputs additional information about the value.
Example of logging tags:
• Quality code and time stamp of the tag value
• Labels

Data source items
The following data source items can be added to single value segments:
• Logging tags 
• Tags

Note
Data source items of the PI options
If PI options are installed, additional data source elements may be added. For more information 
on this, refer to the PI Options help.

Runtime Operating Manual
2.8 Controls

WinCC Unified Runtime
176 System Manual, 05/2021



The segment user interface

Structure
The interface for creating and editing segments has the following structure:

① Filter
Filters the list of segments by name.

② Button for creating a segment
③ List of segments

Each segment has buttons for reading in, editing and deleting the segment.
The following configuration is displayed for each segment:
• Segment name 
• Number of data source items
• Insertion location of the segment in the Excel file
• Time span
• If context filters have been configured: The filter string
A click on the segment opens the area with the data source items.
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Create segments

Requirement
• The "WinCC Unified" tab is visible in Excel. 
• The data source is set up.
• To filter the time interval of the time series segment depending on the context: There are 

contexts in the project that run on the connected Runtime server or are the basis of the 
configuration file.

Procedure
1. Click on "Segments" in the "Configuration" group.
2. Click "New segment".
3. Select "New time series segment" or "New single value segment".
4. Enter a segment name. Note the Excel restrictions for naming tables (for example, do not use 

blanks).
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5. For a time series segment, make the following settings in addition: 
– Under "Location", determine where the segment is inserted in the file. Enter the name of 

the worksheet and the cell.
Alternatively, click  and use the cell currently highlighted in the Excel file.

– Under "Start" and "End", you determine the time period for which values are read into the 
segment. 

 Absolute time information Select a date and a time.
The information is absolute to the current 
date.

 Relative time information Select a reference time and a time interval.
The information is relative to the current 
date.

 Read time information from cell Applies the value of the cell currently high‐
lighted in the Excel file.
Make sure that the cell supplies a valid time.

 Read time information from tag Applies the value of the set tag.
Make sure that the tag supplies a valid time.
Possible data types: 
• DateTime
• String
• Integer
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– Optional: Under "Legend table properties", you configure the contents that the legend 
table of the segment is to display:

"Name"
"Start time"
"End time"
"State"

General information on the segment

"Context filter" If the segment time was limited by a context filter: The path to the 
plant object of the context and the context name.

"Audit status" Displays the overall status of the Audit data:
• Green field: No manipulations of the Audit Trail were found in the 

queried time range.
• Red field: Manipulations of the Audit Trail were found in the quer‐

ied time range. Single or multiple entries have been deleted, 
added or changed.

"Header" The legend table includes a list of the data source items of the seg‐
ment which shows general information about the data source items 
of the segment.
The information displayed for the data source items depends on their 
type.
Example of contexts: Display name of the context, context provider, 
hierarchy path, short name of the context, full name of the context, 
option

Use the check boxes to remove information from or add information to the legend table.
To change the sorting in the legend table, move the cursor to a row and move it using the 
arrow buttons.

– Optional: Under "Autofit", configure whether the column width and row height of the data 
table is automatically adapted to the text read from Runtime.
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6. Optional: You can filter the time interval of the time series segment depending on the 
context. You can define up to two filter conditions.
Follow these steps:
– Under "Context filter", click "+" or "Add new condition row". 

The condition line is added.
– Click on "+" in the condition line.
– Under "Select context", select the root of the common plant model. 

In the next row, you see the top level of the common plant model.
– Navigate through the common plant model to plant objects with contexts.

Plant objects and contexts can be recognized by the following icons:

Plant object

Context

– Select a context.
– Select an operator. 
– Enter a value. 
– Optional: Use "+" or "Add new condition row" to create a second condition and select 

whether the two conditions are to be linked with a logical AND or OR.
7. Confirm your entries with "OK".

Result
The segment is created and added to the list of segments:
Next, add data source items to the segment. Your procedure depends on the type of the new 
data source item.
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Format for relative time information 
The relative times are entered using a reference time and a time interval.

Reference time
Use one of the following characters for the reference time:
• "*" - Now
• "t" (today) - Today at midnight
• "y" (yesterday) - Yesterday at midnight
•  "1-31" - Specific day of the current month

Time interval
• "y" (year): +1y = plus 1 year
• "mo" (month): +1mo = plus 1 month
• "w" (week): +1w = plus 1 week
• "d" (day): +1d = plus 1 day
• "h" (hour): +1h = plus 1 hour
• "m" (minute): +1m = plus 1 minute
• "s" (second): +1s = plus 1 second
• "ms" (milliseconds): +250ms = plus 250 milliseconds

Examples
• *-1y: One year ago today
• t+8h: Today at 8:00 am
• y+8h: Yesterday at 8:00 am 
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• 1+8h: The first day of the current month at 8:00 am
• *-1d: One day ago
• *-2h-30m-30s: 2 hours, 30 minutes and 30 seconds ago

See also
Tips on design and layout (Page 211)
Adding data source items (Page 185)
Working with configurations (Page 197)

Edit segments

Requirement
• The "WinCC Unified" tab is visible in Excel. 
• A segment is available.

Procedure
1. Click on "Segments" in the "Configuration" group.
2. Click "Edit" next to a segment in the list of segments.
3. Edit the segment.

You can make the same settings as when creating the segment.

Delete segments

Requirement
• The "WinCC Unified" tab is visible in Excel. 
• A segment is available.

Procedure
1. Click on "Segments" in the "Configuration" group.
2. Click "Delete" next to a segment in the list of segments.
3. Confirm your entries with "OK".
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Specifying the column sequence

Introduction
The columns of the data table take over the order that the data source items have in the 
segment. By default, this is the sequence in which the data source items were added to the 
segment. 
For time series segments, you can change the sequence of the data source items and thereby 
specify a different column sequence in the data table.

Note
Changing the column sequence of alarm properties of an alarm data source item
The configuration of the alarm data source item also allows you to define the sequence in which 
the columns of the alarm properties are inserted into the data table.

Requirement
• The "WinCC Unified" tab is visible in Excel. 
• A time series segment has been created.

Procedure
1. Click on "Segments" in the "Configuration" group.
2. Click the time series segment in the list of segments.

The data source items of the segment are displayed.
3. Left-click a data source item and move it up or down using drag-and-drop operation.

Result
The order of data source items in the segment interface is changed.
The next time the Runtime data is read in, the columns of the data table have the same order as 
the data source items.

See also
Create or edit configurations for an alarm (Page 198)
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Adding data source items

Adding log alarms

Requirement
• There are log alarms in the project that runs on the connected runtime server or is the basis 

of the configuration file.
• The "Alarm" option is activated in the connection settings.
• The "WinCC Unified" tab is visible in Excel. 
• A time series segment is available.

Adding log alarms
1. Click on "Segments" in the "Configuration" group.

The list with the segments already created is loaded.
2. Select a segment.

The segment is extended by the area for the data source items.
3. Click "+".
4. Select the "Alarm" option.
5. Select the "Alarm" entry under "Select alarms".

Note
Change selection criteria
After you have added alarms, you can change the selection criteria and add more data source 
items.
For example: Output tags and alarms in the same segment.

6. To undo your choice, select the "Alarm" entry under "Selected data source items" and click 
"Delete".

7. Confirm with "OK".

Note
Displayed alarms
First, the data table shows all log alarms of the project. You filter the alarms using the 
configuration of the data source item.

Result
The added data source item for alarms is displayed below the segment and inserted into the data 
table. 
If you do not want the data source item to use the default configuration, select a configuration.
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See also
Create or edit configurations for an alarm (Page 198)
Select configuration (Page 207)
Working with configurations (Page 197)

Adding alarm statistics

Introduction
To output statistical calculations for log alarms in a report, add alarm statistics to a report 
template. The following calculations are available:
• Frequency of an alarm
• Average display time per state machine
• Total display time per state machine
• Maximum display time per state machine
• Minimum display time per state machine
The alarm statistics add columns with statistical calculations and columns with general alarm 
properties of the recorded alarms to the reports.
You can find more information about calculations in alarm statistics in the help for the alarm 
control.

Requirement
• The "Alarm" option is activated in the connection settings.
• The "WinCC Unified" tab is visible in Excel.
• A time series segment is available.

Procedure
1. Click on "Segments" in the "Configuration" group.

The list with the segments already created is loaded.
2. Select a time series segment.

The segment is extended by the area for the data source items.
3. Click "+".
4. Select the "Alarm" option.
5. Under "Select alarms", select the "Alarm statistics" entry.
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6. Under "Select alarm statistics" select the entry "Alarm statistics".
Note
Change selection criteria
After adding the alarm statistics, you can change the selection criteria and add more data 
source items.

7. (Optional) To undo your selection, select the "Alarm statistics" entry under "Selected data 
source items" and click "Delete".

8. Confirm with "OK".

Result
The added data source item for alarm statistics is displayed below the segment and inserted into 
the data table. 
First, the data table shows the contents configured in the standard configuration for alarm 
statistics. To output other contents, select or create a configuration.

Add logging tags

Requirement
• The project on which the connected Runtime server runs or the basis of the configuration file 

has logging tags.
• The "Logging tag" option was selected while setting up of the connection.
• The "WinCC Unified" tab is visible in Excel. 
• A single value segment or time series segment is available.

Procedure
1. Click on "Segments" in the "Configuration" group.

The list of segments is loaded.
2. Select a segment.

The segment is extended by the area for the data source items.
3. Click "+".
4. Select the "Logging tag" option.
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5. Optional: To reduce the load time, filter which tags are loaded to the selection under "Add 
filter".
The preset filters "*" return all logging tags of the project.
– "Tag name": Enter the name of the online tag whose logging tags you want to add.
– "Logging tag name": Enter the name of the logging tags you want to add.  
Note that the entry is case-sensitive.
Note
Filter by partial string
You use the wildcard "*" to filter by partial strings.
For example:
• *T* returns all tags with a "T" in their name.
• *T returns all tags that end in "T".
• T* returns all tags that start with "T".
When filtering for structures, the separators must be part of the filter string.
For example: The following filters return the logging tags for all tags of the device 
"HMI_RT_1":
• Filter for tag: "HMI_RT_1::*" 
• Filter for logging tag: "*"

6. Click "Load".
The logging tags of the project are filtered and provided under "Select tags". 

7. Optional: Further reduce the number of tags that are offered for selection by clicking next to 
"Select logging tags" and entering another filter string.
The list of tags you are being offered is filtered while you type.

8. Select one or more tags under "Select logging tags".
The tags are added to the "Selected data source items" list.
Note
Change selection criteria
After you have added a tag, you can select a different option or a different filter and add 
additional data source items.
For example: Output KPIs and logging tags in the same segment.

9. To remove one or more data source items from "Selected data source items", select them and 
click "Delete".

10.Confirm with "OK".
The added logging tags are shown below the segment and added to the Excel table. 

11.If you have added the logging tag to a single value segment:
– In the Excel worksheet, select the cell in which the logging tag is to be inserted.
– Click the "Select a cell" button on the data source item of the logging tag. 

Alternatively, enter the name of the worksheet and the cell.
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See also
Create or edit configurations for logging tags (Page 200)
Working with configurations (Page 197)

Adding tags

Requirement
• The project on which the connected Runtime server runs or the basis of the configuration file 

has tags.
• The "Tag" option was enabled when the connection was set up.
• The "WinCC Unified" tab is visible in Excel. 
• A single value segment is available.

Procedure
1. Click on "Segments" in the "Configuration" group.

The list of segments is loaded.
2. Select the single value segment.

The segment is extended by the area for the data source items.
3. Click "+".
4. Select the "Tag" option.
5. Optional: To reduce the load time, filter which tags are loaded to the selection under "Add 

filter".
Under "Tag name", enter a filter, e.g. the name of the tag. Note that the entry is case-sensitive.
The default filter "*" returns all tags of the project.
Note
Filter by partial string
You use the wildcard "*" to filter by partial strings.
For example:
• *T* returns all tags with a "T" in their name.
• *T returns all tags that end in "T".
• T* returns all tags that start with "T".
When filtering for structures, the separators must be part of the filter string.
For example: The filter "HMI_RT_1::*" returns all tags of the device "HMI_RT_1".
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6. Click "Load".
The tags of the project are filtered and provided under "Select tags".
You can recognize structs and arrays in the list by the following items: 

① Button to display the members of the struct or array
② "Select all included data source items"

Button that adds all members with a simple data type to the list of selected data source items

7. Optional: Further reduce the number of tags that are offered for selection by clicking next to 
"Select tags" and entering another filter string.

The list of tags you are being offered is filtered while you type.
8. Select which tags will be added to the segment. You have the following options:

Target Procedure Result
Show the members of 
a struct or array.

Click the button with 
the arrow next to the 
struct or array.

A second "Select tags" list is added, in which you 
can see all the members of the struct or array.
You can add to the segment any members that 
have a simple data type, e.g. bool, float or string.

Add all members of a 
struct or array.

Next to the struct or ar‐
ray, click "Select all in‐
cluded data source 
items".

All members with a simple data type are added to 
the "Selected data source items" list and marked 
as selected under "Select tags":

Select tags with simple 
data type.

Under "Select tag", click 
the required tags.

The tags are added to the "Selected data source 
items" list and marked as selected under "Select 
tags":

Note
Automatic filtering when displaying the members or selection of all members 
If you click the button to display the members of a struct or array or activate the option to 
select their members, the struct or array is set as a filter:
• The list under "Select tags" only shows the struct or array.  
• A second "Select tags" list is added below this, in which you can see all members of the 

struct or array. 
To see all available tags again, delete the filters.

Note
Change selection criteria
After you have added a tag, you can select a different option or a different filter and add 
additional data source items.
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9. To remove tags from the segment, click on the tags in "Selected data source items" and click 
"Delete".

10.Confirm with "OK".
The added tags are added to the segment. 
When the report template is updated in the add-in and when the report is generated in runtime, 
the tag values are inserted into the data table. 

See also
Creating or editing configurations for tags: (Page 201)
Working with configurations (Page 197)

Adding contexts

Introduction
To display in a report which contexts are to run during a certain time period, add only contexts 
to a segment in the report template.
To display which process data has been accumulated during the runtimes of a context, add the 
context and other data source items, such as logging tags or log alarms, to the segment.

Requirement
• There are contexts in the project that run on the connected Runtime server or are the basis 

of the configuration file.
• The "Context" option is enabled in the connection settings.
• The "WinCC Unified" tab is visible in Excel. 
• A time series segment is available.

Adding a context to a segment
1. Click on "Segments" in the "Configuration" group.

The list with the segments already created is loaded.
2. Select a segment.

The segment is extended by the area for the data source items.
3. Click "+".
4. Select the "Context" option.
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5. Select a context:
– Under "Select context", select the root of the common plant model. 

In the next row, you see the top level of the common plant model.
– Navigate through the common plant model to plant objects with contexts.

Plant objects and contexts can be recognized by the following icons:

Plant object

Context

– Select the desired contexts.
All selected contexts are included in the "Selected data source items" list

Note
Change selection criteria
After you have added a context, you can select a different option and add additional data 
source items.
For example: Context and logging tags in the same segment.

6. To remove one or more data source items from "Selected data source items", select them and 
click "Delete".

7. Confirm with "OK".

Result
The selected contexts are displayed below the segment and inserted into the data table. 
If you do not want a context to use the default configuration, select its configuration next.

Content of the data table after executing the segment 
In segments to which only contexts or contexts and user-defined columns have been added:
• A line is inserted for each context whose runtime falls within the time period of the segment.
• "Time stamp" column: The time at which the context was started
In segments that combine contexts with logging tags or log alarms:
• All logged values with the same time stamp are displayed per row.
• "Time stamp" column: The logging event 
• "Start time" column: The time at which the context was started
• "Context " <Context name>"" column: The value passed to the context at start
• If no context was started at the time of logging, the context cells remain empty.
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Example
The following data source items were added to a segment:
• The "Product" context

Runtime of the context: 15:00:00 to 19:59:59 hours
The context was started with the "Orange lemonade" value.

• The "Logged_Rotation" logging tag
Logging cycle: 2s

• The "Logged_Temperature" logging tag 
Logging cycle: 5s

• The user-defined "Unit" column
It contains the unit for "Logged temperatures".

Content of the data table after execution of the segment:

Lines 2 to 
6

Values were logged for "Logged_Rotation" and "Logged_Temperature", while the "Product" context ran with the 
"Orange lemonade" value.

Line 8 A value was logged for "Logged_Rotation" while no context was running.

See also
Contexts (Page 46)

Adding user-defined columns

Introduction
User-defined columns supplement the data of the other data source items of a time series 
segment with additional information:
• With a fixed string

The string appears in each cell of the column.
Example: Display measurement unit of the tag values in report

• With a formula
The formula is calculated during generation for each cell in the dynamic column.  
Example: The sum of the tag values output in the report.

The configuration of the user-defined column controls which string or formula it uses.
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Requirement
• The "User-defined column" option was enabled when the connection was set up.
• The "WinCC Unified" tab is visible in Excel. 
• A time series segment is available.

Procedure
1. Click on "Segments" in the "Configuration" group.

The list of segments is loaded.
2. Select a segment.

The segment is extended by the area for the data source items.
3. Click "+".
4. Select the option "User-defined column".
5. Enter the name of the column under "name".
6. Click "Select" or press <ENTER>.

The column is included in the list "Selected data source items".
Note
Change selection criteria
After you have added a column, you can select a different option or a different filter and add 
additional data source items.

7. Select a configuration for the user-defined column.
8. To remove one or more data source items from "Selected data source items", select them and 

click "Delete".
9. Confirm with "OK".
The added columns are displayed below the segment and inserted into the data table. 

See also
Creating and editing configurations for user-defined columns (Page 203)
Select configuration (Page 207)
Working with configurations (Page 197)

Add Audit

Introduction
To output the Runtime device Audit Trail in a report, add an Audit data source item to a report 
template.
You can find more information about the Audit option in WinCC Unified in the TIA Portal help.
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Requirement
• The Audit option was activated in the engineering for the Runtime device.
• The "Audit" option is activated in the connection settings of the Excel add-in.
• The "WinCC Unified" tab is visible in Excel.
• A time series segment is available.

Procedure
1. Click on "Segments" in the "Configuration" group.

The list with the segments already created is loaded.
2. Select a time series segment.

The segment is extended by the area for the data source items.
3. Click "+".
4. Select the "Audit" option.
5. Select the Audit Trail.
6. (Optional) To undo your selection, select the Audit Trail under "Selected data source items" 

and click "Delete".
7. Confirm with "OK".

Result
The Audit data source item is displayed below the segment. 
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If an Audit Trail is configured for the data source, the Audit data is inserted into the report when 
the Runtime data is read into Excel and when it is generated in Runtime:
• In the legend table: Identifier of the overall status of the Audit Trail for the queried time range 

in the "Audit Status" field

Value Description
Green No manipulations of the Audit Trail were found in 

the queried time range.
Red Manipulations of the Audit Trail were found in the 

queried time range. Single or multiple entries 
have been deleted, added or changed.

Requirement: The "Audit status" option is activated on the segment under "Header 
properties".
Note
Overall status for check mode "None"
If the check mode "None" is set in the configuration of the audit data sources item, the "Audit 
status" field is always green.

• In the data table of the segment: Identifier of manipulations 

Type of manipulation Identifier in the data table
Value of entries changed Directly at the entries
Entries added
Entries deleted The manipulated time range receives a start and 

end entry.

First, the data table shows the contents configured in the standard configuration for Audit. To 
output other contents, select or create a configuration.

Defining the display name of a data source element
The name that is automatically generated when adding a data source element can be long, for 
example, for data source elements of the type context. 
You have the capability of defining a display name for a data source element that is displayed in 
the report instead of the name.

Requirement
• The "WinCC Unified" tab is visible in Excel.
• A segment with a data source item is available.

Procedure
1. Click on "Segments" in the "Configuration" group.
2. Expand a segment by clicking on it.

The area for adding and editing data source elements appears.
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3. Move the mouse pointer over a data source element and click "Edit".
A local configuration of the data source element opens. 
The local configuration adopts the values of the configuration that was originally set.

4. Enter the desired display name in "Display name". 
The display name must be unique within the segment.

5. Confirm your entry with "OK".

Result
• The "Display name" column is displayed in the legend table. 

The "Display name" column remains empty for data source elements without display name.
If the segment is configured accordingly, the "Name" column is also displayed.

• The display name is shown in the value table instead of the name.

Note
The display name is retained if you select a different configuration at the data source element

Delete data source elements

Requirement
• The "WinCC Unified" tab is visible in Excel. 
• A segment with a data source element is available.

Procedure
1. Click on "Segments" in the "Configuration" group.
2. Expand a segment by clicking on it.

The area for adding and editing data source elements appears.
3. Move the mouse pointer over a data source element and click "Delete".

Working with configurations

Basics of configuration
The configuration of a data source item defines the values of a data source element that are 
displayed in a segment or how they are calculated and displayed. 
There are specific configuration settings for each data-source-item type.
Data source items used in time series segments use a different configuration than data source 
items used in single-value segments. 
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You have the following options:
• Use standard configuration.

There is a standard configuration for all types of data source items. Once added, data source 
items use the default configuration of their type. 
You can edit the standard configurations.

• Use user-defined configuration.
You can create any number of user-defined configurations for all types of data source items.
You can select one of the user-defined configurations on the data source item.

• Overwrite a configuration locally.
You can overwrite the configuration selected at the data source item locally. 

Create or edit configurations for an alarm

Requirement
• The "WinCC Unified" tab is visible in Excel. 

Creating a configuration
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click "New Configuration > Logging alarm configuration". 
4. Enter the name of the configuration under "Name".
5. To determine which alarm properties are displayed, activate the options for the desired 

columns under "Columns".
To change the sequence of columns in the data table, move the mouse cursor to a row and 
move it with the arrow buttons.

6. To filter which log alarms are displayed, define a filter query. The filter query can consist of up 
to two conditions.
Follow these steps:
– Under "Filter query", click "+" or "Add new condition row".
– Select an alarm property, an operator, and enter a value.
– Optional: Use "+" or "Add new condition row" to create further conditions and select 

whether the conditions are to be linked with a logical AND or OR.
7. Activate the option "Use system colors" so that the alarms are highlighted with the same 

colors as in the alarm control.
8. Confirm your entries with "OK".

Editing a configuration
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
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3. Click a configuration for log alarms.
4. Edit the configuration settings. You have the same options as when creating the 

configuration.
5. Confirm your entries with "OK".
The changes are applied the next time you read in the Runtime data. 

Creating or editing configurations for an alarm statistics

Requirement
• The "WinCC Unified" tab is visible in Excel. 

Procedure
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click "New Configuration > Alarm statistics configuration". 
4. Enter the name of the configuration under "Name".
5. To determine which statistical calculations and alarm properties are displayed, activate the 

options for the desired columns under "Columns".
6. To filter which content is displayed in the alarm statistics, define a filter query. The filter query 

can consist of up to two conditions.
Follow these steps:
– Under "Filter query", click "+" or "Add new condition row".
– Select an alarm property, an operator, and enter a value.
– Optional: Use "+" or "Add new condition row" to create further conditions and select 

whether the conditions are to be linked with a logical AND or OR.
7. Activate the option "Use system colors" so that the alarms are highlighted with the same 

colors as in the alarm control.
8. Confirm your entries with "OK".

Editing a configuration
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click a configuration for alarm statistics.
4. Edit the configuration settings. You have the same options as when creating the 

configuration.
5. Confirm your entries with "OK".
The changes are applied the next time you read in the Runtime data. 
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Create or edit configurations for logging tags

Requirement
• The "WinCC Unified" tab is visible in Excel. 

Creating a configuration
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click "New Configuration". 
4. To create a configuration for logging tags in a time series segment, select the entry "Logging 

tag configuration". 
To create a configuration for logging tags in a single value segment, select the entry "Single 
value configuration logging tag".

5. Set the settings for the configuration.
6. Confirm your entries with "OK".

Editing a configuration
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click a configuration for logging tags.
4. Edit the configuration settings.
5. Confirm your entries with "OK".
The changes are applied the next time you read in the Runtime data. 

Settings for time series segments
The following settings are available for logging tags in time series segments:

Setting Description
"Name" Enter the name of the configuration.
"Calculation mode" Select which data are to be written if there is no current value.
"Interval" Only for the calculation modes "Keep last value" and "Interpolate".
"Show quality code" Select whether the quality code is output with the value.
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Settings for single value segments
The following settings are available for logging tags in single value segments:

Setting Description
"Name" Enter the name of the configuration.
"Time stamp" Determine the date and time for which the value is read. 
"Calculation mode" Determine which data is to be written if there is no current value.
"Show captions" Define whether a header is displayed in the columns for the time stamp, 

the data source item and the quality code.
"Show time stamp" Determine whether and where this information is displayed in the table. 

The information is always in relation to the value cell."Show data source item"
"Show quality code"

Possible values for "Time stamp":

 Absolute time information Select a date and a time.
The information is absolute.

 Relative time information Select a reference time and a time interval.
The information is relative to the current date.

 Read time information from cell Applies the value of the cell currently highligh‐
ted in the Excel file.
Make sure that the cell supplies a valid time.

 Read time information from tag Applies the value of the set tag.
Make sure that the tag supplies a valid time.
Possible data types: 
• DateTime
• String
• Integer

Creating or editing configurations for tags:

Requirement
• The "WinCC Unified" tab is visible in Excel. 

Creating a configuration
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click "New Configuration> Tag single value configuration". 
4. Set the settings for the configuration.
5. Confirm your entries with "OK".
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Editing a configuration
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click a configuration for tags.
4. Edit the configuration settings.
5. Confirm your entries with "OK".
The changes are applied the next time you read in the Runtime data. 

Settings for single value segments
For tags in single value segments the following settings are available:

Setting Description
"Name" Enter the name of the configuration.
"Show captions" Select whether a header is displayed in the columns for the time stamp, 

the data source item and the quality code.
"Show time stamp" Select whether the time stamp is output with the value.
"Show data source item" Select whether the quality code is output with the value.
"Show quality code" Select whether the quality code is output with the value.

Creating or editing configurations for contexts

Requirement
• The "WinCC Unified" tab is visible in Excel. 

Core statement
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click "New Configuration". 
4. Select the entry "Configuration context". 
5. Under "Columns" you select which columns are inserted in the data table for contexts. 
6. To change the order of the columns, move the mouse pointer to the row of a column and 

move it using the arrow buttons.
7. Confirm your entries with "OK".
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Edit configuration
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click a configuration for contexts.
4. Edit the configuration settings.
5. Confirm your entries with "OK".
The changes are applied the next time you read in the Runtime data. 

Creating and editing configurations for user-defined columns

Requirement
• The "WinCC Unified" tab is visible in Excel. 

Procedure
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click "New Configuration > User-defined column configuration". 
4. Enter the name of the configuration under "Name".
5. Under "Formula", select one of the following options:

– Enter a fixed string.
The string is transferred into each cell of the column.

– Enter an Excel formula.
The formula is copied into each cell of the user-defined column and adapted to the 
respective row. 
To prevent a part of the formula from being adjusted, place the character "$" in front of 
it.
Example

Formula in configuration =B2+C2 =B$2+C2 
Adapting the formula in the 
report

in line 2 =B2+C2 =B2+C2
in line 3 =B3+C3 =B2+C3
in line 4 =B4+C4 =B2+C4

Note
No validity check 
The formula is not tested for correctness during either input or dynamic adaptation.

6. Confirm your entries with "OK".
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Adding or editing configurations for audit

Introduction
Check mode
The check mode of the configuration of an audit data source item determines
• whether an integrity check is performed when the runtime data is read, and what is checked. 

You can output the overall result of the check in the table header row in the "Audit status" 
field.

• Which audit data records are provided in the data table.
Possible check modes:

"None" Provides the data for all audit data records that fall within the requested time range. No 
integrity check is performed.
Default setting

"Check only" Checks all audit data records that fall within the requested time range without providing their 
data. 
It is tested whether data records have been manipulated, deleted or added.

"Check entries" Checks the audit data records that fall within the requested time range and that have not been 
deleted from the audit trail or subsequently added, and provides their data. 
It is checked whether data records have been manipulated.

"Check all" Checks all audit data records that fall within the requested time range and provides their data. 
It is tested whether data records were manipulated, deleted from the audit trail or subse‐
quently added.

Filter type
An Audit data record consists of two entries: One for user expectation and one for system 
response. User expectation and system response may differ. In addition, there are cases in which 
one of the two entries is missing. 
The filter type controls which data records and which entries are inserted into the data table. 
Possible filter types:

Filter type User expectation equals sys‐
tem response 

User expectation does not 
equal system response

Data record entry for user 
expectation or system re‐
sponse is missing

"Show all data in detail" Both data record entries are inserted. The existing data record entry 
is inserted."Show data and conformity 

errors"
The data record entry with 
the user expectation is inser‐
ted.

Both data record entries are 
inserted.

"Show only data with con‐
formity errors"

No data record entry inserted.

Requirement
• The "WinCC Unified" tab is visible in Excel. 
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Procedure
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click "New Configuration > Audit configuration". 
4. Enter the name of the configuration under "Name".
5. Select a check mode:
6. Determine which audit attributes are displayed. To do this, activate the options for the 

desired columns under "Columns". 
7. Specify a filter type. 

Preset value: "Show data and conformity errors"
8. (Optional) To further filter the inserted content, define a filter query. 

The filter query can consist of up to two conditions. Follow these steps: 
– Under "Filter query", click "+" or "Add new condition row". 
– Select an Audit attribute, an operator and enter the value of the attribute. 
– Optional: Use "+" or "Add new condition row" to create further conditions and select 

whether the conditions are to be linked with a logical AND or OR.
9. Confirm your entries with "OK".

Editing a configuration
1. Click on "Segments" in the "Configuration" group.
2. Click "Data source item configuration". 
3. Click a configuration for Audit.
4. Edit the configuration settings. You have the same options as when creating the 

configuration.
5. Confirm your entries with "OK".
The changes are applied the next time you read in the Runtime data. 

Examples of the configuration of the filter type
The following table contains examples of data records that were generated in Runtime through 
changes to tags monitored by Audit:

Data record 
ID

Tag name Modified by Old value New value Description

1A Mo‐
tor1_Speed

User1 0 10 An operator changes the speed of a motor in 
an I/O field of an HMI screen.
User expectation and system response are 
identical.

1B Mo‐
tor1_Speed

System 0 10
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Data record 
ID

Tag name Modified by Old value New value Description

2A ValvePercen‐
tile

User1 0 100 An operator opens a valve using a slider on 
an HMI screen.
The valve has a physical blockage and cannot 
be opened. Therefore, no data record entry 
for the system response is generated.

3A ValvePercen‐
tile

User1 0 99 A physical blockage has been removed and 
the operator repeats the entry. The valve re‐
acts, but cannot be fully opened.
User expectation and system response differ.

3B ValvePercen‐
tile

System 0 49

4B Mo‐
tor2_Speed

System 0 20 An operator changed the speed of another 
motor. The resulting data record was manip‐
ulated and the user expectation entry was 
deleted.
There is only one entry for the system re‐
sponse.

The following table shows which data record entries are inserted into the data table depending 
on the filter type selected when generating the report:

Data record ID Tag name Modified by Old value New value
Filter type "Show all data in detail"
1A Motor1_Speed User1 0 10
1B Motor1_Speed System 0 10
2A ValvePercentile User1 0 100
3A ValvePercentile User1 0 99
3B ValvePercentile System 0 49
4B Motor2_Speed System 0 20
Filter type "Show data and conformity errors"
1A Motor1_Speed User1 0 10
2A ValvePercentile User1 0 100
3A ValvePercentile User1 0 99
3B ValvePercentile System 0 49
4B Motor2_Speed System 0 20
Filter type "Show only data with conformity errors"
2A ValvePercentile User1 0 100
3A ValvePercentile User1 0 99
3B ValvePercentile System 0 49
4B Motor2_Speed System 0 20
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Select configuration

Requirement
• The "WinCC Unified" tab is visible in Excel. 
• A segment with a data source item is available.
• There is a user-defined configuration for the type of the data source item.

Procedure
1. Click on "Segments" in the "Configuration" group.
2. Select the segment.

The segment is extended by the area for the data source items.
3. Select the desired configuration from a data source item in the drop-down list.
4. Click "OK".

Result
The changes are applied the next time you read in the runtime data. 

Overwrite a configuration locally
A local configuration overwrites the configuration selected at the data source item. It is only 
available at the data source item where it was entered. 

Requirement
• The "WinCC Unified" tab is visible in Excel. 
• A segment with a data source item is available.

Procedure
1. Click on "Segments" in the "Configuration" group.
2. Select the segment.

The segment is extended by the area for the data source items.
3. Move the mouse over a data source item and click "Edit".

You create a local configuration that first adopts the values of the original configuration.
4. Enter a name for the local configuration.
5. Change the desired settings. 
6. Confirm your entries with "OK".
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Result
The changes are applied the next time you read in the runtime data. 

See also
Defining the display name of a data source element (Page 196)

Delete configuration

Requirement
A configuration is available.

Procedure
1. Click on "Segments" in the "Configuration" group. 
2. Click "Data source item configuration".
3. Move the mouse to a configuration.

Note
Default configurations cannot be deleted
You can edit default configurations but not delete them.

4. Click "Delete".

Result
• The configuration is deleted. 
• Data source items with this configuration obtain a local configuration with the same settings.

Reading Runtime data in Excel

Note
Reading in Runtime data in Excel is used for testing. It is not intended for mass retrieval of data, 
as is the case when report jobs are executed in Runtime.

Requirement
An online connection is established.
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Reading in all segments
1. Select "WinCC Unified > Segments".
2. Click "Update all" . 

Reading in individual segments
1. Select "WinCC Unified > Segments".
2. Click "Update"  next to a segment in the list of segments. 

Result
The segment or segments are run. The Runtime data of your data source items are read into 
Excel. 

Note
Controlling the column width and row height 
When the automatic adjustment of the column width and row height is disabled in the segment 
properties, the text read in may be truncated or the formula results are replaced with "#" 
characters. 
Check the column widths and row heights and adjust them manually, if required, or select 
automatic adjustment.

Note
Removing Runtime data from report template
Remove the Runtime data from the report template before you save the report template and 
make it available for uploading to Runtime. 
To do this, click the "Delete Runtime data" button  in the toolbar of the Excel add-in.

Diagnostics during the data query
Successful execution of the data query is documented by the add-in with a status message in the 
table:
If an error occurs during the data query, a general error message is displayed under status. In 
addition, detailed error messages are displayed in the "ErrorLog" worksheet.

Calculation modes for data source elements
If there is no current value for a data source item for a requested point in time, the following 
calculation modes are available.
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Calculation modes for tags 
The following calculation modes are available for tags of a time series segment:

Calculation mode Description
Raw The actual value available for the specified period. If no data are available, no value is 

output.
Keep last value: If no data are available, the last value is used.

With this mode you can also use values with an invalid quality code.
Interpolate The values are interpolated linearly for the specified time period.

With this mode you can only use values with a valid quality code.

The following calculation modes are available for tags of a single value segment:

Calculation mode Description
Interpolate The values are interpolated linearly for the specified time period.

With this mode you can only use values with a valid quality code.
Left If no data are available, the last value to the left of the specified time period is used.
Right If no data are available, the last value to the right of the specified time period is used.

Making general settings

Adapting the work area

Undocking and moving the add-in 
To enlarge your workspace, you can undock the Excel add-in:
1. Open the drop-down list in the header of the add-in.
2. Click "Move".
3. Move the mouse pointer to the desired location and click the left mouse button.
4. To move the add-in again, keep the left mouse button pressed in the header of the add-in and 

move the mouse.
5. To dock the add-in again, double-click in the header of the add-in. 

Adapting the size of the add-in
1. Open the drop-down list in the header of the add-in.
2. Click "Size".
3. Move the mouse pointer to the left to make the add-in wider or to the right to make it 

narrower.
4. Left-click when you have reached the desired size.
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Changing the language

Changing the add-in language
The Excel add-in automatically uses the same interface language as Excel. If you are using a 
language for Excel that is not included in the Unified options, English is used as the default 
language.
You can select the language for the contents of the report independently of the interface. To 
select another language, the language must be configured in Runtime.

Selecting the language for the report
1. Select "WinCC Unified > Segments".
2. Click  "Basic settings". 
3. Under "Runtime language", select the language of the report content.
4. Under "Query language" you select which language data queries have that require user input, 

e.g. filter definitions.

Zooming in the add-in

Procedure
To zoom in or out of the display in the add-in, press <CTRL> and move the mouse wheel.

Undo and redo
The Excel functions "Undo" and "Redo" are not available in the add-in. 

Tips on design and layout
This section includes tips on the visual design of reports. The apply for:
• Report templates
• Reports that were generated as XLSX file

Note
Deviating PDF results
A PDF report created by LibreOffice can deviate in content or layout from a PDF report generated 
with Excel, for example, if the report template uses common Excel features that LibreOffice does 
not support, such as special fonts or chart types.

Arranging segments
Always place the segments of a report template side by side or each in their own worksheet.
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Because the data tables of the segments grow dynamically, tables can overlap when segments 
are placed one below the other. This causes an error of the OfficeExtension.Error type.

Changing the column sequence
See section Specifying the column sequence (Page 184).

Adapt column width and row height
For each segment of a report template, check whether the column widths and row heights of 
your data table are wide or high enough for the values to be read. If this is not the case, texts in 
the generated report are truncated or the formula results are is replaced with "#" characters. 
To do this, select one of the following options:
• In the properties of the segments, select the options for automatic adjustment of the column 

width and row height.
• Click "Update all"  in the report template.

Values are imported to Excel from the data source. Check the column widths and row heights 
and adjust them manually, if required.

Preparing imported Runtime data
Adjust the cell formatting of the runtime data, for example, font, color, alignment, or number 
format. The rows inserted when reading the runtime data take over the formatting
Add diagrams, pivot tables or formulas that graphically visualize, structure or evaluate the data 
imported from Runtime.

Set up page
Use "File > Print > Set up page" to define details for printing the report, for example:
• Alignment of the report (portrait format or landscape format) 
• Scaling, for example, to print all columns on one page
• Inserting a user-defined header or footer
The print settings set in the report template are applied in Runtime when a report job is executed 
for PDF generation.

2.9 Elements

2.9.1 Overview of elements
Operable elements are available in process pictures in Runtime.
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The following elements are available depending on the configured access rights:

Icon Element Brief description
Bar Represents tags graphically. The bar graph can be labeled with a value 

scale.
I/O field Used for entry and display of process values.
Check box Used for display and selection of multiple options.

List box Used for display and selection of multiple list entries.

Radio button Used for display and selection of various options of which only one can be 
selected.

Switch Used for toggling between two predefined states.

Button Executes a configured function.
Slider Used for monitoring and changing process values within a defined range 

and adjusts them. By adjusting the slider, you intervene in the process and 
correct the displayed process value.

Clock Used for display of date and time.

Gauge Represents numerical values in the form of an analog gauge. For example, 
it can be seen at a glance whether the boiler pressure is in the normal range.
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2.9.2 Using elements

2.9.2.1 Bar

Application
The tags are displayed graphically with the "Bar" object. The bar graph can be labeled with a 
value scale.

Layout
The settings for the position, geometry, style, colors and fonts of the object are made during 
configuration.
In particular, the following properties are changed:
• Color transition: Specifies the change in color display when limit values are exceeded.
• Limit marking: Displays the configured limit value as an arrow.
• Bar segments: Defines the gradations on the bar scale.
• Scale gradation: Defines the position of the zero point on a bar scale.
If the object falls below a certain size in the light or dark style, it is automatically displayed in 
compact mode.
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Color transition
The display of the color change is specified during configuration.

Color transition Description
"Segmented" If a particular limit was reached, the bar changes color segment by segment. 

With segmented display, for example, the limits exceeded by the displayed 
value are visualized.

"Entire bar" If a particular limit was reached, the entire bar changes color.

2.9.2.2 IO field

Application
The "I/O field" object is used to enter and display process values.

Layout
The settings for the position, geometry, style, color and fonts of the object are made during 
configuration.
In particular, the following properties are changed:
• Mode: Specifies the response of the object in Runtime.
• Display format: Specifies the display format in the I/O field for input and output of values.
• Hidden input: Specifies whether the input value is displayed normally or encrypted during 

input.
Note
Reports
In reports, I/O fields only output data. "Output" mode is preset. Properties for configuring 
input are not available, e.g. "hidden input".

Mode
The behavior of the I/O field is specified during configuration.

Mode Description
"Input/output" Values can be input and output in the I/O field.
"Output" The I/O field is used for the output of values only.
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Layout
The "display format" for the input and output of values is specified during configuration.

Layout  
"Binary" Input and output of values in binary form
"Date" Input and output of date information. The format depends on the language setting 

on the HMI device.
"Date/time" Input and output of date and time information. The format depends on the lan‐

guage setting on the HMI device.
"Decimal" Input and output of values in decimal form
"Hexadecimal" Input and output of values in hexadecimal form
"Time" Input and output of times. The format depends on the language setting on the HMI 

device.
"Character string" Input and output of character strings.

Hidden input
In Runtime the input can be displayed normally or encrypted, for example for hidden input of a 
password. A "*" is displayed for every character during hidden input. The data format of the value 
entered cannot be recognized.

Avoid overlaps in output fields
If several I/O fields are configured as output fields with a transparent background in a screen, 
these I/O fields may overlap. The transparent part of the one field covers the digits of the other 
field. This may cause display problems. In order to avoid such overlaps, the border of the I/O 
fields must be set to zero during configuration.

Limits
During configuration, colors can be specified for the values that exceed or fall below limits.
When there is a limit violation, the background color of the I/O field changes according to the 
configuration, even if the I/O field is in input mode.
A limit range can also be defined for the input in the I/O field for the configuration.
If you enter a numeric value outside this limit, it is not applied; for example, 80 with a limit of 78. 
In this case, a system alarm is generated on the HMI device if an alarm window is configured. The 
original value is displayed again.

Decimal places for numerical values
The number of decimal places can be specified for a numerical input field during configuration. 
The number of decimal places is checked when you enter a value in this type of I/O field. Decimal 
places in excess of the limit are ignored. Empty decimal places are filled with "0".
In the exponential display, the displayed numerical value is represented with a maximum 
precision of nine decimal places.

Runtime Operating Manual
2.9 Elements

WinCC Unified Runtime
216 System Manual, 05/2021



Behavior when switching between input fields
When you change from one input field to another within a screen due to an operator input and 
the on-screen keyboard appears, the "Exit field" event is not immediately triggered for the 
previous field. Rather, it is only triggered after the on-screen keyboard is closed.

No events during the input
While an I/O field is in input mode, no events are transmitted to the server for the I/O field.
Terminate the input mode with Enter or Esc so that the events configured for the I/O field in 
engineering take effect again.

2.9.2.3 Check box

Application
You use the "Checkbox" object to select multiple options. Checkboxes can be activated by default 
so that the user changes the default values only as required. Multiple options can be selected if 
the corresponding properties are dynamized.

Layout
The settings for the position, geometry, style, color and fonts of the object are made during 
configuration.
In particular, the following properties are changed:
• Number of the checkboxes: Defines the number of options.
• Selection of the checkboxes: Defines which options are displayed as activated by default.

Default setting of the checkboxes
Each option is represented by a bit in a 32-bit word. To activate a field, the corresponding bit must 
have the value "1". The 32-bit word contains the information for all options of the checkbox list. 
The value of the "Presetting enabled" property is specified in hexadecimal format.

Runtime Operating Manual
2.9 Elements

WinCC Unified Runtime
System Manual, 05/2021 217



2.9.2.4 List box

Application  
You use the "List box" object to present and select multiple list entries. List entries are selected 
by default so that the default setting can be changed only when necessary. If the list box is larger 
than the selection rectangle, WinCC automatically adds a scroll bar to the right margin.

Layout  
The settings for the position, geometry, style, color and fonts of the object are made during 
configuration.
In particular, the following properties are changed:
• Number of entries: Defines the number of list entries.
• Selection of entries: Defines which entry is displayed as activated by default.

Default setting of the list boxes
Each option is represented by a bit in a 32-bit word. To activate a field, the corresponding bit must 
have the value "1". The 32-bit word contains the information for all texts of the list of list boxes. 
The value of the "Selected fields" property is given in hexadecimal notation. 

2.9.2.5 Option buttons

Application
You use the "Option button" object for selection of various options. Options are selected by 
default so that the default setting can be changed only when necessary. Only one option can be 
selected if the corresponding property is dynamized.
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Layout
The settings for the position, geometry, style, color and fonts of the object are made during 
configuration.
In particular, the following properties are changed:
• Number of fields
• Selection of the fields: Specifies which fields are displayed as activated.

2.9.2.6 Switch

Application
With the "Switch" object you switch between two predefined states. The current state of the 
"Switch" object is visualized with either a label or a graphic.

Layout
The settings for the position, geometry, style, color and fonts of the object are made during 
configuration.
In particular, the following property is changed:
• Type: Defines the graphic representation of the object.

Type
The display of the switch is specified during configuration.

Type Description
"Switch" The two states of the "Switch" are displayed in the form of a switch. The position 

of the switch indicates the current state. The switch is switched by moving it.
"Switch with text" The switch is shown as a button. The current state is visualized with a label. The 

switch is switched by clicking the button.
"Switch with graphic" The switch is shown as a button. The current state is visualized with a graphic. 

The switch is switched by clicking the button.
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2.9.2.7 Button

Use
With the "Button" object, you execute a configured function.

Layout
The settings for the position, geometry, style, color and font of the object are made during 
configuration.
In particular, the following properties are changed:
• Mode: Defines the graphic representation of the object.
• Text / Graphic: Defines whether the Graphic view is static or dynamic.
• Define hotkey: Defines a key, or shortcut that the operator can use to actuate the button.

Note
You can only define a hotkey for HMI devices with keys.

Mode
The display of the button is specified during configuration.

Mode Description
"Invisible" The button is not visible.
"Text" The button is displayed with text. This text explains the function of the button.
"Graphic" The button is displayed with a graphic. This graphic represents the function of 

the button.
"Graphic or text" The button is displayed with text or graphics. 

If the graphic cannot be displayed, the corresponding text is displayed.
"Graphic and text" The button is displayed with text and graphic.

Different options are available depending on the device.

Text / Graphic 
Depending on the "Mode" property, the display can be specified as a static or dynamic display. 
The display is specified during configuration.
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You can, for example, select the following options for the "Graphic" or "Text" type.

Type Option Description
"Graphic" "Graphic" With "Graphic when button "not pressed"", a graphic is specified that is 

displayed in the button for the "OFF" state.
When "Graphic when button "pressed"" is selected, a graphic for the "ON" 
state can be entered.

"Graphics 
list"

The graphic in the button depends on the state. The corresponding entry 
from the graphics list is displayed depending on the state.

"Text" "Text" With "Text when button "not pressed"", a text is specified that is displayed 
in the button for the "OFF" state.
When "Text when button "pressed"" is selected, a text for the "ON" state can 
be entered.

"Text list" The text in the button depends on the state. The entry from the text list 
corresponding to the state is displayed.

Hotkey
A key or key combination that the operator can use to actuate the button can be defined during 
configuration.

2.9.2.8 Slider

Use
Process values are monitored and adapted within a defined range with the "Slider" object. The 
monitored range is visualized in the form of a slider. By adjusting the slider, you intervene in the 
process and correct the displayed process value.
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Layout
The settings for the position, geometry, style, color and fonts of the object are made during 
configuration.
In particular, the following properties are changed:
• Maximum Value and Minimum Value: Specifies the top and bottom values of the scale.
• Display current value: Specifies whether the current position of the controller appears below 

the slider.
• Display of bars: The sliders above and below the bar can be hidden.
If the object falls below a certain size in the light or dark style, it is automatically displayed in 
compact mode.

Limits/ranges
You can represent limits and ranges in different colors. The colors are defined during 
configuration.

Note
If the "Show ranges from tag" option is selected, up to five ranges can be displayed in a slider. The 
values of the ranges are specified using a process tag. The values for the ranges are defined with 
a process tag that is connected to the screen object.
The option "Show ranges from tag" is available for Comfort Panels, KTP Mobile Panels and RT 
Advanced.

Behavior during operation
The displayed value on the slider control may deviate from the actual value of the associated tag 
in the following circumstances:
• The value range (minimum and maximum value) configured for the slider control does not 

correspond to the configured limits for the slider control tag.
• An invalid password has been entered for a password-protected slider control.
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2.9.2.9 Clock

Application
The "Clock" object displays the date and time.

By default, the "Clock" object displays the date and time of the client.
If the "Process value" property of the clock is connected to a DateTime tag, the clock uses the tag 
value as a start value and continues counting. When the tag value is changed the time is 
synchronized and continues counting from the new value.

Note
Static display of a date-time value
If the image is supposed to display a static time of day, link a tag of the type DateTime with an I/O 
field.

Layout
The settings for the position, geometry, style, color and fonts of the object are made during 
configuration.
In particular, the following properties are adapted:
• Analog display: Specifies whether the clock is shown as an analog clock or digital clock.
• Display clock dial: Specifies whether hour marks of the analog clock will be displayed.
• Width and length of hands: Specifies the width and length of the hands.
If the object falls below a certain size in the light or dark style, it is automatically displayed in 
compact mode.
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2.9.2.10 Gauge

Use
The "Gauge" object shows numeric values in the form of an analog gauge. For example, it can 
be seen at a glance whether the boiler pressure is in the normal range.

Note
The gauge is for display only and cannot be controlled by the operator.

Layout
The settings for the position, geometry, style, color and fonts of the object are made during 
configuration.
In particular, the following properties are changed:
• Display peak value pointer: Specifies whether the actual measurement range is indicated 

with a slave pointer.
• Maximum Value and Minimum Value: Specifies the top and bottom values of the scale.
• Start value of the danger range and start value of the warning range: Specifies the scale value 

from which the danger range and the warning range start.
• Display normal range: Specifies whether the normal range is shown in color on the scale.
• Color of individual ranges: Different operating modes, such as normal range, warning range 

and danger range, are shown in different colors so that the operator can distinguish them 
easily.

If the object falls below a certain size in the light or dark style, it is automatically displayed in 
compact mode.

Note
The use of many differently sized "Gauge" objects can reduce the performance in Runtime. With 
"Gauge", avoid minimally different heights and widths, for example, 48 pixels, 49 pixels, 51 
pixels, etc. Use the same sizes instead.
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Display peak value
The "Display peak value" property can be used to activate a marker function for the maximum 
and minimum pointer movement in Runtime. The actual measurement range is shown with a 
slave pointer.

Color of individual ranges
The normal range, danger range and warning range can be displayed in different colors. The 
colors are defined during configuration.

Note
If the "Show ranges from tag" option is selected, up to five ranges can be displayed in the gauge. 
The values of the ranges are specified using a process tag. The values for the ranges are defined 
with a process tag that is connected to the screen object.
The option "Show ranges from tag" is available for Comfort Panels, KTP Mobile Panels and RT 
Advanced.

2.10 Basic objects
In addition to controls and elements, HMI screens contain basic objects such as circles, polygons 
or text boxes. Basic objects are often used for design purposes, but can also provide information 
about the process.
Dynamically configured basic objects react to changes in the process or to operator actions. 
Example: In engineering, a text box is linked to a text list that defines text entries for the value 
range of a tag. In Runtime, the text box always shows the text assigned to the current tag value. 
When the tag changes its value, the content of the text box changes.

Overview of basic objects
Depending on the configuration, screens can contain the following basic objects:
• Line
• Polyline
• Polygon
• Ellipse
• Ellipse segment
• Circle segment
• Elliptical arc
• Circular arc
• Circle
• Rectangle
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• Text box
• Graphic view

Process values in text fields
If a text box has been connected to a tag in engineering, the text box shows the process value 
of the tag in runtime. 
If the text box was connected to a tag and a text list, the text box shows the text list entry that 
corresponds to the tag value.

Note
If no default value is assigned to the text list and the tag value is outside the defined value range 
of the text list, the last valid process value displayed by the text box is output.

2.11 Popup window
Popup windows are freely movable windows that open when an event configured in the 
engineering system occurs. They show, for example, additional information on a partial area of 
the process image. 
You close a popup window using the button in the top right corner of the popup window.

Example
Runtime shows a screen with an overview graphic for a pump and its valves. 

Configuration in the engineering system
A faceplate instance was positioned on the screen for each valve, which is displayed by the 
graphic of the valve. The faceplate instances have a script that opens an additional faceplate 
instance in a popup window in Runtime. This second instance shows detailed information on the 
valve as well as input fields.

Behavior in Runtime
When you click on a valve in the overview graphic in the screen, a popup window opens. In the 
popup window, you can check the state of the valve and edit the valve using the input fields.
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2.12 Starting and stopping projects on the RT server.

Overview
With SIMATIC Runtime Manager, you obtain an overview of which projects are running on the 
WinCC Unified Runtime server. You can start or stop the projects manually. Detailed information 
about the projects is displayed, e.g. status and type.

Project details Description
Project Project name 
State Status of the associated Runtime service (Running, Partly Running, Shutting Down, 

Stopped)
Type Type of the Runtime service 

REAL: Runtime mode
SIMULATION: Simulation mode

Device name Device name
ID Project ID 
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Runtime settings
Under "Settings of SIMATIC Runtime Manager", you have the following options: 
• Start OPC UA Export 

For additional information, refer to the "Runtime - Open Platform Communications (OPC)" 
manual.

• Set Script Debugger
Activate the option button for a Screen Debugger or Scheduler Debugger and enter the port.

Operation
1. Start SIMATIC Runtime Manager.
2. In the project list, select a project for the operation.

Icon Function
Starts a stopped project.

Stops a started project.

Adds a project to the list.

Deletes a project from the list.

Updates the project list.

2.13 Tests and error analysis

2.13.1 Trace protocols for function calls and tag values
WinCC Unified provides trace logging for error analysis. Tag values and function calls can be 
logged for test purposes and for troubleshooting with the trace.
All trace outputs with "Fatal", "Error" or "Warning" severity are stored in LOG files (.log) in the 
directory "%ProgramData%\Siemens\Automation\Logfiles\WinCC_Unified_SCADA_Vxx" In case 
of problems you must send these files to SIEMENS Customer Support.
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TraceViewer
The log files can be viewed with the Trace Viewer. It is located in the installation directory of 
WinCC Unified under "WinCCUnified\bin". To open the Trace Viewer start the file 
"RTILtraceViewer.exe". 

2.13.2 Debugging scripts

2.13.2.1 Basics of debugging

Introduction
For example, you can use a debugger to test whether correct values are being transferred to tags 
and whether abort conditions are being correctly implemented. Check the following in the 
debugger:
• Source code of functions
• Function sequence
• Values
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Note
Your code is displayed in the debugger but is write-protected.

Basic procedure
To find an error, check the script with the debugger. 
The following options are available for your support:
• Setting breakpoints
• Step-by-step execution
• Viewing values parallel to execution of the script
You do not edit the code of your scripts directly in the debugger. When you find an error, follow 
these steps:
1. Correct the error in the engineering system.
2. Compile the changed code.
3. Load the runtime.
4. Update the debugger.

2.13.2.2 Design and function of the debugger
Google Chrome provides the user interface of the debugger. Not all functions of the user 
interface of the debugger are relevant for debugging WinCC Unified Scripts. Only the functions 
that are needed to debug scripts in WinCC Unified are explained below.
You can find more information on Chrome DevTools under: https://developers.google.com/web/
tools/chrome-devtools/.
The debugger is divided into two areas:
• Debugger for screens
• Debugger for jobs
With the debugger for screens you view scripts at screens and screen objects. With the debugger 
for jobs, you view scripts that you have configured in the Scheduler.

Start page of the debugger
After the debugger has been started, its start page is displayed. 
The available contents differ depending on the selected area.
On the start page of the debugger for screens you can see two different contexts:
• Dynamizations (e.g. "UMCadmin@192.168.116.144 VCS_1 Dynamics") 
• Events (e.g. "UMCadmin@192.168.116.144 VCS_1 Events") 

Runtime Operating Manual
2.13 Tests and error analysis

WinCC Unified Runtime
230 System Manual, 05/2021



The name of the contexts is composed as follows:
• UMCadmin: User name
• 192.168.116.144: IP address of the computer
• VCS: Name of the graphic component
• _1: Number of the open client
• Events/Dynamics: Scripts at events or dynamizations

Note
A client corresponds to a tab in Google Chrome in which the runtime is open. When you have 
opened runtime in multiple tabs, multiple clients are used. The client opened first is given the 
number 1. Numbering is reset when the runtime is restarted.

On the start page of the debugger for jobs you can see the context "JobsExecution".

User interface of the debugger

① Navigation area
② Code display area
③ Console
④ Debugging area

Navigation area
In the navigation area, the available contents for the screen shown in runtime are displayed in 
groups. The available groups vary depending on the use of scripts and functions.
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Groups in the debugger for screens
The debugger for screens can contain the following groups in the dynamizations context:
• A group for scripts that were configured for dynamizations.
• One group per screen window in which scripts were configured for dynamizations.
The debugger for screens can contain the following groups in the events context:
• A group for scripts that were configured for events.
• One group for functions that were configured for events using the function list.
• One group per screen window in which scripts were configured for events.
• One group per screen window in which functions were configured for events using the 

function list.

Groups in the debugger for jobs
The debugger for jobs can contain the following groups:
• A group for scripts that were configured for tasks.
• One group for functions that were configured for tasks using the function list.

Code display area
Your code is displayed in the code display area. The rows are numbered.

Debugging area
The debugging area offers the following relevant options for WinCC Unified:
• Toolbar: Control for executing the script
• "Watch": Display of values
• "Callstack": Display of the current call stack
• "Scope": Available local values ("Local"), functions ("Module") and global values ("Global"),
• "Breakpoints": List of set breakpoints

2.13.2.3 Enabling the debugger

Requirement
• SIMATIC Runtime Manager is installed.
• The logged-on user has administrator rights.

Note
The debugger is only available locally. 
Remote access from the debugger to other devices is not possible.
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Procedure
The debugger is disabled by default.

Note
The debugger should be deactivated in production operation, as using the debugger can 
endanger system stability and security. Actions can accumulate if the debugger is, for example, 
at a breakpoint for a long time or the screen is not refreshed.

To activate the debugger, follow these steps:
1. Run the SIMATIC Runtime application with administrator rights.
2. Click the button  in the toolbar.
3. Switch to the "Scripts Debugger" tab.
4. To enable the debugger for screens, select the "Enable" check box in the "Screen debugger" 

area.
5. To enable the debugger for scheduled tasks, select the "Enable" check box in the "Scheduler 

debugger" area.
6. Assign an available port number to the debugger for screens (default port number: 9222).
7. Assign an available port number to the debugger for jobs (default port number: 9224).
8. Confirm your entries.

Note
Start the runtime after enabling the debugger.

2.13.2.4 Starting the debugger

Requirement
• Google Chrome (as of version 70) is installed.
• A project is opened in runtime.
• The debugger was activated in SIMATIC Runtime Manager.

Note
The debugger is only available locally. 
Remote access from the debugger to other devices is not possible.
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Procedure
1. In a new tab, call up the URL chrome://inspect in Google Chrome. 

The homepage of the Chrome DevTools is loaded in the tab.
2. Click "Devices".
3. Select the "Discover network targets" check box.
4. Click "Configure".
5. In the "Target discovery settings" dialog box, enter one of the following strings:

– 127.0.0.1:<Port number> 
– localhost:<Port number>
Use the port number for the Script Debugger entered in SIMATIC Runtime Manager.

6. Press Enter.
7. Click "Done".
8. Under "Remote Target", click "inspect" for the desired target.

The DevTools open in a separate window with the selected target.
9. In the DevTools, select "Sources".

The debugger is displayed.
10.Click "Toggle screencast".
11.In the navigation area under "Page", select the desired script module.

Updating the debugger
The debugger must be updated:
• After starting a new project 
• After restarting a running project, for example, because you have reloaded the project in 

engineering with "Download to device > Software (all)".
• After a screen change in Runtime
The connection to the debugger is lost in each case. Google Chrome therefore shows an error 
message and asks whether you want to restore the connection.
To restore the connection, proceed as follows:
1. Close the DevTools window.
2. On the DevTools start page under "Remote Target", click "inspect" again for the desired target.

Stopping the debugger
Exit the debugger by closing the DevTools window and, if necessary, the DevTools homepage.
This does not stop runtime.
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2.13.2.5 Working with breakpoints
Set breakpoints to stop the execution of the script at certain points and thus localize errors step-
by-step. Previously set breakpoints are still available after updating the debugger.

Requirement
• Runtime has started.
• The debugger has been started.
• The group you want to debug is selected.

Pause script
To pause the execution of a script, you have 2 options:
• To pause the script immediately, click the  "Pause script execution" button while the script 

is being executed.
• Set a breakpoint in the desired line.

The script pauses when a breakpoint is reached.
To pause a script at a breakpoint that is configured to an event, follow these steps:
1. Set a breakpoint in the script.
2. Trip the respective event in runtime.

The script pauses at the breakpoint.

Setting breakpoints
You have several options to set a breakpoint in a line of the script:
• Click on the line number.
• Right-click the line number and select "Add Breakpoint".
All set breakpoints are displayed in the debugging area under "Breakpoints".

Linking breakpoints to conditions
To link a breakpoint to a condition, proceed as follows:
1. Open the shortcut menu of the relevant line.
2. Select the entry "Add conditional breakpoint".

Execution of the script is stopped at the breakpoint when the condition is fulfilled.
Edit conditions as follows:
1. Open the shortcut menu of the relevant line.
2. Select the entry "Edit breakpoint...".
To prevent the script from pausing at a selected line, proceed as follows:
1. Open the shortcut menu of the respective line.
2. Select the entry "Never pause here".
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Showing and hiding breakpoints
When you hide a breakpoint, its position is retained. The script then ignores the hidden 
breakpoint. When you need the breakpoint again, it can simply be shown.
In the debugging area, all breakpoints set in the selected group are displayed under 
"Breakpoints".
You have several options to show a breakpoint:
• Set the check mark in front of the relevant breakpoint in the debugging area under 

"Breakpoints".
• Alternatively, right-click the number of the respective line in the code display area and then 

select "Enable breakpoint".
You have several options to hide a breakpoint:
• Remove the check mark in front of the relevant breakpoint in debugging area under 

"Breakpoints".
• Alternatively, right-click the number of the respective line in the code display area and then 

select "Disable breakpoint".
To show or hide all breakpoints, follow these steps:
1. Open the shortcut menu in the debugging area under "Breakpoints".
2. Select "Enable all breakpoints" or "Disable all breakpoints"

Enabling and disabling breakpoints
You can enable or disable all breakpoints independent of showing or hiding individual 
breakpoints.
You have several options to enable or disable all breakpoints:
• Click on the  "Deactivate breaktpoints" button in the debugging area.
• Open the shortcut menu of a breakpoint in the debugging area and select 

"Activate breakpoints" or "Deactivate breakpoints".
• Press <Ctrl + F8>.

Deleting breakpoints
You have several options to delete a breakpoint:
• Click on the breakpoint in the code display area.
• Open the shortcut menu of the breakpoint in the code display area and select 

"Remove breakpoint".
• Open the shortcut menu in the debugging area under "Breakpoints" and select 

"Remove breakpoint"..
To delete breakpoints, the shortcut menu offers the following additional options in the 
debugging area under "Breakpoints":
• Delete all breakpoints ("Remove all breakpoints")
• Delete all breakpoints except the selected breakpoint ("Remove other breakpoints")
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2.13.2.6 Step-by-step execution of scripts

Introduction
The following options are available to execute your script step-by-step:
• Execute script to the next breakpoint
• Force execution of a script
• Execute script to the next function call
• Jump into a function
• Jump out of a function
• Execute script up to a selected line
• Pause at Exceptions
• Use call stack

Requirement
• The group you want to debug is selected.
• The script pauses at a breakpoint.

Execute script to the next breakpoint
To pause the continuation of a script, you have several options:
• Click on the  "Resume script execution" button in the debugging area.
• Press the <F8> key.

The script is executed to the next breakpoint. If there is no other breakpoint, the script is 
executed completely.

Force execution of a script
To ignore the following breakpoints when resuming execution of a paused script, proceed as 
follows:
1. Click and hold down the  "Resume script execution" button.

The  "Force script execution" button appears.
2. Move the mouse pointer to the  "Force script execution" button while keeping the mouse 

button pressed.
3. Now release the mouse button.

The script is executed to the end.
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Execute script to the next function call
If a line with a breakpoint contains a function that you are not interested in, you can suppress the 
debugging of this function:
• Click on the  "Step over next function call" button in the debugging area.
• Press the <F10> key.

The function is executed without the script pausing within the function.

Jumping into a function
If the script pauses in a line containing a function that interests you, you can pause the script in 
that function:
• Click on the  "Step into next function call" button in the debugging area.
• Press the <F11> key.

The script pauses in the first line of the function.

Note
You can only jump into functions that you have defined yourself.

Jump out of a function
If the script pauses within a function that you are not interested in, you can suppress further 
debugging of this function:
• Click on the  "Step out of current function" button in the debugging area.
• Press the key combination <Shift + F11>.

Note
You can only jump out of a function that you have defined yourself.

Execute script up to a selected line
To pause a paused script again at a selected line, proceeds as follows:
1. Right-click the number of the line in the code display area.
2. Select the entry "Continue to here".

The script pauses at the selected line.

Pause at Exceptions
• To pause the script at Exceptions, click on the  "Pause on exceptions" button in the 

debugging area.
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Use call stack
• To jump into a function of the call stack, click on the corresponding entry under "Call Stack".

Note
You can only jump into functions that you have defined yourself.

2.13.2.7 Show values

Introduction
To identify errors in your script efficiently, have current values displayed while the script is being 
executed. This way you can view properties of objects or parameters of functions, for example. 
You can find additional information on objects and their properties under "WinCC Unified Object 
Model".

Requirements
• The group you want to debug is selected.
• The script pauses at a breakpoint.

Procedure
You view values by moving the mouse over the label in the code display area. 
You also have the following options to view values:
• In the debugging area under "Scope"
• In the debugging area under "Watch"
• In the console

"Scope" area
All local values ("Local"), functions ("Module") and global values ("Global") that are defined at this 
time are displayed in the "Scope" area.
The values cannot be edited.

"Watch" area
In the "Watch" area, you view how values change in the course of a script. 
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The following buttons are available to you:
•  "Add expression": Add a value
•  "Refresh": Refresh the "Watch" area
•  "Delete watch expression": Delete a value from the "Watch" area. Available when the 

mouse pointer is located above the respective value.

Console
The values available at the current time can be called in the console.
• You show or hide the console with <Esc>.
Call the current values in the console as follows:
1. Enter the name of a local or global value in the console.
2. Press <Enter>.
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Options 3
3.1 Plant Intelligence Options

Overview
The Plant Intelligence options offer optional enhancements to the WinCC Unified Basic System. 
These can be combined freely in line with your requirements.
The options allow you to plan production processes and analyze and optimize the overall 
effectiveness of your plant. In addition, you can design flexible production processes and 
coordinate complex and interlinked production processes.

Plant Intelligence options

• WinCC Unified Performance Insight
Define, calculate and analyze plant-specific key performance indicators (KPIs) for individual 
aggregates, machines or entire production lines in machine-oriented or line-oriented 
manufacturing plants.

• WinCC Unified Calendar
Plan, configure and manage events and actions together in a shared calendar in WinCC and 
combine these with WinCC tags or scripts.

• WinCC Unified Sequence
Control step-based and sequence-based processes, define the production steps of the 
production units and adapt the production processes flexibly in runtime.

• WinCC Unified Line Coordination
Coordinate and monitor processes in the production line in your plant. Control and manage 
recipes, processes and jobs for the production of various end products.

Note
The Plant Intelligence options are successively released as add-on packages. To use the Plant 
Intelligence options, you require the relevant software packages and licenses.
You can find information on the licenses in the TIA Portal installation instructions in the section 
"Licensing of WinCC Unified options".
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Requirements
Please note the following requirements for using the options: 
• SIMATIC WinCC Runtime Unified V17 is installed. 
• STEP7 Professional V17 is installed. 
• Plant Intelligence option, including license, is installed.
• The plant hierarchy is configured.
• License for the respective option is available. 
• The configuration engineer has WinCC experience.

Options
3.1 Plant Intelligence Options

WinCC Unified Runtime
242 System Manual, 05/2021



User administration in Runtime 4
4.1 User management scenarios

In the user management, you create new users and manage existing users.
Select one of the following scenarios of local or central user management.

Creating a local user management on a PC
WinCC Unified Runtime and the user management are installed on one PC.

Central user management
TIA Portal and WinCC Unified Runtime can be installed on one PC, UMC Server runs on a 
different PC.

4.2 User management in Runtime

4.2.1 Logon
To manage the local users on a Unified PC, you require the "User management" function right. 
Configure a user with the required rights in the engineering system and load the user into 
Runtime. Log in to the user management. 

WinCC Unified Runtime
System Manual, 05/2021 243



Procedure
To log on to user management in Runtime, follow these steps:
1. In the browser, enter the IP address or the fully qualified name (name and domain) of the PC 

on which Runtime is installed. If Runtime is installed on the same PC as the browser, the 
"localhost" designation can also be used. 
The start page of Runtime is displayed.

2. Click on the "User management" button. The "User login" dialog is displayed.
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3. Type in the user name and password.
4. If necessary, use the selection list to change the displayed language.
5. Click "Login". 

The user management start page opens in Runtime and you can manage the users.

4.2.2 Structure of the start page
In menu on the start page, select whether you want to manage the users, change the password 
or language, or log out. You can find the menu via the drop-down list in the upper right corner.

Note
Users with the "User management" function right have access to all functions.
Users without the "User management" function right can change their password under "User 
profile".
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Menu
The following options are available to you under the symbols in the menu:
• "Home"

This takes you to the start page of the user management.
• "Users" 

You can create new users or manage the existing users. 
• "User profile"

You can change your password and switch the language. 
• "Logoff"

You will be logged out directly and can log in again.

4.2.3 Users
Open the "UMC user" tab via the "Users" tab. Here you create new users and edit the properties 
and roles of the users.
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Adding users
The buttons are used to manage the users:
• "Add user" – you create a new user. 
• "Details" – you open a dialog in which you can change the password and status of the user 

and assign or remove roles.

You can select "Edit" or "Delete" in the line for each user:
• "Edit" – you change the password, the full name or the comment.
• "Delete" – you remove a user.

4.2.4 Password
You can change your password via the "User profile" link.
Users with the "User management" function right can change their password via "User profile" 
in the menu.
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Changing your password
If you have the "User management" function right, follow these steps:
1. Expand the selection menu at the top right.

2. Select "User profile".
3. Enter your current password. 
4. Assign a new password. 
5. Enter the new password again.
6. Select "Change". The password is changed.

4.2.5 Logging out
If you want to end your session in Runtime, explicitly log out.
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Logging out
To log out in Runtime, proceed as follows:
1. Close all open pages.
2. Select "Logout" from the menu. Your session is terminated.

Newly loaded data from the TIA Portal will not be applied until the next time you log in. 
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Certificate Manager 5
5.1 Functions of the Certificate Manager

Using certificates
Communication within the plant must be protected to secure plants, systems and networks 
against cyber threats. Between WinCC Unified devices, this is ensured by using encrypted 
communication protocols. Each communication partner is assigned a unique certificate, which 
is used for authentication and encryption.

WinCC Unified Certificate Manager 
The Certificate Manager supports you in creating and distributing certificates for WinCC Unified 
components that use encrypted communication. 

Note
No support for certificates from external certification authorities
To issue certificates for Unified Runtime via a certification authority, the use of the Certificate 
Manager is necessary. 

Additional information on the use of certificates can be found in the "Runtime Readme" help 
under Handling certificates (Page 23).
Functions of the Certficate Manager:
• Create a root certificate for the plant (Certificate Authority - CA)
• Central creation of certificates for WinCC Unified devices in the network
• Creation of the certificates for the following WinCC Unified components:

– WinCC Unified Runtime (Webserver (IIS))
– WinCC Unified OPC UA Server
– WinCC Unified OPC UA Exporter
– WinCC Unified OPC UA client
– WinCC Unified Collaboration
– WinCC Unified Audit

• Encrypted export of certificates for manual distribution to WinCC Unified devices
• Import and installation of the configured certificates on a WinCC Unified device
• Encrypted export and import of the root certificate including keys and all device certificates 

for data backup and restore.

WinCC Unified Runtime
System Manual, 05/2021 251



5.2 Using certificates

Required certificates
For WinCC Unified devices, certificates should be configured for the following applications:
• If a device has a web server (IIS) to enable access to WinCC Unified via web pages, a "web 

server" certificate is required.
• If WinCC devices are to exchange data with each other (WinCC Unified Collaboration), an "RT 

collaboration" certificate is required on all participating devices.
Note
Renewal of the Runtime Collaboration certificate after upgrading to V17
After a Runtime Collaboration device was upgraded to V17, its Runtime Collaboration 
certificate must be renewed.

• If the OPC UA server is used on a device, a device-specific certificate is required for the OPC UA 
server and the OPC UA Exporter.
Alternatively, you can use the self-signed default certificates generated for the OPC UA server 
and OPC UA exporter.

• If a device is to communicate with an OPC UA server, an OPC UA client certificate is required.
• All above-stated certificates are issued by a common Certification Authority (CA) to simplify 

the trust relationship between the communication partners.
• An empty CRL file (Certificate Revocation List) is automatically generated for the root 

certificate of the certification authority.
• The root certificate of the certification authority is classified as trusted on each device for each 

application. 
• When accessing WinCC Unified Runtime via websites, the root certificate must be configured 

as trustworthy once in the web browser.

Example
• In the example shown, two WinCC Unified PC devices and a panel are operated. 
• The PC devices provide web pages for the visualization of the runtime and therefore require 

a "WebServer certificate". 
• A PC device (192.168.0.100) operates an OPC UA server. The "WinCC Unified OPC UA Server" 

and "WinCC OPC UA Exporter" certificates are therefore required. 
• Runtime data should be exchanged between a panel (192.168.0.30) and a PC 

(192.168.0.40). Accordingly, both devices require an "RT collaboration certificate".
• The root certificate is installed and classified as trustworthy on all devices.
• When accessing the Runtime web pages from external devices via a browser, the root 

certificate must be installed in the browser's certificate store. The WinCC Runtime home page 
provides a corresponding download link. 
Additional information on the use of certificates can be found in the "Runtime Readme" help 
under Handling certificates (Page 23).
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5.3 Creating certificates

Creating a root certificate
1. Select a WinCC Unified PC device in your network that is to serve as the certification authority. 

The root certificate and the associated key are only available on this device. The 
configuration of additional application certificates for other devices is only possible on this 
device.

2. Open the "WinCC Unified Certificate Manager" on this device. 
3. Create a new root certificate for your plant. To do this, double-click the item "Create new 

certification authority".
4. Enter the properties of the root certificate in the "New certification authority" dialog. The 

fields are freely editable. 
Mandatory fields: 
– "Certification authority"  
– "Password" for the private key

See also Password requirements (Page 267).
If necessary, select a different key length and runtime for the certificate.

5. Click "Create". 　 
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The root certificate and its key are stored on the device and used to generate the device 
certificates. An empty CRL file (Certificate Revocation List) is created under the root certificate. 

Note
If the "WinCC Certificate Manager" is restarted on this device, the root certificate and the device 
certificates generated with it are loaded automatically.

Note
Distribution of the root certificate
Exporting and installing a certificate configuration with Certificate Manager includes the root 
certificate and its CRL file. In addition, you can export the root certificate and CRL file individually 
with the Certificate Manager and install them on a Unified PC with the SIMATIC Runtime 
Manager. 

Adding devices
1. Right-click the root certificate and select "Add device ...".
2. In the "New device" dialog, enter the complete computer name (fully qualified domain name) 

and/or the IP address of the device.
The specification of the IP address is sufficient for panel devices.  　 
For devices with dynamic IP addresses, enter only the host name.
Note
Permitted names
Either the host name or the "Fully qualified domain name" can be used as the name. The 
name is inserted in the certificates created for the device and used for validation. Within a 
domain, the "Fully qualified domain name" must be used to avoid validation errors when 
accessing the web pages.
The use of the name "localhost" is not permitted and is automatically replaced by the 
Certificate Manager with the name of the local device.

Adding certificates
1. Right-click on a device and select "Add <Certificate type> ..."
2. Enter the properties of the certificate in the dialog.  

If necessary, select a different key length and runtime for the certificate.
Note
Runtime
For web certificates, the runtime is limited to a maximum of 27 months. Longer runtimes are 
not accepted by some browsers.

Note
The "Fully qualified domain name" must be used for web server certificates.
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See also
Distributing and installing certificates on PC devices (Page 255)
Distributing and installing certificates on HMI panels (Page 258)
Exporting root certificate and CRL file (Page 259)

5.4 Distributing and installing certificates on PC devices

Introduction
To distribute the configured certificates to the corresponding devices, the certificates must be 
exported to a secure storage file. This file must be transferred manually to the respective device 
and imported there. The procedures differ for PC devices and panel devices.

Distribution and installation for PC devices
1. Export the entire certificate configuration to an encrypted file. Right-click the root certificate 

and select "Export all ..." in the menu.
Note
Export via "Export device certificates ..."
Alternatively, right-click on the PC device and select the command "Export device 
certificates..." from the menu. 
The TAR log created by the command cannot be imported and installed on the PC device via 
the Certificate Manager. Decrypt the log via OpenSSL and distribute the certificates manually 
to the specific repositories of the respective application. Proceed as described for Panels for 
the manual distribution of certificates. See section Distributing and installing certificates on 
HMI panels (Page 258).

2. In the "Export all" dialog, assign a password and select "Export for installation ..." (default 
setting).

See also section Password requirements (Page 267).
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3. Click on "Export" and select the storage location and file name. 
The data is stored encrypted with the specified password.

4. Copy the export file to the device to be installed.
5. Open the WinCC Certificate Manager on the device to be installed.
6. Double-click "Open configuration ...".
7. Select the exported file and enter the password.
8. You see the entire configuration for all devices, but you can only install a certificate for the 

local device. 
Note
Restrictions
The certificates of the other devices can only be displayed, the configuration cannot be 
changed.
The configuration display is used to install the certificates on the device. Exiting the 
Certificate Manager also closes the configuration. 

9. To install certificates for the local device, the following options are available:
– To install all available certificates, right-click the device and select "Install all 

certificates ...".

– To install a single certificate of the device, right click on the certificate and select "Install ..." 
in the menu.

Perform steps 4 to 9 on the other PC devices on which you want to install certificates.
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Result
• The certificates are installed in the certificate store defined for the respective application.
• The public root certificate of the certification authority is trusted in each certificate store.
• The CRL file of the root certificate is installed in the designated certificate store.
• If a web certificate is installed, it is automatically linked to the WinCC Unified website. The 

web certificate replaces any certificate selected during the runtime installation. 
The web page will then be restarted to enforce the use of the new certificate. Any connected 
web browsers are disconnected and must log on again.

Note
New certificates for the OPC UA server only become effective after a restart of the WinCC Unified 
Runtime.

See also
Exporting root certificate and CRL file (Page 259)

Certificate Manager
5.4 Distributing and installing certificates on PC devices

WinCC Unified Runtime
System Manual, 05/2021 257



5.5 Distributing and installing certificates on HMI panels

Exporting the certificate configuration
1. Export the certificate configuration of the panel device to an encrypted file:

– Right-click on the corresponding device in the Certificate Manager.
– Select "Export device certificates..." in the menu.

2. Assign a password. Optionally, you can adapt the iteration count for the encryption. Confirm 
with "Export".

See also section Password requirements (Page 267).
3. Select the storage path and file name. 
The data is stored in a TAR log and encrypted with the password.

Importing certificate from the Control Panel
Import the certificate in the control panel of the panel device under "Security" using the function 
"Certificates" > "Import".
A detailed description can be found in the "SIMATIC HMI devices Unified Comfort Panels" help.

Distributing certificates manually 
Copy the export file to the device to be installed. OpenSSL is required to decrypt the file.
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openssl enc -d -aes256 -salt -iter <25000> -in <exportfilename> -out 
<tarfilename.tar> -k <password>
• The value for the parameter -iter must match the iteration count specified during export.
• The decrypted TAR log contains the configured certificates in the respective application-

specific folder structure. 
• Manually distribute the certificates to the specific repositories of the respective application.

5.6 Exporting root certificate and CRL file

Introduction
The root certificate and the associated CRL file can be exported individually in the Certificate 
Manager, for example, to establish trust between a Unified device and its external 
communication partners or to update an expired CRL file.
After exporting, distribute the files:
• To install files on a Unified PC, use SIMATIC Runtime Manager.
• To install files on a Unified Comfort Panel, use the "Certificates" > "Import" function in the 

Control Panel of the device under "Security". 
• To distribute files to external communication partners, proceed as described in the user help 

for the device.

Note
Exporting the root certificate and CRL file of a Unified PC
To export the root certificate installed on a Unified PC and its CRL file, you can use the "SIMATIC 
Runtime Manager" tool as an alternative. You can find additional information here (Page 278).

Exporting root certificate and CRL file
1. Select the root certificate in the Certificate Manager.
2. Right-click and select "Export CA certificate ...".
3. Select a file format.
4. Confirm your entries.
5. Select a target folder.
6. Confirm your entries.
The root certificate and its CRL file are exported to the target folder. 
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Exporting a CRL file alone
1. Under the root certificate, select the Certificate Revocation List.
2. Right-click and select "Export".
3. Select a file format.
4. Confirm your entries.
5. Select a target folder.
6. Confirm your entries.
The CRL file is exported to the target folder.

5.7 Installing a root certificate in the browser for access via web client 
(Unified PC)

Using web certificates
To enable web browsers to establish a secure connection to WinCC Unified, the current root 
certificate of the WinCC Runtime must be known in the web browser as a trusted certification 
authority.
By installing the web certificate on the PC device, the public root certificate is made available as 
a download for installation in web browsers on the WinCC Unified home page.
The procedure for installing the root certificate differs depending on your web browser.

Installing the root certificate for Chrome and Microsoft Edge
Chrome and Microsoft Edge use the Windows system certificate store.
• On devices with WinCC Unified installation that have been configured with the Certificate 

Manager, these web browsers can immediately establish a secure connection to the WinCC 
Unified web pages because the root certificate has already been installed in the system 
certificate store.

• On devices without WinCC Unified Installation the root certificate must be installed 
manually. 
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To install manually, follow these steps (for example, Microsoft Edge):
1. Open the WinCC Unified home page via the URL https://<host name>

At first, an error message appears:

2. Open the field with the error details and confirm that you want to open the web page. 
3. On the WinCC Unified home page, select the field "Certificate Authority" and confirm "Open 

file" in the download dialog.

The root certificate is downloaded to the default download directory.
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4. Open the downloaded file.
The root certificate is opened with the Windows standard form.

5. To import the root certificate into Windows, select "Install Certificate".
6. In the Certificate Import wizard, select "Local machine" as the storage location, "Trusted Root 

Certification Authority" as the certificate store and start the import process.

Installing the root certificate for Firefox 
Firefox uses its own certificate store and must therefore be configured manually on each device 
once:
1. Open the WinCC Unified home page via the URL https://<host name>

At first, an error message appears:
2. Open the field "Advanced" and confirm the field "Accept the Risk and Continue".

An exception is entered for this page in the Firefox certificate management.
3. On the WinCC Unified home page, select the field "Certificate Authority".
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4. Save the root certificate. To do this, click "Save file" in the Firefox dialog that follows.
5. Store the certificate in the Firefox certificate store. Proceed as follows:

– Open the "Settings" page of Firefox.
– Select "Privacy & Security". There you will find the "Certificates" area further down. Open 

"Show certificates...".
– In the "Certificate Management" window, select the "Certification authorities" tab:

– Click "Import" and select the root certificate you saved in step 3.
– In the window that opens, select the option "This certificate can identify websites" and 

confirm your selection.
– Click "Server" and remove the exception that was created by step 2.
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Installing the root certificate on iOS devices
iOS uses its own certificate store and must therefore be configured manually on each device 
once. An error message also appears when the WinCC Unified home page is opened.
1. Open the field "Advanced" and confirm the field "Accept the Risk and Continue".
2. On the WinCC Unified home page, select the field "Certificate Authority".

3. Select "Install".
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4. Select "Install" again.

You see the entry "Trusted".
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5. Select "General > Info > Certificate Trust Settings".

6. Activate "WinCC Unified CA" and select "Next".

5.8 Renewing certificates
Use the "Recreate" function to:
• Edit entries for a valid certificate, for example, to correct entries.
• Renew a certificate whose lifetime has expired.
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Procedure
1. Right-click the certificate and select "Recreate...".

The "New <Certificate type> certificate" dialog opens. The entries of the old certificate are 
downloaded into the dialog.

2. Change the desired properties.
3. Click "Confirm".

Result
A new certificate is created. Export the certificate and install it on the target device. 

5.9 Updating a CRL file
When the root certificate is created, the CRL file is given a lifetime of 24 months. 
To update the CRL file, proceed as follows:
1. Under the root certificate, select the "Certificate Revocation List" entry.
2. Select "Update".
A new CRL file with a lifetime of 24 months is created. Export the CRL file and install it on the 
target device.

5.10 Password requirements
The passwords defined in the Certificate Manager must meet the following requirements:
• Length: At least 8 characters
• In each case at least one uppercase letter, one lowercase letter, one number and one special 

character
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5.11 Changing the user interface language
To change the interface language of the Certificate Manager, select the desired language in the 
"Select language" list:
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SIMATIC Runtime Manager 6
6.1 Functions in the SIMATIC Runtime Manager

Introduction
The SIMATIC Runtime Manager offers the following options for WinCC Unified PC:
• Use the project list to get an overview of the projects loaded into the Runtime and their

properties.
See The Runtime Manager user interface (Page 270).

• Manually start and stop a project loaded into the Runtime.
See Starting the project (Page 272).

• Define a project that is started automatically when the HMI device starts up.
See Selecting an autostart project (Page 275).

• Restore log segments in Runtime and delete restored segments.
See Restoring and deleting log segments (Page 275).

• Load a project from an external storage medium into Runtime.
See Adding a project (Page 273).

• Make the following settings:
– Enter the password that is used by the Runtime Manager for secure communication with

Runtime.
See Setting security settings (Page 277).

– Activate automatic adaptation of the HMI screens to the window size of the browser in
which the Runtime project is displayed (autoscale).
See Setting general settings (Page 277).

– Export the tags of the project running in Runtime into an XML file via the OPC UA server.
See Exporting tags via the OPC UA server (Page 284).

– Activate the user management of the project running in Runtime.
See Activating user management (Page 282).

– Manage and distribute certificates of external communication partners and manage and
distribute the root certificate of the Unified PC.
See Managing certificates (Page 278).

– Configure and activate the Runtime script debugger (screen debugger and scheduler
debugger).
See Setting the Runtime Script Debugger settings (Page 285).

WinCC Unified Runtime
System Manual, 05/2021 269



6.2 Start Runtime Manager

Requirement
WinCC Unified Runtime for PC is installed on the device.

Procedure
Double-click the desktop link created during the installation of WinCC Unified Runtime. 
Alternatively, start the Runtime Manager from a file explorer by double-clicking the following 
file: "<Path to the Unified installation directory>\bin\SIMATICRuntimeManager.exe"
For example C:\Program Files\Siemens\Automation\WinCCUnified\bin
\SIMATICRuntimeManager.exe

Note
Starting the Runtime Manager as administrator
Some settings under "Settings" require the Runtime Manager to be started as administrator. 
Right-click on the .exe and select "Run as administrator".

6.3 The Runtime Manager user interface

Note
User interface language 
Runtime Manager starts with the language configured in the general settings. You can change 
the interface language. See also Setting general settings (Page 277).
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Structure
The Runtime Manager has the following structure:

① Information about the server on which the Runtime is installed
② Toolbar
③ Project list
④ Button to start the project is selected in the project list
⑤ Button to stop the project is selected in the project list
⑥ Status bar
⑦ "Restore/remove database segments for logs" button
⑧ "SIMATIC Runtime Manager settings" button

Toolbar
The toolbar has the following buttons:

Icon Function
Loads a project from an external storage medium into the Runtime.

Deletes from the Runtime the project selected in the project list.
The project folder and the log folders are deleted.
Updates the project list.
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Content of the project list.
The project list shows all projects loaded into the Runtime.
The list provides the following information on the projects:

Project details Description
Project Project name 
Autostart Indicates whether the "Autostart" option is activated.
Device name Device name
Status Status of the associated Runtime service 

Possible status values: 
• Running
• Is partially executed
• Is shut down
• Stopped
• Unknown

Type Type of the Runtime service 
REAL: Runtime mode
SIMULATION: Simulation mode

ID Project-ID 

6.4 Starting the project

Requirement
A project is loaded into Runtime that is not in the "Running" status.

Start without reset
Proceed as follows to start the project in a state that existed before the last project stop:
1. Click on the project in the project list.
2. Click the "Start" button . 
3. Select "Start".

Start with reset
Proceed as follows to start the project in a state that existed during the first project start:
1. Click on the project in the project list.
2. Click the "Start" button .
3. Select "Start with options".
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4. Enable the options "Reset logging data" and/or "Reset Runtime data" in the "Start project 
options" dialog.

5. Click "Start".

Result
• The project is started.  

Note
Activating user management
The login to the Runtime project requires that its user management is active in Runtime.
After starting a project manually, you have to activate its user management manually.

• If the "Reset logging data" option was enabled, the following data is deleted when Runtime 
is started:
– Logging tags
– Log alarms
– Logged context values

• If the "Reset Runtime data" option was enabled, the following data originating from the last 
runtime of the project is deleted when Runtime is started:
– The last values of internal, persistent tags
– The last alarm states
– The persistent attributes of the alarm system
– The persistent attributes for the last logging cycle of the logging tags.

See also
Activating user management (Page 282)

6.5 Adding a project
You have the option of loading projects from an external storage medium into Runtime with the 
Runtime Manager.
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Requirement
• The external storage medium with the Runtime project is connected to the computer. 
• The Runtime Manager is open.
• To download a project for which only the changes to the project have been downloaded to 

the external storage medium, the following additional requirements must be met: 
– The project that is to receive the changes is executed on the HMI device.
– The Runtime ID of the executed project and the project on the external storage medium 

match.

Procedure
1. In the toolbar, click "Add project from offline transmission".

The "Add projects" dialog box opens.
2. Under "Select project log", click "...". 

A selection dialog opens.
3. Select the compressed ZIP folder of the Runtime project on the storage medium.
4. Click "Open".

Under "Project information" you can see details of the selected project.
5. If the project was downloaded completely to the external storage medium, you can start it 

in Runtime after the download.
Follow these steps:
– Under "Options", select the "Start Runtime with project" option.
– Define whether project data is reset on startup.

To start the project in a state that existed when the project was first started, activate the 
options "Reset logging data" or "Reset Runtime data".
Disable these options to start the project in a state that existed before the last project stop.
For more information on which data is reset with these options, see section Starting the 
project (Page 272).

6. To overwrite the Runtime UMC data with UMC data from the project, select the "Overwrite 
UMC data with the context of the offline loading" option under "Options".

7. Confirm with "Add project".

Result
• The project is downloaded to Runtime and appears in the project list.
• When "Start Runtime with project" is activated: The running project is stopped and the 

downloaded project is started. Depending on your settings, the Runtime data and log data 
of the project is reset and the Runtime UMC data is overwritten by the UMC data from the 
project.
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Note
When you load a project from an external storage medium, the SIMATIC Runtime Manager 
extracts the repository to a temporary folder on the target system. The transfer to Runtime takes 
place from this folder, which is then deleted again.

6.6 Selecting an autostart project

Requirements
• At least one project is loaded into Runtime.
• The Runtime Manager is open.

Procedure
In the project list for the desired project, select the option in the "Autostart" column. 

Note
Restrictions
• You can only select one project for autostart at a time.
• The project must not have the "SIMULATION" project type.

Result
The project is started automatically when the device on which the Runtime is installed is started.

6.7 Restoring and deleting log segments
In Runtime you have the option of restoring segments from logs for which a backup was created.  
You can visualize the restored data in a trend view, for example.

Note
Database type for backups
Backups can only be created if the Microsoft SQL database type is used.

You can find more information on logs in the help of the TIA Portal.
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Requirement
• At least one backup of a tag or alarm log is available.
• A project is loaded into Runtime and is in the "Running" status.
• The Runtime Manager is open.

Restoring log segments
1. Select the project.
2. Click "Restore/delete database segments for logs".

A dialog opens.
3. Select the log type:

– "Alarm" for alarm logs
– "Tag" for data log

4. If required, select the relevant log in the selection menu.
5. If required, define a start time or end time.

If you define a start time, all entries from this point in time are restored.
If you define an end time, all entries up to this point in time are restored.
If you define a start time and an end time, all entries between the defined points in time are 
restored.

6. If you have moved the backup of the log to be restored, enter the changed storage path of the 
backup under "Backup path".
Note
Only one log can be restored using the "Backup path" option. 

7. Click "Restore segments".
The selected segments are restored.
If you have selected a time period, data may be restored beyond the selected period, as the 
restoration is carried out segment by segment.
Information on the restoration can be found under "Status".

Delete log segments
To delete all previously restored segments of the tag logs or alarm logs, follow these steps:
1. Select the log type:

– "Alarm" for alarm logs
– "Tag" for data log

2. Click "Delete segments".
Note
All restored segments of the selected log type are deleted regardless of the log or the defined 
period.
Information on the deletion process can be found under "Status".
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6.8 Setting security settings
For secure communication with Runtime, the same password must be stored in the Runtime 
Manager as in Runtime.

Requirement
The Runtime uses secure communication.

Note
Enabling secure communication 
Secure communication for Runtime can be enabled as follows:
• During the installation of the Runtime, in the step "Secure Download"; 

Or after the installation in the application "WinCC Unified Configuration".
• In the Engineering System, if encrypted transmission is configured in the Runtime settings of 

a device and the option "Allow initial password transfer via unencrypted download" is 
activated when downloading the device to Runtime.
After the first, unencrypted transmission, the Runtime switches to secure communication.

Enter password for secure communication
1. Click the  button in the toolbar.
2. Select the "Security" tab.
3. Under "Secure connection", enter the same password that is used by Runtime for secure 

communication.
See also Configuring the settings during installation (Page 16).

Note
If Runtime does not use secure communication, the password entered here is ignored during 
communication with Runtime.

6.9 Setting general settings

Activate Autoscale
Proceed as follows to automatically adapt the size of HMI screens to the window size of the 
browser in which a Runtime project is open:
1. Click the button  in the toolbar.
2. Select the "General" tab.
3. Under "Autoscale", select the "Fit screen to window" check box.
4. Restart the currently running project or start another project that is loaded into the Runtime.
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When users zoom in or out of the browser window, the HMI screens automatically adapt. Users 
always see the entire screen. 

Changing the user interface language
Proceed as follows:
1. Click the  button in the toolbar.
2. Select the "General" tab.
3. Select a language under "Language > Select language".
4. Click "OK".

Changing the interface language requires you to restart the Runtime Manager. To restart the 
Runtime Manager directly, confirm the message that opens with "OK".

6.10 Managing certificates
External communication partners are devices that exchange data with WinCC Unified Runtime 
via a secured connection. These devices use certificates for authentication that are either self-
signed or issued by another certificate authority.
Examples: An S7PLUS device or an external OPC UA communication partner

Introduction
The "Certificates" tab provides you with the following options: 
• Manage the trusted certificates of the external communication partners of the Unified HMI 

device (certificates, root certificates, and CRL files). 
• Export the certificates of the external communication partners to distribute them to other 

Unified HMI devices (certificates, root certificates, and CRL files). 
• Export the root certificate of the Unified HMI device and its CRL file (= Certificate Revocation 

List) to distribute them to external communication partners.
Note
Alternative method 
Export the root certificate and the CRL file of the Unified HMI device using the "WinCC Unified 
Certificate Manager" tool. You can find additional information here (Page 259).

• Import the root certificate of the Unified HMI device and its CRL file separately from the 
remaining certificate configuration. 
The root certificate is installed by the import.
Note
Alternative method 
Install the root certificate and the CRL file of the Unified HMI device together with the 
remaining certificates configured for the device using the "WinCC Unified Certificate 
Manager" tool. You can find additional information here (Page 255).
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Note
Importing and exporting CRL files
The root certificate of the Unified HMI device and its CRL file must be imported separately. 
When you export the root certificate of a CRL file, the CRL file is also exported. If required, you can 
export the CRL file separately.
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Structure

① Button for importing a certificate or CRL file
By importing a certificate, you trust the certificate. You can later reject the certificate and trust it again.

② List of certificates 
The following certificates are displayed:
• The root certificate installed on the Unified HMI device.
• The imported third-party certificates:

– Application certificates (self-signed or issued by a certification authority).
– Root certificates issued by the issuing certification authority.

③ Shows whether the HMI device trusts a certificate.
④ List of CRL files

Requirement
• The Runtime Manager is open.
• The certificates and CRL files to be imported are located in a folder to which the HMI device 

has access.
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Managing certificates
1. Click the button  in the toolbar.
2. Select the "Certificates" tab.
3. You can perform the following actions:

Action Procedure
Import and trust 1. Click "Import new certificate or Certificate Revocation List 

(CRL)."

2. Select the storage location of the certificate, for example an 
external data storage medium, and select the certificate.

3. Confirm your input.
The certificate is imported and copied to the "trusted" folder on the 
HMI device.

Trust Right-click on a certificate and select "Trust".
The certificate is moved to the "trusted" folder on the HMI device.

Reject Right-click the certificate and select "Reject".
The certificate is moved to the "untrusted" folder on the HMI de‐
vice.

Display Right-click on a certificate and select "Show".
A window with detailed information on the certificate opens.

Delete Right-click on a certificate and select "Delete".
The certificate is deleted from the certificate store on the HMI 
device.

Export 1. Right-click the certificate and select "Export".
2. If you have selected a root certificate, select the file format.
3. Select the target folder, for example, an external data storage 

medium.
4. Confirm your input.
The certificate is copied to the target folder. If you have selected a 
root certificate, its CRL file is also copied.
Distribute the files to the desired devices. To do this, proceed as 
described in the application help of the device.
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Managing CRL files
1. Click the  button in the toolbar.
2. Select the "Certificates" tab.
3. You can perform the following actions:

Action Procedure
Import 1. Click "Import new certificate or Certificate Revocation List 

(CRL)."

2. Select the location of the CRL file, e.g. an external data storage 
medium, and select the file.

3. Confirm your input.
The file is imported and copied to the "trusted" folder on the HMI 
device.

Delete Right-click on a CRL file and select "Delete".
The file is deleted from the "trusted" folder on the HMI device.

Export 1. Right-click on the CRL file and select "Export".
2. Select the file format.
3. Select the target folder, for example, an external data storage 

medium.
4. Confirm your input.
The CRL file is copied to the target folder.
Distribute the files to the desired devices. To do this, proceed as 
described in the application help of the device.

See also
Functions of the Certificate Manager (Page 251)

6.11 Activating user management

Introduction
Several projects can be loaded on one Unified PC. The configuration of their user management 
may differ. For a successful login to a project in Runtime, the project must be running in Runtime 
and the appropriate user management must be active.
In the "User administration" tab, activate the appropriate user administration. For a project with 
central user management, you can also adapt the connection settings to the UMC server, e.g. to 
add missing settings in the TIA Portal or to use different settings.
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Configuring the user administration
The user management of a project is configured in the TIA Portal under "Runtime settings > User 
management". In the Runtime Manager, it is not possible to switch a project from local to central 
user management.
You can find information on configuring the user management in the TIA Portal in the TIA Portal 
online help. 
You can find information on how to configure the runtime system settings for user management 
during runtime installation or later with WinCC Unified Configuration here (Page 18).

Requirement
• In the Runtime system settings, it has been specified that Runtime uses the user 

management configuration downloaded from the TIA Portal.
• At least one user has been configured with an HMI function right for the user management 

active in Runtime.
• At least one user has been configured with an HMI function right for the user management 

that you want to activate. 
• The Runtime Manager is open.
• A project is running in Runtime, and: 

– The active user management does not match the user management configured for the 
project.

– For projects with central user management: The connection settings configured in the TIA 
Portal for the project are incomplete, or you want to use different settings.

Procedure
1. Click the button  in the toolbar.
2. Select the "User management" tab.
3. Under "Select configuration", in the "From" list, select the project whose user management 

configuration you want to activate in Runtime.
Default setting after starting the Runtime Manager: The project running in Runtime

4. Confirm the confirmation prompt.
The "Operating mode" area shows the operating mode of the user management of the 
selected project. The displayed options are read-only.
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5. If the project selected under "From" uses local user management, click "Load user 
management".
User management is activated in Runtime:
– The user data pre-configured in the TIA Portal for the project is loaded into the local user 

management.
– Runtime uses the local user management.
– The "Status" field shows the status of the user management.

NOTICE
Possible data loss
The user data configured in the TIA Portal overwrites the user data added or changed on the 
HMI device in the local user management. Data loss can occur.

6. If the project selected under "From" uses central user management, proceed as follows:
– Add missing or incorrect information about the connection settings. 

By default, the identity provider address is automatically generated based on the UMC 
server address.
To enter the address of the identity provider manually, deactivate the option "Generate 
the address of the identity provider automatically".
To set all fields to empty, click "Reset configuration".

– Click "Connect to server".
The system will notify you if the configured server ID and the server ID reported during the 
connection attempt are different from each other. To continue with the ID reported 
online, click "Yes"; to continue with the configured server ID, click "No".

User management is activated in Runtime:
– A connection to the UMC server is established using the connection settings from the 

Runtime Manager. 
– Runtime uses the UMC server for user management.
– If you later select the project under "From", the connection settings you entered are 

loaded.

6.12 Exporting tags via the OPC UA server
In the "OPC UA Export" tab, you can export the tags of the project running in Runtime via the OPC 
UA server into an XML file. The exported data can then be imported into another application, e.g. 
the TIA Portal, without the need for a connection to the OPC UA server. 
The export makes it easier for you to apply an existing configuration to a new Runtime system.
For a detailed description on this topic, refer to the "Runtime - Open Platform Communications 
(OPC)" help. To do this, open the following file after installing Runtime: "<Path to the Unified 
installation directory>\Documentation\<Language folder>\WinCCRTUOPCUA<Language 
code>.pdf"
For example C:\Program Files\Siemens\Automation\WinCCUnified\Documentation\en-US
\WinCCRTUOPCUAenUS.pdf
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6.13 Setting the Runtime Script Debugger settings
The scripts of the screens and jobs of a Runtime project can be tested using the Google Chrome 
script debugger. 
To this end, the debugger must be configured and enabled in advance in the "Script debugger" 
tab in the Runtime Manager. 

See also
Enabling the debugger (Page 232)

6.14 Operation via command line
The Runtime Manager has an interface with which you can start numerous functions of the 
Runtime Manager via a command line program:

Requirement
• Runtime and command line program are installed on the same device.
• For starting/stopping projects: Projects have been loaded into Runtime.
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Procedure
1. Start the command line program.
2. Enter the command line call. Separate the individual elements of the call with spaces.

– Enter the path to the SIMATIC Runtime Manager.exe:
"<Runtime installation directory>\bin> start /wait SIMATICRuntimeManager.exe"
Example: C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe

– Enter the options with which the command line program calls the Runtime Manager.
The last option must be "-c".

Option Description
-s Option for starting the Runtime Manager in silent mode.

Without this option, the UI of the Runtime Manager is started when the 
command line call is processed.

-u Option to enable help messages that assist you in operating the Runtime 
Manager via the command line program.

-sim Only use this option if you call the option "-c" with the 
command projectstate, start, stop or remove.

-quiet Option for calling the Runtime Manager without output. 
-o Option for diverting the output into an Output.txt file that is stored parallel 

to SIMATICRuntimeManager.exe.
You can redirect the output to another folder. The Unified Administrator 
must have write access to the folder.
Example: 
-o “C:\Program Files\Siemens\Automation\WinCCUnified
\bin\MyOutput.txt"
If an error occurs during the write and -quiet is not set, the error indication 
appears on the console.

-keepUmc Optional
Only in combination with the fulldownload command
Set the option to keep the Runtime UMC data.

-overwriteUmc Optional
Only in combination with the fulldownload command
Set this option to replace the UMC data of the Runtime with the UMC data 
from the project.

-c Option for inputting the commands that are transmitted to the Runtime 
Manager.
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– After the option "-c", enter the command that the Runtime Manager should run and the 
argument that is transmitted to the command:

Command Argument Description
start <Project ID> Starts the project.
stop <Project ID> Stops the project.
projectlist [ALL] or [RUNNING]

Default: [ALL]
[ALL]: Returns a list of projects loaded in the 
Runtime.
[RUNNING]: Returns the project running in 
Runtime.

projectstate <Project ID> Returns the status of the project running in 
Runtime.

remove <Project ID> Removes the project from Runtime.
If the autostart option was previously set for 
the project: Removes the autostart option.

securemode <Password>
 

Sets the password for secure communication 
with SCS.
Enter the same password that Runtime uses 
for secure communication.

setautostart <Project ID> The project is started when the device is boo‐
ted.
The project must have the REAL type. 
The option can only be set for 1 project.

removeautostar
t

<Project ID> Removes the autostart of the project.

fulldownload <Log path> Starts the full download of a TIA Portal log.
If the project is already running in Runtime, it 
is stopped first before the full download.
To start the project after successful down‐
load, use the command start.

deltadownload <Log path> Starts the change loading of a TIA Portal log.
Check in advance if the corresponding 
project is downloaded and running in Run‐
time.

To run multiple commands, use multiple command line calls. 
3. Press Enter.
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Result
• The command is executed.
• A return code with description is output in the console.

List of possible return codes: 

Return code Description
0x00000000 Success
0x0080400b Project already running
0x0080400c Project started
0x0080400d Project already stopped
0x0080400e Project stopped
0x80000000 General error
0x80000001 Not supported (e. g. wrong command)
0x80000003 Timeout during communication with SCS
0x80000004 Invalid arguments
0x80000005 Access denied – password required for secure 

connection
0x8000000C Another project is currently flagged as autostart 

project, remove autostart from the other project
0x80000016 Unable to connect to SCS
0x80804019 Project not found
0x80B0412E Write output file error
0x80B0412F Autostart option cannot be set on simulation 

project
0x80B04130 Empty command value
0x80B04131 archive target path could not be created
0x80B04132 project archive can not be extracted
0x80B04133 DownloadTask file can not be read
0x80B04134 Could not change UMC Data override option
0x80B04135 Missing config folder in archive
0x80B04136 Missing delta folder in archive

• An output is written to the console or to the output file.
Requirement: The command was called without the -quiet option.
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Examples
• Call a list of all projects loaded into Runtime:

– Input: C:\Program Files\Siemens\Automation\WinCCUnified\bin> 
start /wait SIMATICRuntimeManager.exe -s -c projectlist [ALL]

– Example output:
[1]
 Project name:  T1 
 Device name:  T1 
 Project type:  REAL 
 Project ID:  0B527D12-6BBD-4F2F-BEB9-23E3C37A8932 
 Autostart:  0
[2]
 Project name:  T2 
 Device name:  T2 
 Project type:  REAL 
 Project ID:  29DCBA1D-C615-4560-AFB4-94EB9565682C 
 Autostart:  0
[3]
 Project name:  T3 
 Device name:  T3 
 Project type:  REAL 
 Project ID:  96FE68D0-5337-4072-A96C-F7C1D7525CAF
 Autostart:  0

• Call the project running in Runtime:
Input: 
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATiCRuntimeManager.exe -s -c projectlist RUNNING

• Query project status:
Input: 
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -c projectstate 96FE68D0-5337-4072-
A96C-F7C1D7525CAF

• Start a project:
Input: 
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -c start 96FE68D0-5337-4072-A96C-
F7C1D7525CAF

• Stop a project:
Input:
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -c stop 96FE68D0-5337-4072-A96C-
F7C1D7525CAF

• Remove a project from Runtime:
Input: 
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -c remove 96FE68D0-5337-4072-A96C-
F7C1D7525CAF
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• Example of a query regarding the status of a simulation project: 
Input:
C:\Program Files\Siemens\Automation\WinCCUnified
\bin>SIMATICRuntimeManager.exe -s -sim -c projectstate 
96FE68D0-5337-4072-A96C-F7C1D7525CAF

• Set password for secure communication with Runtime:
Input:
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -c securemode <password>

• Enable autostart for a project:
Input:
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -c setautostart 28AC5BD5-0741-42D1-
B3C6-503359F32B7E

• Disable autostart for a project:
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -c removeautostart 
28AC5BD5-0741-42D1-B3C6-503359F32B7E

• Perform a full download of a TIA Portal log:
Input:
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -c fulldownload "C:\Users\admin
\Desktop\ HMI_RT_1[Project1] - Full 2019-10-21 - 08.00.22.zip"

• Download only the changes of a TIA Portal log (delta download):
Input:
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -keepUmc -c fulldownload "C:\Users
\admin\Desktop\HMI_RT_1[Project1] - Full 2020-03-27 - 
11.39.51.zip"

• Retain UMC data during full download:
Input:
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -c deltadownload "C:\Users\admin
\Desktop\ HMI_RT_1[Project1] - Delta 2019-10-21 - 08.03.18.zip"

• Replace UMC data during full download:
Input:
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s -overwriteUmc -c fulldownload 
"C:\Users\admin\Desktop\HMI_RT_1[Project1] - Full 2020-03-27 - 
11.39.51.zip"

• Enable help messages:
Input:
C:\Program Files\Siemens\Automation\WinCCUnified\bin> start /wait 
SIMATICRuntimeManager.exe -s – u

See also
Enabling the debugger (Page 232)
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Tag Simulator 7
7.1 The WinCC Unified Tag Simulator

The WinCC Unified Tag Simulator of WinCC Unified Runtime is used to simulate internal tags and 
process tags. You use it, for example, to simulate the behavior of objects and scripts in the WinCC 
project.
To configure and activate the simulation, use the "Tags simulation" simulator.

Brief description 
The following general conditions apply for the simulator:

Tag types Process tags, internal tags and structure tags can be simulated.
You can find unsupported tag types under "Inserting tags in the "Tag simula‐
tion" editor (Page 298)".

Quantity structure A maximum of 300 tags can be simulated at the same time.
However, you can configure and save more tags in the simulator.

Update cycle The update time for tag values is one second.
Specify a multiple of a second using the "Cycle" parameter.

Online configuration Configuration changes of the simulation are immediately visible in Runtime.

WARNING
Effects on connected controls
Simulated tag values can be transferred to connected controllers.
When the WinCC project is connected to a controller, WinCC writes the simulated process values 
to the automation system.
This can lead to a reaction of the connected process I/Os.
Disconnect hardware
Before using the simulator, ensure that
• No hardware is connected, if possible.
• The connected hardware represents no danger even when values are extreme.
Recommendation
Simulate the process values without process connection.

Application examples 
Typical fields of applications for the Simulator:
• Testing the configuration without connected process I/Os
• Testing of the configuration with connected process I/Os, but without running process
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You can simulate process tags both with and without connected process I/Os.

Testing a WinCC project
Use the simulator to test a configuration without connected process I/O or without running 
process.
When process I/Os are connected, the process tags can be directly supplied with values using the 
simulator.
A function test of the operating and monitoring system with connected hardware offers the 
following options, for example:
• Checking limit levels and alarm outputs.
• Test the integration of alarms, warnings, and error messages and check of status displays.
• Preset, readout, and change of digital and analog inputs and outputs.
• Alarm simulation.

Presenting a WinCC project
Another application of the simulator is the implementation of a project for demonstration 
purposes.
A process connection is usually not available for the presentation of the operator control and 
monitoring system.
In this case the simulation takes over the control of the internal tags and the process tags.

See also
Inserting tags in the "Tag simulation" editor (Page 298)

7.2 Open the "Tag Simulation" simulator

Procedure
To configure and activate the simulation, use the "Tags simulation" simulator. The simulator 
opens in a separate window.
Start the simulator via the Windows user interface. Select one of the following options:
• In the Windows program group "Siemens Automation", select the entry "WinCC Unified Tag 

Simulator".
• Search via the taskbar for "WinCC Unified Tag Simulator" and start the simulator.
The "Tags Simulation" simulator is opened. No simulation is started.
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7.3 User interface of the "Variable simulation" simulator.

Areas of the simulator
The simulator consists of the data area and the Properties window.

Window "Properties - Tag"
To display and edit the properties of a tag in a clear form, use the Properties window.
The property window contains no simulation values or runtime values of the tags.
The tag selected in the data area is loaded to the "Properties - Tags" property view for editing.
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Data area
To set the same property for multiple tags, work in the data area and use, for example, the 
automatic continuation ("Drag Down").
The data area additionally contains the simulation values and runtime values of the tags.

"Simulation" menu
The menu bar contains the entry "Simulation".
When the WinCC project is in RUN in Runtime, the entries "Start" and "Stop" are active. This allows 
you to start and stop the configured simulation.

Tag properties
You edit the properties in the data area or in the properties window.

Name Property Description
Tag name Inserted tag Enter a tag name or click on the arrow button and select 

a tag from the list.
You can find additional information under "Inserting tags 
in the "Tag simulation" editor (Page 298)".

Object type Tag -
Object name Tag name Display: Inserted tag
Data type Tag type Display: Data type of the inserted tag
Active Activating the tag for 

the simulation
A maximum of 300 tags can be simulated at the same 
time.
To activate all inserted tags, select the "Active" column in 
the data area and select the entry "Select all" in the 
shortcut menu.
When more than 300 tags are inserted, the first 300 tags 
are activated.

Cycle Update cycle Base is 1 second.
To extend the cycle, enter a value > 1.

Function Simulation function Select the function from the drop-down list.
Parameters of the simulation functions You can find the description of the parameters under 

"Configuring functions for the simulation (Page 300)".
In the data area, the parameters of the simulation func‐
tions are hidden in the standard view. To show these 
columns, select "Show" from the column header short‐
cut menu.

Runtime values in the data area
The runtime values of the simulated tags are only displayed or entered in the data area.
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These fields are not included in the properties window.

Column Description
Value set Value transferred by the simulator.

"User input" function
• If Runtime is activated, enter the required value in the field.
• To display the slider, click the displayed button: 

Current value Current tag value in runtime
Time stamp Current time stamp of the tag value in runtime
Quality set Quality code set by the simulator.

Select the quality code from the drop-down list.
Default setting:
• 0x60: Uncertain; Simulated value

Quality code Current quality code of the tag in runtime
Tag status Current tag status in runtime

Quality code in runtime
When the controller is connected and active when simulating a process tag, the displayed quality 
code is influenced by the actual values.
The simulator sets the quality code according to the update cycle.
As soon as the value is read by the controller, the "Quality Code" field shows the actual quality 
code until the simulator sets the next value.

No quality code with S7-1500 controllers
The "SIMATIC S7-1500" controllers do not support the WinCC Quality Code.
As long as there is no connection to the S7-1500 controller, you can simulate a quality code.
With an active S7-1500 connection, the default value is always displayed as the quality code.

User interface language of the editor
The user interface depends on the project language of the project running in runtime:
• Project language German: The user interface is in German.
• Other project language: The user interface is in English.
If you start the emulator without running any projects, the user interface is in English.

See also
Inserting tags in the "Tag simulation" editor (Page 298)
Configuring functions for the simulation (Page 300)
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7.4 How to simulate tags
In the WinCC Unified Tag Simulator, select the tags you want to simulate.
Select the simulation type and the update cycle for each tag.

WARNING
Effects on connected controls
Simulated tag values can be transferred to connected controllers.
When the WinCC project is connected to a controller, WinCC writes the simulated process values 
to the automation system.
This can lead to a reaction of the connected process I/Os.
Disconnect hardware
Before using the simulator, ensure that
• No hardware is connected, if possible.
• The connected hardware represents no danger even when values are extreme.
Recommendation
Simulate the process values without process connection.

Requirement
In runtime, a project of the project type REAL or SIMULATION is in RUN.

Procedure
1. Open the WinCC Unified Tag Simulator.
2. Insert the required tags.

To open the tag selection dialog, click the displayed button in the "Tag name" column: 
Other possible procedures:
– "Inserting tags in the "Tag simulation" editor (Page 298)"

3. Select the function for the simulation.
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4. Select the other function parameters in the "Tag properties" area.

5. To change the update cycle, enter a number > 1 in the "Cycle" field.
An update cycle of 1 second is the basis. To change the simulated value, every 5 seconds, for 
example, enter "5".

6. If necessary, select the quality code in the "Quality set" column.
The selected quality code is also set each time a simulated tag value is written.

7. Activate the simulation of the required tags in the "Active" column.
You can simulate a maximum of 300 tags simultaneously, even if more tags are configured 
in the simulator.

8. Save the simulation using the menu command "File > Save as".
This allows you to reuse the projected simulation later, for example, to test a changed 
configuration.
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9. Start the simulation using the menu command "Simulation > Start".
– The simulated values are displayed in the "Value set" column.
– The actual values of the tags are displayed in the "Current value" column.
– The respective, actual quality code is displayed in the "Quality Code" column.

10.To use the "User input" function to change the simulated value for tags, click the "..." button 
in the "Value set" column and then select a value with the slider.

11.To stop the simulation, select the menu command "Simulation > Stop".
The simulation is also ended when you stop the runtime project.

See also
Inserting tags in the "Tag simulation" editor (Page 298)

7.5 Inserting tags in the "Tag simulation" editor

Inserting tags
You have the following options for inserting tags in the WinCC Unified Tag Simulator:
• Enter tag name
• Applying tags from the list for tag selection
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Tag Management: Consistency
You can only add tags that have been created and compiled in the engineering system in the Tag 
Management.
If a tag has been renamed or deleted in the Tag Management, the line in the simulator is 
highlighted in red. 

Supported tags
The following tags can be simulated:
• Process tags
• Internal tags
• Structure tags
• Structure tag elements

Insert structure tags
When you insert complete structures in the form of structure tags, note the following.
• A structure tag is inserted collapsed.

To expand the structure, click the arrow in front of the tag name.
• Simulate the contained structure tag elements independently of each other, like single tags.
• You can only delete inserted structure tags as complete structures.

You cannot delete lower-level elements individually.

Restrictions
Simulation of the following tag types is not supported:
• Raw data tag
• Text reference
• Date/time

Tag name
The tag or structure tag is searched for and added in the tag management.

Adding a tag
In the detail area, you define which tags are part of the simulation. You have the following 
options to add a tag:
• In the "Tag name" column, double-click in the cell with the following icon: 

Then enter the tag name in the field. Make sure that the name is case-sensitive.
• In the "Tag name" field, click on the arrow button and select a tag from the list.
If a row that is already filled is selected in the data area, this tag is overwritten during pasting.
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To add more tags, click the next empty line in the data area.

Delete tag
To delete a tag, click the respective row number in the data area. The line is highlighted.
Select "Delete" from the shortcut menu or press the <Del> key.
The tag is deleted, without further prompt, from the list of tags to be simulated.

7.6 Configuring functions for the simulation

Functions for the simulation 
Select how the tag value is simulated for each tag.
The following functions are available:
• Sine
• Oscillation
• Random values
• Increment
• Decrement
• User input (slider)
• Script

"Binary tag" data type
The "Sine" and "Oscillation" functions are not supported by binary tags.

Sine function
Periodic, non-linear function:

Parameters Description
Amplitude Value range
Offset Zero point for the value range
Oscillation period Duration of period in seconds

Oscillation
Simulation of jumps of a setpoint:

Parameters Description
Overshoots Maximum deviation from the rated value
Rated value Value around which the oscillations are occurring
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Parameters Description
Oscillation period Time interval of the oscillation in seconds.

The oscillation restarts after the specified time have elapsed.
Damping Reduction of amplitude within the oscillation period

Random values
Randomly generated values:

Parameters Description
Random minimum value Smallest possible value
Random maximum value Greatest possible value

Increment
Up counter which restarts at the minimum value when it reaches the maximum value:

Parameters Description
Initial value Increment Minimum value

The start value is applied at runtime start.
End value Increment Maximum value
Step Increment Value increase, e.g. in increments of 10

Decrement
Down counter; restarts the maximum value after having reached the minimum value:

Parameters Description
Initial value Decrement Maximum value

The start value is applied at runtime start.
End value Decrement Minimum value
Step Decrement Value reduction, e.g. in decrements of 10

User input
Enter in the "Value set" table field or use the slider:

Parameters Description
Slider minimum value Lowest value that can be entered or selected with the slider
Slider initial value Value at runtime start
Slider maximum value Highest value that can be entered or selected with the slider.

Slider
1. To open the slider in runtime, click in the "Value set" field in the table area.
2. Click the displayed button: 
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3. Move the bar with the mouse or the cursor keys.
4. Close the slider using the "x" in the top-right.

Text tags
In addition to numbers, you can also set letters as start value for text tags.
The slider is not displayed. The "Minimum value" and "Maximum value" fields are inactive.

Script
VBScript function with the return value that is written to the WinCC tag:

Apply code Deactivated: Only the "VBS function" option is active.
Activated: Only the "VBS code" option is active.

VBS function Selection of a created VBS function
To select a VBS function, click on the button displayed in the field: 

VBS code Entering a new VBS function
The function is stored in the simulation file.
To open the VBS editor, click on the button displayed in the field: 

7.7 Simulating tags via script
The "Script" simulation function provides the following options to simulate tag values:
• Setting a tag value using a VBScript function
• Read out or set values from other WinCC tags
The following VBS objects are supported:
• Tags object
• SmartTags object.
• HMIruntime object: Trace function

Other functions of the HMIruntime object are not supported.

VBS function: Select source
Use the "Apply code" property in the "Tag properties" window to select the source:

"Apply code" field Source Procedure
disabled The "VBS function" field con‐

tains the name of the selec‐
ted VBS function.

Create a function in the VBScript editor.
To select the function in the simulator, click the 
displayed button in the "VBS function" field.

enabled The "VBS code" field contains 
the code of the VBS function.

To open the internal VBS editor, click the displayed 
button in the "VBS Code" field.
Create the required function.
The function is saved in the simulation file and is 
only available in the simulator.
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Restrictions
• Tags whose name starts with the prefix "@" cannot be addressed in scripts via the simulator.
• You cannot deactivate a tag with the "Script" simulation function as long as the simulation is 

active in runtime.
• If the script cannot be processed in the current cycle, it is not called up again until of next 

update cycle after processing has been completed.
To deactivate the tag simulation and correct the script, stop the simulation using the menu 
item "Simulation > Stop".

Transfer parameters
The VBS function must have a transfer parameter.
An object with the following properties is transferred to the script during the execution:

Read/write access Property Description
Read and write Value 1) The script reads or writes the last calculated tag value.

UserData The script can cache a value.
QualityCode Quality code as numeric value which is set when the tag is written.

Read only Tag name Name of the WinCC tag with the value the script calculates
Data type The data type of the tag as numerical value
Counter Counter with which the cycle is increased

1) In the simulator you can only create procedures of the "Sub" type. The value to be set is written in the 
"Value" parameter.
The "Function" type is only supported in the project modules or standard modules. In this case, the return 
value is written to the tag.

Example script: Set tag value
Set a calculated value as "MyCalculatedValue" with the quality code "0x48: Uncertain - Substitute 
set".
If you do not formulate a calculation, the value is incremented by +1.

  
'VBS378
Sub Tag_Simulation_01 (Byval Item)
 MyCalculatedValue = Item.Counter
' do your own calculation
' ...
  
' write the calculated value to be set by WinCC Unified Tag Simulator
Item.Value = MyCalculatedValue
Item.QualityCode = 72
End Sub

Example script: Access to tags
To read out or set the tag value of WinCC tags, use the Tags object or SmartTags object.
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You use the trace function via the HMIruntime object. The text is displayed in the diagnostic 
window of the simulator.

Tags object
  
'VBS379
Sub SimulatedTag_address_02 (Byval Item)
    
Dim group
Set group = Tags.CreateTagSet
' add tags "Simulation_x" to the collection
group.Add "Simulation_3"
group.Add "Simulation_4"
' set the values of the tags
group("Simulation_3").Value = Item.Counter
group("Simulation_4").Value = Item.Counter +1
' write the values to the DataManager
group.Write
    
' write trace text
HMIruntime.Trace "Simulation: Tag values set"
 
End Sub

SmartTags object
  
'VBS380
SmartTags("Simulation_5") = 7

7.8 Save and open the simulation file
You can save a configured simulation as a file in the "* .sim" format and call it up again later.

Saving the simulation file
1. In the simulator, select "File > Save" or "Save as".
2. Select a target directory and a file name.
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Target directory:
• When you started the simulator via the Windows user interface while a project is in RUN in 

Runtime, the simulation file is saved to the following directory: 
<Path to the active RT project>\Simulation
Note
Overwriting the simulation file by full download
Simulation files saved in the project directory are overwritten by a full download.

• When you started the simulator without a project being in RUN in Runtime, the document 
directory of the user is recommended as a storage location. Select a different directory, if 
necessary.

Opening the simulation file
1. In the simulator, select "File > Load".
2. Select the desired simulation file or the path to the desired file.
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